# Table of Contents

## Preface

- About this documentation
- Documentation conventions
- Product support contact information

## Chapter 1: Introduction to Progress OpenEdge Business Process Modeler

- Business Process Modeler supported platforms
- System requirements

## Chapter 2: Getting started with Business Process Modeler

- Starting Business Process Modeler
- Exploring Business Process Modeler
  - Using the Business Process Modeler menubar
  - Business Process Modeler Tasks pane
  - Business Process Modeler palette
  - Using keyboard shortcuts
  - Localizing Business Process Modeler

## Chapter 3: Developing Business Process Modeler projects

- Project facets
  - Project facet properties
- Creating a BPM project
  - Creating a BPM process
  - Creating a Web application
- Exporting BPM applications
- Importing BPM applications
- Managing multiple processes
  - Importing a process file
  - Adding a new BPM process
  - Adding a new Web application
  - Importing a process file
  - Using a process file as a template
    - Using a process file from recent releases
    - Importing XPDL files
  - Using a project as a template
  - Creating a simulation project
Chapter 4: Designing a process template diagram.........................41
Creating a process template diagram..........................................................41
Changing shapes.................................................................................................43
Connecting worksteps.......................................................................................43
Using multiple links ..........................................................................................45
Adding notes.........................................................................................................47

Chapter 5: Managing gestures....................................................................49
Using mouse gestures........................................................................................49
Creating custom gestures.................................................................................50
Using the Gesture Editor..................................................................................50
Saving custom gestures......................................................................................52
Using custom gestures.......................................................................................52

Chapter 6: Performing additional Business Process Modeler operations.55
Publishing the process.......................................................................................55
Managing pages.................................................................................................56
Generating 360 degree view............................................................................56
Opening a subprocess........................................................................................56
Printing the process template..........................................................................58
Exporting the process template........................................................................59
Generating a process summary.........................................................................60
Managing phases...............................................................................................62
Creating a phase..................................................................................................62
Resizing a phase..................................................................................................63
Performing additional phase operations.........................................................63

Chapter 7: Working with the Overview page.............................................65
Introducing the Overview page.........................................................................65
Reviewing the Overview page...........................................................................66
Managing tasks....................................................................................................67
Adding a task.......................................................................................................68
Performing other operations..............................................................................69

Chapter 8: Introducing Path Analysis.........................................................71
Using the Path Analysis view............................................................................71
Exploring the Path Analysis view.................................................................72

Chapter 9: Defining process properties........................................................75
Chapter 10: Using dataslots

Reviewing the Dataslots tab

Chapter 11: Defining and assigning performers

Chapter 12: Setting workstep properties
Chapter 15: Using alerts.................................................................147
  Reviewing the Alerts tab............................................................147
  Defining an alert..............................................................................148
  Associating an alert with a workstep............................................149

Chapter 16: Configuring and running simulation.......................151
  Adding a process model...............................................................152
  Exploring the Progress OpenEdge BPM Simulation perspective.....152
  Configuring a simulation scenario...............................................153
    Adding a scenario........................................................................154
    Modifying simulation settings for a scenario............................154
    Importing and exporting a scenario.........................................155
    Configuring simulation parameters for a process......................156
  Managing performers.................................................................161
  Managing resources......................................................................162
  Defining objectives........................................................................163
  Setting calendar...........................................................................164
  Performing other operations.......................................................165
    Choosing a randomization method..........................................165
    Specifying a date........................................................................166
  Running a process simulation......................................................167
    Viewing process information..................................................168
    Viewing project information....................................................170
  After completion of simulation..................................................173
    Generating a simulation report.................................................173
    Viewing simulation report details.............................................174
    Comparing simulation results..................................................176

Chapter 17: Working with User Management tool......................179
  Types of members.......................................................................179
  Starting User Management tool..................................................180
  Printing organization chart.........................................................181
  Managing nodes...........................................................................181
    Managing users.........................................................................181
    Managing groups.....................................................................182
    Managing queues.....................................................................183
  Importing users..........................................................................184

Chapter 18: Working with Business Calendar.........................185
  Using the Business Calendar tool...............................................185
  Managing calendars.....................................................................185
Chapter 19: Managing business objects.........................................................189
  Using the Business Object Manager..........................................................189
  Importing business objects.........................................................................191
  Exporting a business object.........................................................................193
  Using business objects in a link..................................................................193
  Using business objects in applications.......................................................194
  Using business objects in scripts.................................................................194

Chapter 20: Business Process Modeler tutorial...........................................195
  Designing a process template diagram.......................................................196
  Reviewing the process requirements.........................................................196
  Defining the process flow.............................................................................196
  Creating the process model.........................................................................197
  Defining the process information flow.......................................................198
  Defining process performers.......................................................................199
  Defining workstep properties.....................................................................199
  Assigning dataslots to worksteps...............................................................200
  Saving and installing the process...............................................................200
  Installing the published application.........................................................201
  Creating an instance and performing a task..............................................201
Preface

For details, see the following topics:

- About this documentation
- Documentation conventions
- Product support contact information

About this documentation

This guide provides documentation for Progress OpenEdge Business Process Modeler, version 11.6. Progress OpenEdge Business Process Modeler is a component of the Progress OpenEdge Business Process Server line of software products.

Progress OpenEdge Business Process Modeler is a graphical, easy-to-use tool that enables line-of-business analysts and other business users to design processes, run simulations of them, and to store and retrieve processes from a central shared repository.

Documentation conventions

This document uses the following conventions and terminology notations.
Table 1: Conventions in this manual

<table>
<thead>
<tr>
<th>Convention (styles and terms)</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>bold</strong></td>
<td>Indicates titles of command buttons, check boxes, options, lists, dialog boxes, and portal page names.</td>
</tr>
<tr>
<td><strong>bold italic</strong></td>
<td>Represents notes that alert you on specific Business Process Server elements and similar advisory information.</td>
</tr>
<tr>
<td><em>italic</em></td>
<td>Indicates folder paths, file names, and book titles.</td>
</tr>
<tr>
<td>monospace</td>
<td>Represents code segments or examples.</td>
</tr>
<tr>
<td>backward slash “\”</td>
<td>Indicates the path in Windows environment. For UNIX environment, replace with forward slash “/”</td>
</tr>
<tr>
<td>Modeler_Home</td>
<td>Represents the installation folder of OpenEdge Business Process Modeler.</td>
</tr>
<tr>
<td>Workspace_Home</td>
<td>Represent the Workspace folder of Business Process Modeler located in the Modeler_Home folder.</td>
</tr>
</tbody>
</table>

Product support contact information

If the product documentation does not provide a solution to your specific issue, or if you need clarification on the issue, then contact our Product Support team. You can contact the team through the Internet, telephone, or postal mail, as per the details provided in the following table.

Table 2: Product Support Contact Information

<table>
<thead>
<tr>
<th>To contact by</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>Web site</td>
<td><a href="http://progresslink.progress.com/supportlink">http://progresslink.progress.com/supportlink</a></td>
</tr>
<tr>
<td></td>
<td>If you are an existing customer, then you can log in to the above site for product support. If you are a first time user, then you need to create an account first.</td>
</tr>
<tr>
<td>Telephone(^1)</td>
<td>1-781-280-4999 for US, Latin America and Canada</td>
</tr>
<tr>
<td></td>
<td>1-781-280-4543 for the Product Support Fax Line</td>
</tr>
<tr>
<td>Postal Address(^1)</td>
<td>Progress Software Corporation</td>
</tr>
<tr>
<td></td>
<td>14 Oak Park Drive</td>
</tr>
<tr>
<td></td>
<td>Bedford, MA 01730, USA.</td>
</tr>
</tbody>
</table>

To enable us to quickly answer your questions, please provide the following information:

- Your name, installation site address and the license key for Business Process Server software.

\(^1\) For support telephone numbers and offices in your region, visit the support web site above. This contact information is for customer support only.
• Your Business Process Server version and build number.
• Your operating system, application server and browser, with version and service pack details, if any.
• Your database management system and version, and information on JVM and JDBC used.
Introduction to Progress OpenEdge Business Process Modeler

This chapter introduces Progress OpenEdge Business Process Modeler (herewith referred to as Business Process Modeler), a tool which enables you to:

• Design a business process using the worksteps, connectors, and other features provided in the Business Process Modeler user interface. A process must contain a Start workstep, intermediate worksteps that can include Activity, Adapter and Subprocess worksteps, and one or more End worksteps.

• Define performers for the new process. These process-level performers are available for each instance of the process.

• Assign performers to worksteps. Types of performers include individual users, groups of users, or queues that perform Activity worksteps; adapters that perform Adapter worksteps; and other processes that act as performers of Subprocess worksteps.

• Define the information flow for the new process by creating dataslots, which can provide information into (inputs) or out of (outputs) worksteps.

• Configure and run simulations of the process to analyze performer and resource usage, to identify repetitive loops and inefficient bottlenecks, and to predict process performance. Business Process Modeler also allows you to generate an HTML report on the simulation results.

• Save the process to your local server after completing process design, or save it to the Process Repository, where it can be accessed by other Business Process Modeler users. You can also retrieve the latest version of other processes that have been stored in the Process Repository, and use them as templates when preparing a new process.

• Open the saved process in Progress Developer Studio for OpenEdge, a Business Process Server component that enables users to expand the process design by adding such features as conditions that execute Decision gateways, rules that further define the process, and advanced workstep properties that include excluding...
performers and setting overdue actions. From Progress Developer Studio for OpenEdge, the process can be published to Business Process Portal, where it is available to users as an installed application.

For details, see the following topics:

- Business Process Modeler supported platforms
- System requirements

## Business Process Modeler supported platforms

Business Process Modeler has been extensively tested on the platforms, tools, and applications supported by Progress Business Process Server 11.6. Table 3: Process Modeler Supported Platforms on page 16 provides Business Process Modeler-specific supported platforms.

### Table 3: Process Modeler Supported Platforms

<table>
<thead>
<tr>
<th>Category</th>
<th>Software</th>
</tr>
</thead>
<tbody>
<tr>
<td>Business Process Server Version</td>
<td>11.6</td>
</tr>
<tr>
<td>Operating Systems</td>
<td>MS Windows 2000/Vista/XP Professional SP2 and Windows 7</td>
</tr>
</tbody>
</table>

## System requirements

Table 4: System requirements on page 16 describes the requirements for installing and running Business Process Modeler on Windows.

### Table 4: System requirements

<table>
<thead>
<tr>
<th>Item</th>
<th>Recommended</th>
</tr>
</thead>
<tbody>
<tr>
<td>Free disk space</td>
<td>500 MB free disk space</td>
</tr>
<tr>
<td>Business Process Modeler installation/operation</td>
<td>1 GB of RAM</td>
</tr>
<tr>
<td>Processor power</td>
<td>1GHz</td>
</tr>
</tbody>
</table>
Getting started with Business Process Modeler

You can use Business Process Modeler to design templates for basic business processes and store or retrieve them from the process repository. Business Process Modeler also enables you to manage performers at the process or workstep level and to design and run simulations of processes and individual worksteps.

For details, see the following topics:

- Starting Business Process Modeler
- Exploring Business Process Modeler
- Localizing Business Process Modeler

Starting Business Process Modeler

Business Process Modeler uses the Eclipse-based Integrated Development Environment (IDE), a comprehensive cross-platform environment to provide a stable, universal platform for application development. This open, scalable, and standards-based development environment reduces the time spent in application development and supports a user’s choice of version control system and application server. The current version of Business Process Modeler is based on the Eclipse Foundation SDK (version 3.7) IDE.

To start Business Process Modeler:

1. From the Start menu, select Programs > Progress > OpenEdge > Process Modeler, to open a blank Business Process Modeler GUI in the Progress OpenEdge Business Process Modeler perspective.
2. Use the File menu to perform the following operations:
Table 5: Process Modeler Operations

<table>
<thead>
<tr>
<th>Submenu</th>
<th>Function</th>
<th>For more information, see</th>
</tr>
</thead>
<tbody>
<tr>
<td>New &gt; BPM Project</td>
<td>Creates a new BPM project.</td>
<td>Creating a BPM project on page 28</td>
</tr>
<tr>
<td><strong>New &gt; Process Model</strong> or <strong>New &gt; Web Application</strong></td>
<td>Creates a new BPM Process or Web application.</td>
<td>Creating a BPM process on page 29 and Creating a Web application on page 31.</td>
</tr>
<tr>
<td><strong>New &gt; Simulation Project</strong></td>
<td>Creates a simulation project.</td>
<td>Creating a simulation project on page 37.</td>
</tr>
<tr>
<td><strong>Open</strong></td>
<td>To browse to an existing process in your Workspace_Home folder; or in another location of your existing processes.</td>
<td></td>
</tr>
</tbody>
</table>

**Note:** To access or use Business Process Modeler, you must have a valid license. For the stand-alone Business Process Modeler, your administrator can grant you specific permissions. For more information on Licenses, contact our Product Support Team.

---

Exploring Business Process Modeler

This section describes the Business Process Modeler interface including its views, menus, and toolbars. The commonly used views and components in the Business Process Modeler are further described in Table 6: Process Modeler components on page 18.

Table 6: Process Modeler components

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Menu bar</strong></td>
<td>Provides access to Business Process Modeler functions. For details, see Using the Business Process Modeler menubar on page 19.</td>
</tr>
<tr>
<td><strong>Toolbar</strong></td>
<td>Consists of icons providing shortcuts to commonly used functions.</td>
</tr>
<tr>
<td><strong>Project Explorer View</strong></td>
<td>Displays the contents of active projects. It consists of a hierarchical view of all the files that make up the active project.</td>
</tr>
<tr>
<td><strong>Palette Bar</strong></td>
<td>The bar above the Content pane includes icons for selecting, connecting, grouping and moving the elements in the process template diagram. For details, see Business Process Modeler palette on page 23.</td>
</tr>
<tr>
<td><strong>Business Process Modeler Tasks pane</strong></td>
<td>The Tasks pane contains six options—Select and Change Layout, Create Phases and Swim Lanes, Draw Shapes, Connect Shapes, Assign Participants, Create Annotations. These options help you in the design of a process model. For details, see Business Process Modeler Tasks pane on page 21.</td>
</tr>
</tbody>
</table>
The Content pane contains the main workspace in which the selected project or file is displayed. The Content pane also includes:

- **File tabs**, located at the top of the pane, which display the opened files. Click on a File tab to display the file in the Content pane.

- **Content pane tabs**, located at the bottom of the pane, which include:
  - **Diagram** tab, which displays the process template.
  - **Overview** tab, which displays the process elements in a tabular format.
  - **Process Analysis** tab, using which you can perform process path analysis.
  - **Dataslots** tab, where you can define process dataslots.
  - **Performers** tab, where you can define performers at the process level.
  - **Alerts** tab, where you can define and manage Alerts.

- An arrow, at the bottom right corner of the Content pane, which provides a bird’s eye view of the entire process template in a 3x3 grid. You can drag the purple box (showing the current process view) to navigate to a specific process view location.

**Using the Business Process Modeler menubar**

Table 7: Toolbar Components and Commands in Business Process Modeler on page 19 lists the components and commands available in the Business Process Modeler toolbar.

**Table 7: Toolbar Components and Commands in Business Process Modeler**

<table>
<thead>
<tr>
<th>Component Name</th>
<th>Icon / Shortcut</th>
<th>Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>![icon]</td>
<td>File &gt; New</td>
<td>Select Process Model, Web application, or Simulation Project option to open the appropriate wizard to create the project (as discussed in Developing Business Process Modeler projects on page 27). You can also launch the wizard for Process Model by clicking <strong>Process Model</strong> ![icon] or the Simulation Project wizard by clicking <strong>Create new simulation project</strong> ![icon] icon.</td>
</tr>
<tr>
<td>Open</td>
<td>![icon]</td>
<td>File &gt; Open</td>
<td>Opens the Open File dialog box, where you can locate and open an existing process template.</td>
</tr>
<tr>
<td>Close</td>
<td>Ctrl + W</td>
<td>File &gt; Close</td>
<td>Closes the current process template.</td>
</tr>
</tbody>
</table>

OpenEdge Business Process Modeler: User’s Guide 19
<table>
<thead>
<tr>
<th>Component Name</th>
<th>Icon / Shortcut</th>
<th>Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Close All</td>
<td>Ctrl+Shift+W</td>
<td>File &gt; Close All</td>
<td>Closes all process templates.</td>
</tr>
<tr>
<td>Import Projects into Workspace</td>
<td></td>
<td>File &gt; Import Projects into Workspace</td>
<td>Imports projects from previous Business Process Modeler releases into the current release.</td>
</tr>
<tr>
<td>Save</td>
<td>Ctrl + S</td>
<td>File &gt; Save</td>
<td>Saves the process template currently in the Content pane, in the ProcessModeler\workspace&lt;Application&gt;\processtemplates folder.</td>
</tr>
<tr>
<td>Save As</td>
<td>Ctrl+Shift+S</td>
<td>File &gt; Save As</td>
<td>Saves process templates in a format you specify.</td>
</tr>
<tr>
<td>Save to Repository</td>
<td></td>
<td>File &gt; Save to Repository</td>
<td>Saves the current process to a repository.</td>
</tr>
<tr>
<td>Save Project to Repository</td>
<td></td>
<td>File &gt; Save Project to Repository</td>
<td>Saves the project to a repository.</td>
</tr>
<tr>
<td>Save All</td>
<td></td>
<td>File &gt; Save All</td>
<td>Saves all process templates in Business Process Modeler.</td>
</tr>
<tr>
<td>Print</td>
<td></td>
<td>File &gt; Print</td>
<td>Displays the Print Preview mode (see Printing the process template on page 58) and the Print dialog box, enabling you to print a process template, and define its printing properties. Printing multiple pages is supported only when using JDK 1.2 or later.</td>
</tr>
<tr>
<td>Properties</td>
<td>Alt + Enter</td>
<td>File &gt; Properties</td>
<td>Opens the Process Properties dialog box for the process template.</td>
</tr>
<tr>
<td>Undo</td>
<td></td>
<td>Edit &gt; Undo</td>
<td>Undoes or recreates the last action performed in the Content pane, up to 100 operations. Supports lane, shape, connector, and cut/copy/paste operations, as well as Align, Space, and Collapse operations. Note: All other actions (for example, entering process property information in Process Properties dialog boxes) cannot be undone. If an operation that cannot be undone is performed, then the undo queue is cleared and the previous operations cannot be undone.</td>
</tr>
<tr>
<td>Redo</td>
<td>Ctrl + Y</td>
<td>Edit &gt; Redo</td>
<td></td>
</tr>
<tr>
<td>Cut</td>
<td></td>
<td>Edit &gt; Cut</td>
<td>Cuts a selected item from Business Process Modeler clipboard. Applies to diagram objects only.</td>
</tr>
<tr>
<td>Copy</td>
<td></td>
<td>Edit &gt; Copy</td>
<td>Copies a selected item to Business Process Modeler clipboard. Applies to diagram objects only.</td>
</tr>
</tbody>
</table>
### Component Name \ Icon / Shortcut \ Menu \ Description

<table>
<thead>
<tr>
<th>Paste</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Ctrl + V</td>
</tr>
<tr>
<td></td>
<td>Edit &gt; Paste</td>
</tr>
<tr>
<td></td>
<td>Pastes the clipboard items into Business Process Modeler Content pane. Applies to diagram objects only.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Select All</th>
<th>Ctrl + A</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Edit &gt; Select All</td>
</tr>
<tr>
<td></td>
<td>Selects all workstep items in Business Process Modeler Content pane.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Show views</th>
<th>Ctrl + T</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>View &gt; Project Explorer</td>
</tr>
<tr>
<td></td>
<td>Shows/hides the Project explorer view, the Properties view, the Problems view, the Repository Browser; and the Outline view; or restores the Default view.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Ctrl + I</th>
<th>View &gt; Properties</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Ctrl + L</th>
<th>View &gt; Problems</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Ctrl + R</th>
<th>View &gt; Repository Browser</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Ctrl + O</th>
<th>View &gt; Outline</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>View &gt; Restore Default View</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Users</th>
<th>Tools &gt; Users</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Enables you to add and manage users, groups, and queues.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Calendars</th>
<th>Tools &gt; Calendars</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Enables you to define an organization-level calendar.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Business Objects</th>
<th>Tools &gt; Business Objects</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Enables you to create a new business object, or import, export, modify, or remove an existing business object.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Help</th>
<th>Help &gt; Help Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>F1</td>
<td>Launches the online help system, which assists you with application development in Business Process Modeler.</td>
</tr>
</tbody>
</table>

### Business Process Modeler Tasks pane

The Business Process Modeler Tasks pane includes primarily the Design Tasks panel, which lists the links used when designing your process template diagram. Clicking any of these links displays the associated panel; for instance, the Layout Tasks panel and the Description panel for the Select and Change Layout link.

**Note:** To hide the Tasks pane, click the Hide (Hide) icon beside it. To show the Tasks pane again, click the Show (Show) icon. You can also expand (and then collapse) any of the panels. To expand a panel, click the Expand (Expand) icon. To collapse a panel, click the Collapse (Collapse) icon. Alternatively, you can expand (or collapse) a panel by clicking the panel header.
• **Select and Change Layout.** Enables you to align and space process template elements and to apply auto-layout. For more information, see Aligning and spacing worksteps on page 128.

• **Create Phases and Swim Lanes.** Enables you to add a phase or swim lane to the process template diagram. For more information, see Using swim lanes on page 105. This option is not available for Web applications.

• **Draw Shapes.** This link lists the worksteps and other process template elements (Start, Activity, Decision, Or-Join, End, etc.) that you can drag into the Content pane to create the workflow for your process. For more information, see Using shapes on page 22.

• **Connect Shapes.** Use this link to draw connections between process template elements. The Connect Tasks panel shows three types of connectors for Normal flow, Compensation flow, and Timeout flow, which you can use to connect worksteps. If the connection is not valid, then the connection cursor is displayed in red. Once you select a connector type, you can continue to make connections. To discontinue connecting, click any other Tasks pane link. For more information, see Connecting worksteps on page 43.

• **Assign Participants.** This link displays the performers grouped under four categories namely, Users, Adapters, Sub-Processes, and External. By default, Process Modeler displays organization-level users and a predefined user, “Creator” for Process Models, as well as a group of pre-defined managed adapters and a custom adapter. You can use this link to add, delete, or modify the properties of a performer. For more information, see Defining performers on page 97.

• **Create Annotations.** This link enables you to add an Annotation, Sticky Note, or a Group notation to the process template diagram. For more information, see Adding notes on page 47.

**Note:** For a brief description on how to use each of these links, expand the Description panel.

### Using shapes

Table 8: Shapes in Business Process Modeler Tasks Pane on page 22 provides information about the Shapes listed when you click the Draw Shapes link in the Tasks pane. These shapes follow standard BPMN notation and include Activities (represented by a rounded rectangle); event objects such as Start or End (represented by a circle); and Gateways (represented by a diamond) that indicate a change in the workflow such as the joining, merging, splitting, or deciding of the flow’s direction.

<table>
<thead>
<tr>
<th>Shape</th>
<th>Represents</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Start" /></td>
<td>Start</td>
<td>An event object that specifies the beginning of a business process. The default name is Start. Each Business Process Modeler process must have exactly one Start workstep.</td>
</tr>
<tr>
<td><img src="image" alt="Activity" /></td>
<td>Activity</td>
<td>Represents the basic unit of work that you can assign to one of the following performer types: User (a valid human performer or group of performers), Adapter, or Subprocess.</td>
</tr>
<tr>
<td><img src="image" alt="Decision" /></td>
<td>Decision</td>
<td>This gateway represents a decision point in the process flow. If the specified condition is not met, then the default branch is taken.</td>
</tr>
<tr>
<td>Shape</td>
<td>Represents</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-----------</td>
<td>-------------</td>
</tr>
<tr>
<td><img src="exclusive-or-join.png" alt="" /></td>
<td>Exclusive Or-join</td>
<td>This gateway allows the process flow to proceed only once from multiple predecessor worksteps to a successor workstep, and terminates any other human-performed predecessor worksteps. This shape is not available for Web applications.</td>
</tr>
<tr>
<td><img src="or-join.png" alt="" /></td>
<td>Or-join</td>
<td>This gateway connects multiple predecessor worksteps and one successor workstep. The successor workstep is performed if any of the predecessor worksteps have been completed.</td>
</tr>
<tr>
<td><img src="and-gateway.png" alt="" /></td>
<td>And Gateway</td>
<td>This gateway can act as an And Join or as a Split (or And-Fork). When it connects multiple predecessor worksteps to a single successor workstep, it acts as an And-Join. When it connects one predecessor workstep to multiple successor worksteps, it acts as a Split (or an And-Fork). The successor worksteps are performed in parallel and only if the predecessor workstep was completed. This enables you to synchronize the completion of multiple predecessor worksteps. This gateway is not available for Web applications.</td>
</tr>
<tr>
<td><img src="message.png" alt="" /></td>
<td>Message</td>
<td>An intermediate workstep in a process, indicating that the workstep is waiting for a message or is used to send a message when it is activated. Message worksteps are used for notational purposes only in Business Process Modeler.</td>
</tr>
<tr>
<td><img src="end.png" alt="" /></td>
<td>End</td>
<td>An event object that specifies that the application has come to a normal end. Business Process Modeler allows multiple End worksteps.</td>
</tr>
</tbody>
</table>

### Business Process Modeler palette

The Business Process Modeler palette contains the following icons.

- **Select shapes** (or Select) icon: Use this icon to select an Activity or other shape in the process template diagram to perform operations including copying, moving, and resizing shapes.

- **Pan the diagram** (or Panning) icon: Use this icon to move a portion of the diagram into the viewing area. Once you select the Panning icon, the cursor in the Content pane is displayed as a “hand”. The Panning mode is persistent until you select another mode.

- **Show Gestures** icon: Use this icon to display the list of mouse gestures, that you can use to quickly add shapes, layouts, and perform common process-related actions. For more information, see Using mouse gestures on page 49.

- **Color** icon: Use this icon to apply color to a selected shape, swim lane, or note. Click the icon to display a color palette, from where you can select one of the listed colors, or click **More** to display more color options.

- **Zoom In** / **Zoom Out** icons: Use these icons to zoom in or zoom out the view of the current process template in the Content pane. You can select a pre-defined magnification level (200%, 100%, 75%, 50%, or 25%) from the combo box.
• In the case of Process Model templates only, the drop-down list displays the current process. This is useful in the case of inline subprocesses (see Defining an inline subprocess on page 101). Click the One Level Up icon or select the parent process or higher subprocess from the adjacent drop-down list.

• Check Diagram icon allows you to verify if the process template diagram is correct.

• Show 360° View icon allows you to generate the 360° view of the current process template. For more information, see Generating 360 degree view on page 56.

• Print Preview icon allows you to preview the current process template before printing it. For more information, see Printing the process template on page 58.

• Export icon allows you export the current process template as a Web page (HTML), an SVG, or a JPEG file. For more information, see Exporting the process template on page 59.

Using keyboard shortcuts

Table 9: Keyboard Shortcuts in Business Process Modeler on page 24 lists the keyboard shortcuts you can use during application development.

Table 9: Keyboard Shortcuts in Business Process Modeler

<table>
<thead>
<tr>
<th>Keys</th>
<th>Menu Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alt + Enter</td>
<td>File &gt; Properties</td>
<td>Enables you to define the current process properties.</td>
</tr>
<tr>
<td>Ctrl + A</td>
<td>Edit &gt; Select All</td>
<td>Selects all items in the Content pane.</td>
</tr>
<tr>
<td>Ctrl + C</td>
<td>Edit &gt; Copy</td>
<td>Copies a selected item onto the clipboard, which you can paste into the Content pane. Applies to diagram objects only.</td>
</tr>
<tr>
<td>Ctrl + F</td>
<td></td>
<td>Enables you to find a specified item within displayed text in any text frame.</td>
</tr>
<tr>
<td>Ctrl + I</td>
<td>View &gt; Properties</td>
<td>Enables you to show/hide the Properties view.</td>
</tr>
<tr>
<td>Ctrl + N</td>
<td></td>
<td>Enables you to create a new file, folder or project, by selecting one of the wizards.</td>
</tr>
<tr>
<td>Ctrl + O</td>
<td>View &gt; Outline</td>
<td>Enables you to show/hide the Outline view.</td>
</tr>
<tr>
<td>Ctrl + P</td>
<td>File &gt; Print</td>
<td>Enables you to print a selected item.</td>
</tr>
<tr>
<td>Ctrl + R</td>
<td>View &gt; Repository Browser</td>
<td>Enables you to show/hide the Repository Browser pane.</td>
</tr>
<tr>
<td>Ctrl + S</td>
<td>File &gt; Save</td>
<td>Enables you to save the changes you made to your active business process model or Web application.</td>
</tr>
<tr>
<td>Ctrl + T</td>
<td>View &gt; Project Explorer</td>
<td>Enables you to show/hide the Project Explorer view.</td>
</tr>
<tr>
<td>Ctrl + V</td>
<td>Edit &gt; Paste</td>
<td>Pastes the clipboard item (cut or copied) into the Business Process Modeler Content pane. Applies to diagram objects only.</td>
</tr>
<tr>
<td>Keys</td>
<td>Menu Command</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>-------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Ctrl + W</td>
<td>File &gt; Close</td>
<td>Closes the current process template diagram.</td>
</tr>
<tr>
<td>Ctrl + X</td>
<td>Edit &gt; Cut</td>
<td>Cuts a selected item onto the Business Process Modeler clipboard, which you can paste into the Content pane. Applies to diagram objects only.</td>
</tr>
<tr>
<td>Ctrl + Y</td>
<td>Edit &gt; Redo</td>
<td>Redoes the last operation performed in the workspace.</td>
</tr>
<tr>
<td>Ctrl + Z</td>
<td>Edit &gt; Undo</td>
<td>Undoes the last operation performed in the workspace.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>The Undo/Redo commands support lane, shape, connector and cut/copy/paste operations, as well as Align, Space and Collapse operations.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Note: All other actions (for example, entering process property information in Properties dialog box) cannot be undone. If an operation that cannot be undone is performed, then the undo queue is cleared and the previous operations cannot be undone.</td>
</tr>
<tr>
<td>Alt + F7</td>
<td>Check Diagram</td>
<td>Checks the active diagram and verifies its validity.</td>
</tr>
</tbody>
</table>

**Localizing Business Process Modeler**

You can adapt Business Process Modeler to a language of your choice. For instructions on how to localize Business Process Modeler menus, titles of windows, labels of controls, messages, and other interface elements to a specified language, see Chapter 11: “Localizing Business Process Server” in the *Customization Guide*. 
Developing Business Process Modeler projects

This chapter describes how to create projects using Business Process Modeler.

For details, see the following topics:

- Project facets
- Creating a BPM project
- Exporting BPM applications
- Importing BPM applications
- Managing multiple processes
- Importing a process file
- Using a process file as a template
- Using a project as a template
- Creating a simulation project

Project facets

Business Process Modeler implements the Faceted Project Framework, which enables you to create BPM projects comprising of units of functionality (or facets) that can be easily added or removed.
A facet represents a unit of functionality in a BPM project. By default, you can create a BPM project with any of the following facets:

- **Process**: to create a BPM project with a BPM process facet.
- **Web Application**: to create a BPM project with a Web application facet.
- **Common Resources**: to create a BPM project with a common resources facet.

Business Process Modeler allows you to view project facet properties for any BPM project, as well as apply a facet. For more information, see **Project facet properties** on page 28.

### Project facet properties

Business Process Modeler enables you to view the project facet properties for an added BPM project in the **Properties** page. Additionally, you can apply a facet to the project.

You can view the **Properties** page by selecting the created BPM project in the Project Explorer view and clicking **File > Properties**. You can view the list of the following project facets from the **Project Facets** page:

- **Java**: This facet is locked by default. You cannot remove this facet.
- **Process**: This facet is selected if the BPM project contains a BPM process.
- **Web Application**: This facet is selected if the BPM project contains a Web application.

You can apply a facet to the project by selecting the respective checkbox and clicking **Apply**. You can restore the default facet properties by clicking **Revert**.

### Creating a BPM project

**To create a BPM project:**

1. From the **File** menu, select **New > BPM Project** to launch the **BPM Project** wizard.
2. From the first page of the **BPM Project** wizard, enter the name of the new project in the **Project name** box. The name can contain only alphanumeric characters, and must not contain blank spaces or special characters, except underscores (“_”). Project name must start with an alphabetic character.

   **Note**: The maximum length of the project name is 26 characters.

3. By default, the project is stored in the default workspace folder. To choose another location, clear the **Use default location** checkbox, and then click **Browse** to choose another location.
4. From the **Project type configuration** drop-down list, select the type of configuration (or facet) to be associated with this project. The available options are:
   - **Process**: to associate a BPM process facet with this project.
   - **Web Application**: to associate a web application facet with this project.

5. Click **Next** to continue. The remaining pages of the **BPM Project** wizard varies according to the project type configuration selected. To complete the **BPM Project** wizard, refer to the appropriate section provided in **Table 10: Types of projects** on page 29.
### Table 10: Types of projects

<table>
<thead>
<tr>
<th>Project Type</th>
<th>See</th>
</tr>
</thead>
<tbody>
<tr>
<td>Process</td>
<td>Creating a BPM process on page 29.</td>
</tr>
<tr>
<td>Web application</td>
<td>Creating a Web application on page 31</td>
</tr>
</tbody>
</table>

### Creating a BPM process

You can use the **BPM Project** wizard to create a BPM process.

**To create a BPM process:**

1. From the first page of the **BPM Project** wizard, select **Process** from the **Process type configuration** drop-down list.

2. Click **Next** to open the **BPM Process** page.

   If you want to use an existing process as a template to design a new process, from the **Template** section, select one of the following options:

   - **Use an existing file from file system as template**, then click **Browse** to navigate to an existing file (of type SPT, XML, or XPDL) that you can use as a template for your new application. For more information on using a template to create an application, see **Using a process file as a template** on page 35.

     **Tip:** We recommend using an existing SPT file as a template for creating the new process. The SPT file contains the process template and all associated forms. The XML file is a basic version that does not contain associated forms.

   - **Use an existing process from workspace as template** option, then click **Browse** to select an existing project (example, Approval) that is available in the Project Explorer that you can use as a template for your new application. For information on using an existing project as a template, see **Using a project as a template** on page 37.

   - **Use a Microsoft Project file as template** option, then click **Browse** to navigate to a Microsoft Project file (*.mp*), which you can use as a process for your application.

     **Note:** You can also import existing projects or extract from an archive file using the **Import** functionality. For more information, see **Importing a process file** on page 34.

3. Click **Next** to open the **BPM Process Properties** page, in which you can modify the application name and enter the relevant process information in the respective boxes.

   The following table describes the application information fields.
Table 11: Application properties

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>(Optional) The label is the title of the application that users see in Business Process Portal. For example, it is listed in the Administration module under <strong>Applications &gt; BP Server</strong>, and the Home module in BPM Portal displays this name together with its Description in the installed applications listed under the Applications tab. If no label is entered, the entry in the Name box is shown in Business Process Portal.</td>
</tr>
<tr>
<td>Version</td>
<td>(Optional) Use this box to add (or edit) the version number of the application.</td>
</tr>
<tr>
<td>Manager</td>
<td>(Required) Displays @CREATOR as the default manager. You can specify another manager, if required. The manager, either a single user or a user group, serves as a back-up performer if the originally assigned workstep performer is not available. If an individual is entered in the Manager box, then any tasks assigned to an unavailable performer are assigned to that user. If a group is entered in the Manager box, then any tasks assigned to an invalid performer are made available to the members.</td>
</tr>
<tr>
<td>Group</td>
<td>(Optional) Indicate which group of users is allowed to view and execute this project. You can only specify one group.</td>
</tr>
<tr>
<td>Duration</td>
<td>(Required) To specify the length of time you estimate is required to complete the process, use the appropriate <strong>Duration</strong> boxes to specify the duration in terms of days, hours, minutes, and seconds. The specified duration is used to determine the due date. After the due date you specified is passed, the process instance becomes overdue.</td>
</tr>
<tr>
<td>Category</td>
<td>(Optional) Use this box to differentiate between different types of projects.</td>
</tr>
<tr>
<td>Subcategory</td>
<td>(Optional) Use this box to further differentiate between projects in the same category.</td>
</tr>
<tr>
<td>Author</td>
<td>(Optional) Identifies the application developer who created the process template.</td>
</tr>
</tbody>
</table>

4. Click **Next** to open the **Add BPM Process module to Business Process Server(s)** page of the BPM Project wizard.

You can use this page (optional) to add the Business Process Servers and configure the publishing settings of the BPM process module.

a) To publish the BPM process as a module on any connected Business Process Server from the **Servers** view, select the server (if defined) from the **Available Business Process Server(s)** section.

b) In the **Default Publishing Style** section, select the default option for publishing the process module to the selected server.

c) To publish the BPM process as a Web service, select the **Publish as web service** checkbox.

d) If you want to publish the BPM process with the user permissions you defined in the previous version of the same process, then select the **Inherit ACL** option.

5. Click **Next** to open the **BPM Process Description** page of the BPM Project wizard, in which you can enter the description of the BPM process. This is optional.

6. Click **Finish** to complete the creation of the BPM process project.
Creating a Web application

You can use a Web application to:

• Develop a process that can be integrated as an individual workstep into a complex BPM process. For instance, an approval process that requires several levels of management review and approval, can be defined as a Web application. It can be then used as a single workstep in a process template: thus you can save development time and computer overhead.

• Develop a stand-alone process that may include adapters to access BP Server server and other external sources.

• Replace the Start workstep in a process template.

You can use the BPM Project wizard to create a Web application.

To create a Web application:

1. From the first page of the BPM Project wizard, select Web Application from the Process type configuration drop-down list.

2. Click Next to open the Web Application page.

   If you want to use an existing process as a template to design a new process, from the Template section, select one of the following options:

   • Use an existing file from file system as template, then click Browse to navigate to an existing file (e.g., BS_SVBSurvey.swt) located in your workspace folder that you can use as a template for your new application. For more information on using a template to create an application, see Using a process file as a template on page 35.

   Tip: We recommend using an existing SWT file as a template for creating the new process. The SWT file contains the process template and all associated forms. The XML file is a basic version that does not contain associated forms.

   • Use an existing web application from workspace as template, then click Browse to select an existing Web application project in the Project Explorer that you can use as a template for your new process. For information on using an existing project as a template, see Using a project as a template on page 37.

   • Use a Microsoft Project file as template, then click Browse to navigate to a Microsoft Project file (*.mp), which you can as a process for your application.

3. Click Next to open the Web application properties page, in which you can modify the name of web application, and enter optional information like label, category, sub-category, and author in the respective boxes. For details regarding this information, refer to Creating a BPM process on page 29.

4. Click Next to open the Add Web Application module to Business Process Server(s) page of the BPM Project wizard.

   If you want to publish the Web application as a module on any connected Business Process Server from the Servers view, select the server (if defined) from the Available Business Process Server(s) section. This step is optional.

5. Click Next to open the Web Application Description page of the BPM Project wizard, in which you can enter the description of the Web application. This is optional.

6. Click Finish to complete the creation of a Web application.
Exporting BPM applications

You can use the Export BPM Applications wizard to export a BPM project and its associated artifacts from the current workspace to a compressed ZIP format.

This wizard enables you to export the following artifacts of a BPM project:

- Business Objects
- Users

To export a BPM project and its associated artifacts:

1. Select File > Export > BPM Applications from the main menu bar.
   
   The Export BPM Applications window appears.

2. Select the Automatically select dependent project check box to select dependent artifacts from other associated BPM projects.
   
   For example, if you select a business process that uses another business process from a different BPM project as a subprocess for an activity, the dependent artifact such as the subprocess (business process from another BPM project) is automatically selected to export.

3. Select the BPM project from the Projects section.
   
   Note: By default, the artifacts associated with the selected project are selected in the Artifacts section.

4. Select from the Artifacts section the artifacts of the project that you want to export.
   
   Note: The artifacts associated with the selected projects are automatically selected. Clear the check box of an artifact you do not want to export.

5. Click the Select All button to select all the projects and its artifacts.
   
   Note: Click the Deselect All button to clear your selection of all the projects and its artifacts.

6. Click the Browse button to select the directory in which you want to export the selected resources.
   
   You can specify the directory path as the export location for the ZIP file.

7. Click Finish.
   
   The selected BPM project and its artifacts are exported and saved in a ZIP file in the selected directory.
   
   You can then use the Import BPM Applications wizard to import the ZIP file to copy the exported BPM project and its artifacts into another workspace.

Importing BPM applications

You can use the Import BPM Applications wizard to extract BPM projects and its artifacts from a ZIP file into the current workspace.
Note: You can export the BPM projects and its artifacts to a compressed ZIP file using the Export BPM Applications wizard.

The Import BPM Applications wizard enables you to import the following artifacts of a BPM project:

- Business Objects
- Users

To import the BPM projects and its associated artifacts:

1. Select File > Import > BPM Applications from the main menu bar.
   The Import BPM Applications wizard appears.

2. Click the Browse button to select the compressed ZIP file that contains the BPM projects and artifacts.
   The BPM projects and its artifacts are extracted from the selected ZIP file and appear in the Projects and Artifacts section.

3. Use the following options to select the BPM projects and its artifacts to import into the current workspace:
   - **Projects** — To select the BPM projects
     
     Note: You cannot import the project that already exists with the same name in the current workspace. By default, such project appears as disabled in the Projects section.

   - **Artifacts** — To select the artifacts of the selected projects

   - **Select All** — To select all the projects and its artifacts
     
     Note: Click the Deselect All button to clear your selection of all the projects and its artifacts. You can then choose individual resources to import.

4. Select the Overwrite resources without warning check box to overwrite the selected resources which already exist in the current workspace.

5. Click Finish.

The selected BPM projects and its artifacts are imported into the current workspace. You can view the projects and its associated artifacts in the Project Explorer view.

Managing multiple processes

In Business Process Modeler, you can create multiple BPM processes or web application modules within an existing or (new) BPM project. In the Project Explorer view, all the resources or files pertaining to a process or a web application module are stored in a folder with the same name as the process within the project directory.

For instance, if you create a BPM project, "project1" (as discussed in Creating a BPM project on page 28), a default process, "project1" is created. You can add additional processes (for example, "process1" and "process2") to this project. After adding, you can view the files of the added processes in separate folders within the "project1" project folder in the Project Explorer view.
With multiple process support in a BPM project, each new process acts as a separate project module, and all the properties related to a particular process are stored within the module definition.

You can create any number of processes (within Eclipse capability) in a BPM project. You can also delete added processes from a project. Deleting a process deletes all the resources associated with that particular process from the project directory.

### Importing a process file

Business Process Modeler provides the Import functionality, which enables you to import external projects into your current workspace. You can also extract an archive file as a project into your workspace.

**To import a project:**

1. From File menu, click *Import Projects into Workspace* to launch the Import wizard.
2. To navigate to existing projects, click Browse beside the Select root directory option to open the Browse for Folder dialog box.
   Alternatively, select the Select archive file option and click Browse to navigate to any of the supported archive files to import. Click OK to return to the Import dialog box.
3. From the Projects section, select the project(s) to be imported into your workspace. You can select one, many, or all projects.
4. Select the Copy projects into workspace checkbox (available only for Select root directory option) to create a copy of the external projects in your workspace.
5. Click Finish to start the import.
   The application appears in the Project Explorer View.
6. Expand the application folder displaying the SPT or SWT file in the processtemplates folder. Double-click the file to display it in the Content pane.

### Adding a new BPM process

You can create a BPM process and add it to an existing BPM project.

2. In the Project name box, you must specify the BPM project to which you want to add this BPM process.
   a) Click Browse beside the Project name box to open the Select Project dialog box, which lists the existing BPM projects.
   b) Select the BPM project to which you want to add the process, then click OK. The selected BPM project is displayed in the Project name box.
3. Complete the rest of instructions in the BPM Process wizard, as described in Creating a BPM process on page 29.

On completion of this wizard, the new process is added and displayed in the specified BPM project folder structure in the Project Explorer view.

### Adding a new Web application

You can create a Web application and add it to an existing BPM project.
1. From the **File** menu, select **New > Web Application**. The **Web Application** wizard appears.

2. In the **Project name** box, specify the BPM project to which you want to add this Web application.
   a) Click **Browse** beside the **Project name** box to open the **Select Project** dialog box, which lists the existing BPM projects.
   b) Select the BPM project to which you want to add the process, then click **OK**. The selected BPM project is displayed in the **Project name** box.

3. Complete the rest of instructions in the **Web Application** wizard, as described in “Creating a Web application” on page 31.

   On completion of this wizard, the new Web application is added and displayed in the specified BPM project folder structure in the Project Explorer view.

### Importing a process file

Business Process Modeler provides the **Import** functionality, which enables you to import external projects into your current workspace. You can also extract an archive file as a project into your workspace.

**To import a project:**

1. From **File** menu, click **Import Projects into Workspace** to launch the **Import** wizard.

2. To navigate to existing projects, click **Browse** beside the **Select root directory** option to open the **Browse for Folder** dialog box.

   Alternatively, select the **Select archive file** option and click **Browse** to navigate to any of the supported archive files to import. Click **OK** to return to the **Import** dialog box.

3. From the **Projects** section, select the project(s) to be imported into your workspace. You can select one, many, or all projects.

4. Select the **Copy projects into workspace** checkbox (available only for **Select root directory** option) to create a copy of the external projects in your workspace.

5. Click **Finish** to start the import.

   The application appears in the Project Explorer View.

6. Expand the application folder displaying the **SPT** or **SWT** file in the **processstemplate** folder. Double-click the file to display it in the Content pane.

### Using a process file as a template

You can reduce process development time by using an existing process file as the template for your new process in Business Process Modeler. You can browse to a specific location (for example, your workspace folder), which contains Business Process Modeler projects. The following topics describe how to use an existing process file as a template to create a new process in Business Process Modeler:

- **Using a process file from recent releases** on page 36.
- **Importing XPDL files** on page 36.

You can also retrieve a process file from the Process Repository (for more information, see Using the Repository Browser tab topic in *Progress OpenEdge Business Process Modeler: User’s Guide*).
Caution: We recommend that you do not use the File > Open command to create a new process template, because associated folders within the project are not created.

Using a process file from recent releases

To use a process file from a recent release (7.5 or later) as template to create a new process in Business Process Modeler:

1. In the first page of the BPM Project wizard, enter the name of the new project in the Project name box and click Next.
2. To use an existing process file as a template, select the Use an existing file from file system as template option, then click Browse to open the Select File dialog box, which displays the existing process files.
3. Select the SPT file in any of the process folders, which you want to use as a template for your new process.
4. Select a process file from your Workspace_Home folder and click Open.

The process template name (for instance, Assignment) and its path are shown in the File box; a number is automatically inserted in the Version box; the version number is one increment higher than the selected process file. The process template name and version (example, Assignment_V2) is entered in the remaining read-only fields.

5. Follow Step 4 to Step 7 in Creating a BPM project on page 28.
6. Select File > Save All to save changes to all open projects and files.

Importing XPDL files

Business Process Modeler supports the XML Process Definition Language (XPDL), which is a standardized format used for interchanging business process definitions across different workflow products.

XPDL enables an efficient exchange of BPMN diagrams by:

• Storing all aspects of a BPMN diagram, including graphical information such as the X and Y position of the nodes, as well as the executable aspects required to run a process.

• Including extensions to handle the new BPMN 1.1 constructs, as well as clarification of conformance criteria for implementation.

Business Process Modeler allows you to import process templates, which conform to XPDL version 2.1 specifications.

Note: Business Process Modeler does not support importing process templates containing vendor-specific information. For information regarding vendors and product versions supporting XPDL version 2.1, contact our Product Support team.

To use an exported XPDL file as a template to create a new process in Business Process Modeler:

1. In the second page of the BPM Project wizard, select the Use an existing file from file system as template option, then click Browse to open the Select File dialog box.
2. From the Files of type drop-down list, select the XPDL option, then select the XPDL file, which you want to use as a template for your new process.
3. Follow the instructions listed in Using a process file as a template on page 35, to use the XPDL file as a template for your new process template.
You can export process templates to XPDL version 2.1, as described in Exporting the process template on page 59.

Using a project as a template

You can significantly reduce process development time by using an existing Business Process Modeler project as the template for your new project. If you use this option, you can choose to import not only the process file, but also all associated interfaces, rules, and adapters. You can only use this option for existing project files that are displayed in the Project Explorer view.

To use an existing project as template to create a new process:

1. In the second page of the BPM Project wizard, enter the name of the new project in the appropriate box.
2. To use an existing project as a template, select the Use an existing process from workspace as template option (for BPM processes) or the Use an existing web application from workspace as template option (for Web application), then click Browse to open the Select project dialog box, using which you can select the project to be used as a template for your new application.
   
The process template name (for instance, Assignment) is shown in the Project box, and a number in the Version box is automatically inserted that is one increment higher than the selected process file. The process template name and version (example, Assignment_V2) is entered in the remaining read-only fields. You can change the project name, or change or delete the version number.
3. Click Next to continue.
4. After entering the description (optional), click Finish in the BPM Project wizard.

A new project folder is listed in the Project Explorer view, along with the process template file with an SPT extension; example, NewApp_v2 and NewApp_v2.spt.

Creating a simulation project

Business Process Modeler provides the Simulation project, which supports all simulation functions, and allows for easier integration of additional functionalities in future releases.

To create a Simulation project in Business Process Modeler:

1. From the File menu, select New > Simulation Project to launch the New Simulation Project wizard.
2. In the first page of the New Simulation Project wizard, enter the name of the simulation project in the Project Name box. The name can contain only alphanumeric characters, and must not contain any blank space or special character except underscores (“_”). Ensure that the project name starts with an alphabetic character. Optionally, enter a label and description in the respective boxes.
3. Click Next to open the second page of the New Simulation Project wizard, in which you can define the simulation properties for this project.
   
a) In the Start Simulation section, select either of the following options to define when to start the simulation:
   
   • At current system time option to activate the simulation at the current time of the system.
Chapter 3: Developing Business Process Modeler projects

- **At time** option to activate the simulation at a specified time other than system time. After clicking this option, you need to specify a date and time. To do so, click the *ellipsis* button beside the **At time** option. For details, see **Specifying a date** on page 166.

b) From the **Stop Simulation** section, select any of the following options to define when to stop the simulation:

- **On completion of process instances** option to stop the simulation when all the instances of the processes in the simulation project are completed.

- **At time** option to stop the simulation at a specified time. You can use this option only if you have selected the **At time** option in the **Start Simulation** section. You need to specify a stop time later than the simulation start time. To specify date and time, click the *ellipsis* button beside the **At time** option. For details, see **Specifying a date** on page 166.

- **After duration** option to specify a relative end time for simulation, in terms of duration. You can specify the duration in terms of hours, minutes, and seconds by entering values in the respective boxes. In this case, the simulation continues even after all the instances are completed, for the specified duration.

4. Click **Next** to open the third page of the New Simulation Project wizard, in which you can define the project calendar settings for this simulation project.

You can use the **Project Calendar** page to define the default calendar settings for your simulation project.

a) From the **Work Days** section, select (or clear) the appropriate checkboxes for the work days.

b) The **Sessions** section table displays the default time segments. The default workhours are 9:00 - 13:00 and 14:00 - 18:00.

- To add a session, click **Add** to open the **Session** dialog box. Specify the start time (hours:minutes) and the end time (hours:minutes) of the session in the respective boxes. Click **OK** to add the session to the **Sessions** section table.

- To edit any of the listed sessions, select the session, then click **Modify** to open the **Session** dialog box, in which you can modify the start and end time.

- To remove any of the listed sessions, select the session, then click **Delete**. Business Process Modeler prompts you for confirmation. Click **OK** to remove the session.

c) Click **Next** to continue.

---

**Note:** The settings defined here are applied to the default scenario in your simulation project. You can modify these settings for the default scenario, as well as for any added scenarios in the Simulation perspective, after creating the simulation project. For details, see **Modifying simulation settings for a scenario** on page 154.

---

5. In the fourth page of the New Simulation Project wizard, you can add the processes, which you want to include in this simulation. You can also configure the simulation settings for each added process.

a) To add a process to the simulation project, click the **Add** ( ) icon in the **Select** section to open the **Required Project Selection** dialog box. From the list of current processes, select the process to be added, then click **OK**.

The added process is displayed in the **Select** section. You can add as many processes as required.
**Note:** To remove a process from the simulation project, select the process, then click the `Remove (×)` icon.

For each added process, you can configure the simulation start settings (available only for multiple processes), the instance count, and the type of randomization.

b) From the **Start** section, select the **At time** option to set an absolute time and date, as described in Step 3a. The start time for a process must be later than the absolute start time (if specified) for the simulation project. Alternatively, select the **After duration** option to specify a relative start time for the process simulation, as described in Step 3b.

**Note:** You cannot set an absolute time and date for the process if you have specified the simulation start time as current system time.

c) Use the **Count** section to specify the number of process instances. You can either keep the instance count unlimited or specify a maximum value in the **Limited To** box. You cannot specify an unlimited instance count if you have selected the **On completion of process instances** option in the previous wizard page.

d) From the **Type** drop-down list in the **Distribution** section, choose a method of randomizing the duration of each interval between process instances in the simulation. For information regarding randomizing methods, see Configuring and running simulation on page 151.

6. Click **Finish** to complete the creation of the Simulation project.

7. If you are currently not in the Progress OpenEdge BPM Simulation perspective, then Process Modeler prompts you to switch to this perspective. Click **Yes** to open the simulation project in the Progress OpenEdge BPM Simulation perspective. Alternatively, click **No** to open the simulation project in your current perspective. If you select the **Remember my decision** checkbox, then Business Process Modeler does not display any prompt and executes your selected command the next time you create or open a simulation project file (**SST**). For further details regarding configuring and running a simulation, see Configuring and running simulation on page 151.

**Note:** You can modify the above selected configuration for opening the simulation configuration perspective using the **Simulation > UI** page in the **Preferences** dialog box. For information, see Using the Simulation page on page 78.
Designing a process template diagram

This chapter describes how to design a process template diagram in Business Process Modeler.

Note: Alternatively, you can design a process template without the knowledge of BPMN shapes. For details, see Working with the Overview page on page 65.

For details, see the following topics:

- Creating a process template diagram
- Connecting worksteps
- Adding notes

Creating a process template diagram

Developing Business Process Modeler projects on page 27 describes how to use appropriate wizards to create the project files for process models and Web applications. This section describes how to design a process template for both types of projects and the differences between them.

After completing the New Process Model or the New Web application wizards, the Business Process Modeler perspective is launched, with the new process template displayed in the Content pane.

If you did not use the Template section in the wizards, then the project opens a blank process template file (with an SPT or an SWT extension) in the Content pane. If you used the Template section, then the process you selected as a template appears in the Content pane.
The Tasks pane provides Shapes, Performers, and other elements that are available for the selected process. The name of the current process template is displayed above the Content pane, and the Content pane tabs at the bottom enable you to view the template diagram, dataslots, performers, or simulation data for the process.

A process template typically consists of a single Start workstep, one or more Activity worksteps, and at least one End workstep. The following procedure describes how to create a process template by adding shapes, connectors, and other component templates to the Content pane.

1. From the Tasks pane, click the **Draw Shapes** link and then drag any of the listed shapes into the blank Content pane to add them to the process template diagram, beginning with the Start shape ( ・) .
   
a) Select an Activity shape ( □ ) to represent worksteps performed by a human performer (only for Process Models), an adapter, or a subprocess and drag them into the Content pane. Add more Activity Shapes as required.

b) Similarly, add an End workstep ( ノ ). The process template must include at least one End workstep. Similarly, you can add the remaining Shapes depending on your process template requirements.

2. From the Tasks pane, use the **Connect Shapes** link to connect the worksteps. The worksteps and other shapes contain up to 12 points of connection, enabling you to make multiple connections to worksteps and shapes. For more information on workstep connectors, see *Connecting worksteps* on page 43. *Table 12: Completing a process flow diagram* on page 42 lists the operation you can perform to complete the process flow diagram.

<table>
<thead>
<tr>
<th>Operation</th>
<th>See</th>
</tr>
</thead>
<tbody>
<tr>
<td>Define dataslots</td>
<td>Using dataslots on page 81.</td>
</tr>
<tr>
<td>Add workstep performers</td>
<td>Defining and assigning performers on page 95.</td>
</tr>
<tr>
<td>Define an alert</td>
<td>Using alerts on page 147.</td>
</tr>
<tr>
<td>Add process simulation parameters.</td>
<td>Configuring and running simulation on page 151.</td>
</tr>
<tr>
<td>Define workstep properties</td>
<td>Setting workstep properties on page 109.</td>
</tr>
<tr>
<td>Define workstep presentation</td>
<td>Defining workstep presentation format on page 137.</td>
</tr>
</tbody>
</table>

3. From the Modeler palette, click the **Check Diagram** ( ![checkmark](//) ) icon to determine the validity of the process.

If the new process template is not valid, then invalid items are listed in the Problems view; and a message is displayed listing the invalid items. If you have correctly defined the process template, then “The diagram is complete” message appears. Click **OK**.

4. To save changes to all open projects and files, from the **File** menu, click **Save All**.

The major differences between editing functions for a Process Model and a Web application are described below:

• There are fewer options in the Tasks pane. Unlike a Process Model, creating phases and Swim Lanes are not supported in Web applications.
There are fewer Shapes available for Web applications. The AND Gateway and Exclusive Or-Join shapes are not supported.

The Alerts tab is not present as this feature is not supported in Web applications.

Changing shapes

Business Process Modeler allows you to change the shapes after adding them to your Content pane. This eliminates the need to delete an inappropriate shape and drag the correct shape to the Content pane. Table 13: Changing shapes on page 43 lists the valid shapes that you can change to for each process template element.

Table 13: Changing shapes

<table>
<thead>
<tr>
<th>Shape</th>
<th>Change to (in BPM projects)</th>
<th>Change to (in Web applications)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start</td>
<td>All other shapes, except End.</td>
<td>All other shapes, except End.</td>
</tr>
<tr>
<td>Activity</td>
<td>All other shapes, except Start and End.</td>
<td>All other shapes, except Start and End.</td>
</tr>
<tr>
<td>Decision</td>
<td>Activity, AND Gateway, Message.</td>
<td>Only Activity.</td>
</tr>
<tr>
<td>XOR Join</td>
<td>All other shapes, except Start and End.</td>
<td>Not Applicable.</td>
</tr>
<tr>
<td>OR Join</td>
<td>All other shapes, except Start and End.</td>
<td>All other shapes, except Start and End.</td>
</tr>
<tr>
<td>AND Gateway</td>
<td>All other shapes, except Start and End.</td>
<td>Not Applicable.</td>
</tr>
<tr>
<td>Message</td>
<td>All other shapes, except Start and End.</td>
<td>Not Applicable.</td>
</tr>
<tr>
<td>End</td>
<td>All other shapes, except Start.</td>
<td>All other shapes, except Start.</td>
</tr>
</tbody>
</table>

To change a shape:

1. Right-click the shape that you want to change, and then point to the Change To option.

   Business Process Modeler displays the list of valid shapes that you can change to.

2. Click the shape that you want to change to from the options provided. The shape is changed and the altered shape element is displayed in the Content pane.

Connecting worksteps

You can use the Connect Shapes link in the Tasks pane to connect the several shapes or process template elements in your process template. The connections (or links) between the process elements determine the workflow of the process. Each shape contains up to 12 points of connection, enabling you to make multiple links to worksteps and shapes. Note that when you click the Connect Shapes link, the Tasks pane displays three types of connectors for—Normal flow, Compensation flow, Timeout flow—which you can use.

Table 14: Link types on page 44 describes these link types and their appearance when used on the template workstep:
Table 14: Link types

<table>
<thead>
<tr>
<th>Link</th>
<th>Appearance</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normal (Default)</td>
<td><img src="image" alt="Normal" /></td>
<td>The Normal connector type provides standard connectors to worksteps. In the case of a workstep with multiple outgoing links, the default link (indicated by the slanting line in adjoining figure) indicates a link with no condition.</td>
</tr>
<tr>
<td>Normal (Conditional)</td>
<td><img src="image" alt="Normal" /></td>
<td>This is another Normal connector type. In the case of a workstep with multiple outgoing links, this conditional link indicates a link with a condition. The workflow selects this link path if the condition is satisfied.</td>
</tr>
<tr>
<td>Compensation</td>
<td><img src="image" alt="Compensation" /></td>
<td>Indicates the compensatory steps to be taken in the event of an Error occurring during the execution of the process or a Recovery. The link from the source workstep of a Compensation Flow is marked with a <img src="image" alt="Compensation" />. When you add the Compensation Flow to a diagram, the target workstep of the Compensation Flow automatically becomes a Rollback Point (see Defining a Rollback on page 126) and is marked with a Compensation symbol (↩).</td>
</tr>
<tr>
<td>Timeout</td>
<td><img src="image" alt="Timeout" /></td>
<td>Indicates the direction of a workflow after Overdue Actions have been executed and the Last Overdue action is completed. Add the Timeout Flow link to the diagram and the source workstep of a Timeout Flow is marked with a <img src="image" alt="Timeout" />. For more information, see Defining a Timeout in worksteps on page 127.</td>
</tr>
</tbody>
</table>

**Note:** Keep the Optimize connectors when moving shapes checkbox clear to maintain the point of connection to the shape when you move the connected shape. Alternatively, if you select this checkbox, the shortest path between shapes is used for the connection. For example, if the position of "Activity2" in the process diagram is closer to "Activity1" than the position of "Activity3," then any connector from Activity1 is joined to Activity2.

After choosing one of the above flow types, the representation of the cursor in the Content pane changes to reflect the type of flow you selected. Table 15: Shape and Output Link Matrix on page 44 indicates the type of links that can be used with typical process template components and the number of links (single, multiple, or none), which are allowed to originate from each element.

Table 15: Shape and Output Link Matrix

<table>
<thead>
<tr>
<th>Shape/Workstep</th>
<th>Default</th>
<th>Conditional</th>
<th>Compensation</th>
<th>Timeout</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start</td>
<td>Multiple allowed</td>
<td>Not allowed</td>
<td>Not allowed</td>
<td>Not allowed</td>
</tr>
<tr>
<td>Decision</td>
<td>One allowed</td>
<td>Multiple allowed</td>
<td>Not allowed</td>
<td>Not allowed</td>
</tr>
<tr>
<td>Split</td>
<td>Multiple allowed</td>
<td>Not allowed</td>
<td>Not allowed</td>
<td>Not allowed</td>
</tr>
<tr>
<td>And-Join</td>
<td>One allowed</td>
<td>Not allowed</td>
<td>Not allowed</td>
<td>Not allowed</td>
</tr>
</tbody>
</table>
### Using multiple links

You can use multiple incoming and outgoing links for a workstep without using an intermediary Or-Join, AND or Decision. In addition, Business Process Modeler supports multiple outgoing links for Start worksteps; and multiple incoming links for Decisions and End worksteps.

The following restrictions apply to workstep connections:

- You cannot have more than one link of the same type with the same source and target worksteps.
- A link cannot originate from and terminate at the same workstep.
- The Or-Join and XOR-Join gateways can have only one outgoing link. When an AND Gateway has multiple incoming links, it acts as an And-Join and can have only one outgoing link.

**Note:** Even though you can now design a business process without using the Or-Join or Decision gateways, these worksteps are still available for users who want to add them to processes to clarify or highlight areas of the process’s workflow.
Using multiple incoming links to worksteps

You can add multiple incoming links to worksteps, as shown in Activity 3 in Figure 1: A process diagram with multiple connections on page 46. You can also add multiple incoming links to Decision, Or-Join and End worksteps. These multiple incoming links are the equivalent of an Or-Join shape and, in this case, indicates that Activity 3 will be performed when either Activity 1 or Activity 2 is completed.

Figure 1: A process diagram with multiple connections

Using multiple outgoing links from worksteps

You can add multiple outgoing links to worksteps, as shown by the links out of Activity 3 in Figure 1: A process diagram with multiple connections on page 46. You can also add multiple outgoing links from Decision, Or-Join, and Start worksteps. With this type of link, you can add conditions that direct the process flow.

Note: All links are default links unless you clear the Default checkbox in the Link Properties dialog box (for more information, see Defining link properties on page 124).

If all of the outgoing links from a workstep have no specified condition, then these links are the equivalent of an And shape, indicating that once the predecessor workstep is completed, the successor worksteps are activated simultaneously. For example, the links to Activity 1 and 2 have no condition and these two activities are both started after the Start workstep is completed.

If one or more of the outgoing links from a predecessor workstep has (or have) a specified condition, then these links are the equivalent of a Decision shape. Once the predecessor workstep is completed, one or more successor worksteps can be activated if the links to them fulfill specified conditions. But if these conditions are not met in any of the links, then all links with no condition are executed. For example, the links from Activity 3 to Activities 4, 5, and 7 each have conditions and one or more of these activities are executed when the specified conditions are fulfilled; the links from Activity 3 to Activity 6 has no specified condition and this activity will be executed when the specified conditions for Activities 4, 5, and 7 are not fulfilled.

Note: If there are multiple outgoing links in a Web application, then you must assign a unique name to each outgoing link.
Using multiple incoming/outgoing links with gateways

Gateways are diamond-shaped objects in a BPMN process diagram that represent a change in the workflow—it may indicate the joining, merging, splitting, or deciding of the flow’s direction. In Business Process Modeler, gateways include Decision (including Exclusive Decisions), XOR Join, OR Join, and AND Gateway. Decisions have a single incoming link and multiple outgoing links. Or Join and XOR Join gateways have multiple incoming links and a single outgoing link. When an AND Gateway has a single incoming link, it can have multiple outgoing links—in this case, the AND Gateway acts as an AND Fork (or Split). These variations in incoming/outgoing links for gateways are illustrated in the following figure.

**Figure 2: Examples of Gateway Links**

If you want to start multiple, parallel worksteps after an Or Join or XOR Join gateway, then you must insert an AND Gateway immediately after the Or Join or XOR Join gateway.

Defining Loops in the workflow

You can now define loops in the workflow without using multiple links to and out of worksteps, and without using Decision shapes. For more information, see Defining a Loop condition on page 115.

Adding notes

You can add a note (a Sticky Note, an Annotation, or a Group notation) to any element in a process template diagram. Sticky Notes and Annotations generally have the same functions, and they only differ in visual representation. You can use a Sticky Note or Annotation to indicate specific features or conditions, or as prompts or reminders for other users (for example, Must be reviewed by all managers). Use the Group notation to select and insert a caption that:

- Describe a group of worksteps that share a similar task (for example, all activities performed by the HR Department in Hiring), or
- Require the same performer (for example, highlighting all worksteps Performed by Managers Group in HR Department).

To insert a note into a process:

1. Click the Create Annotations link in the Tasks Pane and drag the Sticky Note ( ), Annotation ( ), or Group notation ( ) shape into the Content pane. You can also drag and drop any of these notes onto a workstep or other shape, which creates a connection between it and the note.
2. Click the note to view its properties in the Properties view.
a) In the **General** tab, you can change the appearance of the note (for example, Sticky Note to Group). Use the **Type** drop-down list to specify the new type for the existing note.

b) Click **View/Edit** link to open the **View/Edit** dialog box, in which you can enter the text of the note, or the **grouping's** caption in the text area. For a Group notation, enter a caption for the group association (for example, *Review all grouped worksteps*). Use the toolbar icons to format the text as needed.

c) You can also check the spelling and insert a link, by right-clicking the text area and selecting the appropriate options. For instance, to add a link to a note, select **Insert > Link** to open the **Link Properties** dialog box. Specify the text to be used as the hyperlink and the URL.

d) Click **OK** to apply the changes to the selected note and return to the **Properties** view.

e) From the **Background** section, you can select a background color only for Sticky Notes. You cannot change colors for Annotation and Group notations. You can also click **More** to display more color options.

**Note:** You can also change the background color of Sticky Notes by selecting the sticky notes in your Content pane and then clicking the **Color** icon from the Modeler palette. From the color palette, you can select one of the listed colors, or click **More** to open the **Color Chooser** dialog box (Creating swim lanes on page 105) to define your custom color.

f) From the **Associate With:** drop-down list, you can associate the Sticky Note or Annotation notation with a specific workstep by selecting from the worksteps listed. To disassociate a note from a workstep, select **(none)** from the drop-down list.

After defining the property of the note, the notes now appear in the process template diagram.

3. Use your cursor to move or resize the Sticky Note, Annotation, or Group notation as required.
Managing gestures

Business Process Modeler provides mouse gestures to quickly add shapes, connectors, and layouts to your Content pane, as well as perform commonly-used actions in your process template.

This chapter describes how to use mouse gestures in your process template diagram in Process Modeler, and to create custom gestures using the Gesture Editor.

For details, see the following topics:

- Using mouse gestures
- Creating custom gestures
- Saving custom gestures
- Using custom gestures

Using mouse gestures

You can view the set of predefined mouse gestures in the Default Gestures dialog box.

1. Create or open the process template diagram (SPT or SWT) in which you want to use mouse gestures.

2. Click the Show Gestures (esture) icon from the Modeler palette, to open the Default Gestures dialog box.

Note: Web applications support fewer shapes and layout gestures.
Chapter 5: Managing gestures

3. Point to each of the shapes, layouts, and actions to view the gesture details in the **Gesture Details** section. The red dot indicates the starting point for the gesture.

4. Click **OK** to close the **Default Gestures** dialog box.

To use any gesture in your Content pane, drag your right mouse button in the required direction. To connect shapes using gestures, press **CTRL** key and then drag your right mouse button between shapes to connect them.

**Note:** By default, you can use gestures to connect shapes with the normal flow connector. To connect shapes using the other connector types, select the other connector types before using gestures to connect shapes. For more information, see **Connecting worksteps** on page 43.

---

Creating custom gestures

Business Process Modeler provides the **Gesture Editor**, which allows you to create custom gestures and replace the default gestures.

**Using the Gesture Editor**

**To start the Gesture Editor:**

1. From the **Tools** menu, click **Gestures** to open the Gesture Editor.

2. To populate the Gesture Editor with predefined actions and parameters, click **File > New**.

The Gesture Editor consists of the following three panes:

- Actions pane, containing the list of predefined gesture actions, as listed in **Table 16: List of predefined actions** on page 50. For information regarding the shapes used, see **Using shapes** on page 22.
- The middle pane, in which you can view (and edit) the action selected in the Actions pane, as well as draw one or many gestures for each action.
- Gestures pane, which displays the gestures associated with each action.

**Table 16: List of predefined actions**

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>shape_start</td>
<td>Creates a Start workstep.</td>
</tr>
<tr>
<td>shape_activity</td>
<td>Creates an Activity workstep.</td>
</tr>
<tr>
<td>shape_activity_performer</td>
<td>Creates an Activity workstep with a performer. You can assign the performer, which can be a human, adapter, or subprocess. For information regarding performers, see <strong>Defining and assigning performers</strong> on page 95.</td>
</tr>
<tr>
<td>shape_decision</td>
<td>Creates a Decision gateway.</td>
</tr>
<tr>
<td>shape_xor</td>
<td>Creates an Exclusive Or-Join gateway.</td>
</tr>
<tr>
<td>shape_or</td>
<td>Creates an Or-Join gateway.</td>
</tr>
</tbody>
</table>

---

OpenEdge Business Process Modeler: User's Guide
Designing gestures

To design a gesture in the Gesture Editor:

1. From the Actions pane, select the action for which you want to design the gesture.

2. Modify, if required, the default text in the Label and Description boxes to provide additional information for the gesture. You can enter a static label or description; for instance, “End” for label and “Adds an End workstep” for description.

   Business Process Modeler converts any value starting with the “$” sign with the corresponding string in the localization file (example, designer.properties).

3. In the drawing area provided, drag your mouse to draw the gesture shape to be used for the corresponding action. To accept the drawn shape and clear the drawing area, click Accept. To discard the drawn shape, right-click in the drawing area.

4. After you click Accept, the drawn shape is displayed as a gesture in the Gestures pane. To remove the added gesture from the Gestures pane, select the gesture and click Discard.
Depending on the complexity of the action, we recommend that you create multiple gesture samples. For simpler actions, 2 or 3 gesture samples are adequate. For complex actions, you must create more samples.

Repeat Step 3 to Step 4 to add multiple gesture samples.

You can use the checkbox for each gesture in the **Gestures** pane to select the icon to be displayed for this action in the help for the customised gestures. If you select multiple checkboxes, then the gesture that you select first is displayed as the gesture icon and the remaining gestures are displayed in the **Gesture Details** section.

**Guidelines for gestures**

The guidelines to be followed when designing a gesture are listed below:

- The starting point of a gesture is important. You can use the starting point to distinguish several similar shaped gestures.

- You can use the direction to create two different gestures for the same shape. For instance, you can use a clockwise-drawn circle for a Start workstep, and anti-clockwise circle for the End workstep.

- Always create multiple gesture samples for each action. This ensures that the gesture recognition algorithm compensates most of the variations, thus resulting in reliable recognition.

- Do not try to be too precise when drawing the gesture sample. Do not make the sample size too big or too small. Draw them as you would when using them in practice.

- Draw each gesture with a single move of the mouse. Releasing your mouse indicates the end of the gesture.

**Saving custom gestures**

Business Process Modeler stores all gestures (default and custom) in the `Workspace_Home\.com.savvion.studio\gestures` folder. The default gesture set is stored as `default.ptp`. All custom gestures are stored as `GLF` files (Gesture Library File). For helping you get started, Business Process Modeler provides a sample gesture set (`sample.glf`) file.

To save your custom gesture:

1. Use the **Gesture Editor** to create your custom gestures for each required action.
2. Click **File > Save** to open the **Save** dialog box.
3. Type the gesture filename, then click **Save**.

You can open your custom gesture file (using **File > Open** option in **Gesture Editor**) and modify the same.

**Using custom gestures**

You can now use your saved custom gesture in your process template diagram by replacing the default gesture set (`default.ptp`) with your custom gesture file.

1. Click **Tools > Preferences** to open the **Preferences** dialog box (described in Setting Business Process Modeler preferences on page 76).
2. Expand **Business Process Modeler > Diagram**.
3. From the **Gestures** section, change the default gestures file (**default.ptp**) by clicking **Browse** beside the **Gestures file** box, then select your custom gestures file in **GLF** format.

4. To close the **Preferences** dialog box, click **OK**.

5. Open the process template diagram (**SPT** or **SWT**) in which you want to use your custom gesture.

6. Click the **Show Gestures** (acional) icon from the Modeler palette, which now displays your custom gesture set. You can now use your custom gesture set to add shapes to your process template.
Performing additional Business Process Modeler operations

This chapter describes how to use Business Process Modeler for performing additional operations.

For details, see the following topics:

- Publishing the process
- Managing pages
- Generating 360 degree view
- Printing the process template
- Exporting the process template
- Managing phases

Publishing the process

After you have defined and saved the process template in Business Process Modeler, it is placed in the `ProcessModeler\workspace\models` folder. You can open and edit the process in Progress Developer Studio for OpenEdge. After saving the changes, you can publish the process from Progress Developer Studio for OpenEdge to Business Process Portal. For information regarding publishing applications, see the *Progress Developer Studio for OpenEdge User’s Guide*. 
After the process is published, it is displayed as an installed application in the BP Server Applications page or the BPM Workflow Applications page in the Administration module in Business Process Portal. After a user with administration privileges installs the application in Business Process Portal, a valid application user with the correct permissions can then open it as a Business Process Server application.

### Managing pages

Business Process Modeler provides a default number of nine pages (in a 3x3 grid) in the **Diagram** tab to design your process template diagram. Business Process Modeler automatically adds pages if your process template diagram does not fit within the 3x3 grid.

You can now add and manage pages in the **Diagram** tab, thus enabling you to control the page size more efficiently.

- From the **Diagram** tab, right-click a blank portion of your process template diagram, point to **Pages** option, then select any of the following options:

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add to right</td>
<td>Adds a page to the right. For the default 3x3 grid, this operation extends the grid size to 3x4.</td>
</tr>
<tr>
<td>Add to bottom</td>
<td>Adds a page to the bottom. For the default 3x3 grid, this operation extends the grid size to 4x3.</td>
</tr>
<tr>
<td>Fit to process</td>
<td>Use this option to save paper when you want to print a process template. Select this option to reduce the page count to fit the process template diagram.</td>
</tr>
</tbody>
</table>

### Generating 360 degree view

Business Process Modeler provides a 360° view, which is a multi-layered Chart view of the current process template diagram. You can generate the 360° view especially for complex process templates, which consist of multiple activity (and adapter) worksteps and complex workstep traversal paths.

**To generate the 360° view:**

- From the Modeler palette (see Business Process Modeler palette on page 23), click the **Show 360° View** icon to launch the 360° View of the current project.

The 360° view diagram consists of color-coded sections, each representing a workstep. Each section displays the label of the workstep along with the estimated time (in days, hours, and minutes) when the workstep is activated. The estimated time is calculated from the beginning of the process. For processes containing multiple paths, each path is depicted as a sub-section in the chart.
**Note:** The estimated start time of each workstep can be calculated only when the duration of the preceding worksteps are set in absolute values (in days, hours, minutes, or seconds). The estimated start time cannot be calculated when workstep duration is bound to a INTEGER dataslot. For setting workstep duration, you can use the Overdue in box in the General tab of the Activity workstep's Properties view (as discussed in Specifying general properties of Activity workstep on page 113).

The 360° view displays each workstep type with the following color code.

**Table 17: 360° view color code**

<table>
<thead>
<tr>
<th>Workstep Type</th>
<th>Color</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activity</td>
<td>Blue</td>
</tr>
<tr>
<td>Adapter</td>
<td>Violet</td>
</tr>
<tr>
<td>Start / End / Gateways</td>
<td>Brown</td>
</tr>
<tr>
<td>Subprocess</td>
<td>Orange</td>
</tr>
</tbody>
</table>

You can perform the following operations in the 360° view.

**Table 18: 360° view operations**

<table>
<thead>
<tr>
<th>To...</th>
<th>Operation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pan the diagram</td>
<td>Drag your mouse.</td>
</tr>
<tr>
<td>Zoom in (or out) on the diagram OR view all workstep labels</td>
<td>Use your mouse scroll wheel.</td>
</tr>
<tr>
<td>Rotate the diagram around its center point</td>
<td>Drag your mouse with the right button.</td>
</tr>
<tr>
<td>Open the subprocess in the 360° view</td>
<td>Click the subprocess workstep section. For additional details, see Opening a subprocess on page 58.</td>
</tr>
<tr>
<td>Calculate a traversal path duration</td>
<td>Move your mouse over the diagram to highlight the selected path. The estimated duration of the selected path is displayed in the Path Length box.</td>
</tr>
</tbody>
</table>

The 360° view also contains the following icons:

- **Show/Hide Loops** icon: For any process containing loops, the default 360° view does not include the worksteps that follow when a loop is executed. You can click this icon to display these worksteps in semi-transparent state. In this case, the worksteps gradually progress with fading color.

- **Timeline View** icon: Click this icon to switch to the Timeline view, which displays the thickness of each workstep corresponding to the time it is likely to take to complete.
The worksteps in the Timeline view with greater thickness require more time to execute. As Activity worksteps are performed by humans and are likely to take the maximum time to complete as compared to the other workstep types, the Timeline view shows Activity worksteps with greater thickness. You can zoom in on the diagram to view the other workstep types in detail.

**Note:** You must click the individual icons again to return to the previous view.

---

**Opening a subprocess**

You can also view an inline subprocess in the 360° view, by clicking the subprocess workstep section of the parent process diagram. For information regarding an inline subprocess, see **Defining an inline subprocess** on page 101. The 360° view of the parent process is replaced with that of subprocess.

**Note:** This feature is not available for Web applications because Web applications do not support an inline subprocess.

Business Process Modeler supports an inline subprocess within another inline subprocess. You can use the breadcrumb trail in the 360° view to track the process hierarchy.

You can click the process name button in the breadcrumb trail to reload the 360° view of the parent process in the hierarchy.

---

**Printing the process template**

You can generate a print preview of a process template diagram before printing it.

**To generate the print preview:**

1. Open the process template to be printed.
2. From the Modeler palette (see **Business Process Modeler palette** on page 23), click the **Print Preview** icon to view the process diagram in the Print Preview mode.
   
   In the Print Preview mode, the Tasks pane displays the print-related functions and other options.
3. To reduce or enlarge the image scale for printing, increase (or decrease) the scaling percentage in the **Scaling factor** box in the **Options** panel.
   
   Alternatively, select the **Fit to width/height** option in the **Scale Mode** drop-down list, then enter the width and height in pages in the respective boxes to set the image scale to fit to the specified pages.
4. Define the page setup for printing by clicking **Page setup** link from the **Print Preview Tasks** panel to open the **Page Setup** dialog box.

   The dialog box that appears depends on the type of printer you are using. Select the size of the printed document—Letter (8.5 x 11 inches), Legal (8.5 x 14 inches), 11 x 17 inches—, its source, and specify Portrait or Landscape orientation. Use the fields in the Margins panel to adjust the page’s margins.
5. Click the **Print this diagram** link to print the displayed process template.

   The **Print** dialog box opens, in which you can select a number of printing options, including number of copies and page range. The dialog box, which appears depends on the type of printer you are using. If you are using Windows, then click **Properties** to define additional print properties.

6. To exit the Print Preview mode, click the **Exit print preview** link.

### Exporting the process template

You can export the process template in the following formats:

- Web Page (**HTML**)
- SVG image
- JPEG image
- XPDL file
- Microsoft Project file
- Process Summary in PDF or MS Excel format

You can even export large process template diagrams as a single file.

**To save the process template’s file and export it in a supported format:**

1. Open the process template, which you want to export.

2. From the Modeler palette (see *Business Process Modeler palette* on page 23), click the **Export** (miş) icon. The Tasks pane displays the **Export Tasks** panel, which includes the following links.

<table>
<thead>
<tr>
<th>Links</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save as a single JPEG image</td>
<td>To export the process as a JPEG image.</td>
</tr>
<tr>
<td>Generate a Web page</td>
<td>To export the process as an HTML page.</td>
</tr>
<tr>
<td>Save as an SVG image</td>
<td>To export the process as a Scalable Vector Graphics image.</td>
</tr>
<tr>
<td>Generate XPDL</td>
<td>To export the process as an XPDL file. You can use the exported XPDL file as template for creating a new process. For more information, see <em>Importing XPDL files</em> on page 36.</td>
</tr>
</tbody>
</table>
### Generating a process summary

Business Process Modeler enables you to generate a Process Summary in PDF and MS Excel format, which presents a summary of the worksteps and other process features for the selected process template.

**To generate a Process Summary document:**

1. Open the process template for which you want a process summary.
2. From the Modeler palette (see Business Process Modeler palette on page 23), click the Export ( cadeaux) icon.
3. From the Export Tasks panel, click Save as Process Summary to open the Document Generation dialog box.
4. Select the Optional Sections, which you want to retain in your process summary.
5. From the Output drop-down list, select the format in which you want to generate the process summary output. The available formats are PDF and Excel.
6. Click Generate to generate the Process Summary.
**Viewing process summary**

The Process Summary document, whether generated in PDF format or Excel format, contains the same information of the process summary.

The first page displays a Process Properties section, including data on General properties, Attributes, and a History of the process (that is, when it was created, saved, checked in, etc.). From the Process Diagram section, you can click the **Click here to view process diagram in a different window** link to open the process diagram file.

**Note:** Process Summary reports for Web applications do not contain all the sections that are displayed for process models. This is because features that are unsupported in Web applications, such as the Simulation section, are not shown in Process Summary reports for Web applications.

To explore the process summary:

1. Use the bookmarks in the left pane to open a section for a specific workstep, or to view performers, dataslots, alerts, or notes (if notes are present in the process).

2. To see the process summary for a specific workstep, expand the **Worksteps** bookmark and then click the workstep name to display the following information:
   - Workstep details including its general properties (including Loop and skippable conditions if present) in the **General** section.
   - Information about dataslots in the **Fields** section. Click the **View All User Dataslot Properties** link to open the **Dataslots** section.
   - Information regarding workstep collaboration (if any) in the **Collaboration** section. This information is displayed only if you have selected the **Collaboration** check box in the **Document Generation** dialog box.

   For Subprocess worksteps, click the **Click here to view <AppName> subprocess document** link under the Subprocess Document heading to open the Process Summary document for the nested process.

3. Click **Links** bookmark to view all the links in the process, along with the source and target worksteps for each link, and associated conditions (if any).

4. Click **Performers** bookmark to open the Performers section, which lists information about all the performers available to the process.

5. You can also click **Dataslots, Alerts** (visible when the process contains alerts), or **Notes** (visible when the process contains notes).

6. Click **File > Exit** or the **Close** button (❌) to exit the Process Summary PDF.
Managing phases

A phase is a set of tasks, which signifies the completion of a project segment. You can use the phase function to divide all the tasks in a process into sets of tasks (or subtasks). For example, in a typical Sales process, all subtasks which help achieve Customer Prospecting can be considered a phase.

Phases are represented by vertical lines and are similar to implementing Swim lanes (as discussed in Using swim lanes on page 105). You can define a phase and its worksteps in the Diagram tab. In the Overview tab, you can view the phase to which a particular task belongs.

Note: Phases are not supported in Web applications.

Creating a phase

You can create a new phase for a Process Model project in the Diagram tab.

To create a phase:

1. Open the Process Model project (SPT) in the Diagram tab.
2. From the Tasks pane (Business Process Modeler Tasks pane on page 21), click the Create Phases and Swim Lanes link in the Design Task panel, and then click the Phase icon ( ) to open the Phase Properties dialog box.

   Note: You can also use the ‘P’ gesture to add a phase. For details, see Using mouse gestures on page 49.

3. Enter the ID and Name of the new phase in the respective boxes.
4. Click OK to add a new phase to the process template diagram. Move all the worksteps that belong to this phase into the added phase, as seen in the Figure 3: Business Process Modeler interface with added phases on page 63.
Note: You cannot move a phase.

Figure 3: Business Process Modeler interface with added phases

Resizing a phase

You may need to resize a phase either to add a shape to the phase or to quickly move a shape into (or out of) this phase.

- To increase the width of a phase, select the Move shapes when resizing phases check box, before resizing the phase. Shapes adjacent to the phase move as you resize the phase.
- To make the adjacent shapes a part of this phase or to remove a shape from this phase, clear the Move shapes when resizing phases checkbox, before resizing the phase. Shapes adjacent to the phase do not move as you resize the phase.

To resize a phase, position your cursor over the space between two phase headers, then use the slider to adjust the width to the left or to the right.

Performing additional phase operations

You can perform additional operations on a phase by right-clicking the phase header (see the popup menu in Figure 3: Business Process Modeler interface with added phases on page 63). Additional operations include changing the phase header display, modifying existing phase properties, and removing a phase.

- To change the phase display header, from the View menu, select either Name or ID to display your selection in the header of each phase.
- To change the properties of the selected phase, click Properties to open the Phase Properties dialog box, in which you can modify the current phase properties.
- To remove the selected phase, click Remove Phase. All the worksteps in this phase are removed along with the phase.
Working with the Overview page

Business Process Modeler allows process modeling and analyzing through the Diagram view. In certain situations, this procedure can be cumbersome, as there is a learning curve involved for the business user, who needs to understand the usage and semantics of BPMN shapes before defining a meaningful process.

Consider an instance where a business user wants to quickly outline a large process with a large number of tasks. Instead of adding shapes and defining their properties in the Diagram view, a business user would probably rather work with a project-oriented view of the process by defining a set of tasks, the task/subtask relationships, and additional details without ever needing to switch to the Diagram view. The Diagram view is still a useful view especially for complex flows. However, it is not the only view, nor is it the only editor for defining new worksteps. Business Process Modeler provides the Overview page, which is an effective tool to support project-oriented processes.

For details, see the following topics:

• Introducing the Overview page
• Managing tasks

Introducing the Overview page

The Overview page (or tab) provides a project-oriented approach - including activity timelines - to designing a process, where you can add a set of tasks (or activities), define their relationship, and configure the properties, without switching to the Diagram tab.

The Overview page provides the following benefits:

• You can reduce process design time by over 30% by using the Overview page.
You can filter process elements in the Overview page for analysis. For example, you can choose to view only Tasks or Adapters.

Both the diagram and tabular views provide different views of the same process. The following are the important common features:

- Any changes made in either of the views are reflected in the other view, when activated.
- All the process template elements in the Diagram view (except for Notes, Swim lanes, and Phases) are also available in the Overview page.
- The same Properties view for the process and for each workstep is available in both views.
- As in Diagram view, you can group tasks in the Overview page and then convert it to an inline subprocess.

Reviewing the Overview page

You can design a process template from scratch in the **Overview** page of the Business Process Modeler interface.

For a blank process template, the **Overview** page does not contain any elements or tasks. For a process template that contains elements, the **Overview** page contains the corresponding elements or tasks.

The **Overview** page displays the following default information about each task in a tabular format:

**Table 20: Task information**

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Displays the task name, with the adjoining icon indicating the shape used. To change the task name, double-click the cell and enter the new task name. An inline subprocess workstep displays an expandable icon, which you can expand to view its worksteps.</td>
</tr>
<tr>
<td>Type</td>
<td>Indicates the type of task or workstep. To change the type, double-click the cell and then select one of the options available. The available options depend on the workstep and process type (as listed in Changing shapes on page 43).</td>
</tr>
<tr>
<td>Successors</td>
<td>Displays the successor tasks (in case of a single outgoing connector) or multiple tasks (in case of multiple outgoing connectors). To define the successor tasks, click in the cell and then click the <strong>ellipsis</strong> button. From the left pane of the <strong>Add/Modify Successors</strong> dialog box that appears, select the tasks to be added as successors and click <img src="ellipsis" alt="Image" /> to move them to the right pane. To remove tasks added as successors, select the tasks in the right pane and click <img src="delete" alt="Image" />. You can define successor for any task type, except End.</td>
</tr>
</tbody>
</table>
| Duration   | Displays the default duration (2 hours) of Activity, Adapter, and Embedded Sub-Process task types. To modify the duration, click in the cell and then click the **ellipsis** button. Select either of the following options:  
  - **Enter a duration**, to open the **Duration** dialog box, in which you can enter the number of days, hours, or minutes for the workstep duration.  
  - **Use a dataslot**, to open the **Select Dataslots** dialog box, which lists the INTEGER dataslots available in the process. Select a INTEGER dataslot to define a dynamic duration for this workstep. |
<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Priority</td>
<td>To change the workstep priority, click in the cell, then select any of the predefined options: Low, Medium, High, or Critical. Click the Use a dataslot option to choose a dynamic dataslot value at runtime.</td>
</tr>
<tr>
<td>Performer</td>
<td>Displays the default performer for Activity, Adapter, and Subprocess worksteps. Double-click the cell to modify the performer. For more information regarding performers, see Defining and assigning performers on page 95.</td>
</tr>
<tr>
<td>Milestone Alerts</td>
<td>Applicable only to Start, Activity, Adapter, and Subprocess type tasks. Displays the alerts (if any) associated with the completion of a task (or a milestone). To associate an alert, click in the cell and then click the ellipsis button. From the left pane of the Milestone Alerts dialog box that appears, select the alerts to be added and click to move them to the right pane. To remove any added alert, select the alert in the right pane and click . You can associate multiple milestone alerts with the same task. To associate all of the defined alerts with the task, click . To remove all of the associated alerts with the task, click . For information regarding alerts, see Using alerts on page 147.</td>
</tr>
<tr>
<td>Phase</td>
<td>Indicates the phase (if any) to which the task belongs. For information regarding phases, see Managing phases on page 62.</td>
</tr>
</tbody>
</table>

You can sort the Overview page content by clicking on the column header. You can also search the task list based on a keyword, by entering the keyword in the Search box ( ).

You can also filter the listed tasks by selecting the appropriate filtering criteria. You can apply filtering on basis of the type of tasks (for example, Adapter) and on basis of advanced properties (for example, "Worksteps with skip condition" and "Worksteps that have overdue actions").

**To filter the tasks:**

1. Click the Click to filter ( ) icon.
   
   The Filter dialog box appears.

2. To enable filtering, select the Enable filtering check box.
   
   To filter the list of tasks on basis of the workstep type, select one (or more) check boxes in the Type list. To filter the list of tasks on basis of advanced workstep properties, select one (or more) check boxes in the Advanced list.

3. Click OK to apply the selected filtering to the list of tasks in the Overview page.

---

**Managing tasks**

You can create and edit an entire process template in the Overview tab. You can also set the properties of individual tasks (or worksteps) in the Properties view, as described in Setting workstep properties on page 109. You can use the toolbar in the Overview tab to add and manage the tasks of the process template.
Adding a task

To add a task (or a workstep):

1. Click the **Click to add** icon (➕), inserting a default Activity task. To add a task after an existing task, select the existing task and then click the **Click to add** icon.

2. Type the task name in the **Name** column. Task names can only include alphanumeric characters and underscores (_).

3. In the **Type** column, click in the cell and then select from the available workstep options, as required.
   
   **Table 21: Workstep Type** on page 68 lists the available options.

<table>
<thead>
<tr>
<th>Option</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>AND Gateway</td>
<td>To add an AND gateway. This gateway is not available for Web applications.</td>
</tr>
<tr>
<td>Activity</td>
<td>(default) To add an Activity workstep.</td>
</tr>
<tr>
<td>Adapter</td>
<td>To add an adapter workstep. Displays the Adapter dialog box, in which you can define (or select) any adapter.</td>
</tr>
<tr>
<td>Decision</td>
<td>To add a decision gateway.</td>
</tr>
<tr>
<td>Embedded Sub-Process</td>
<td>To add an inline subprocess. This option is not available for Web applications.</td>
</tr>
<tr>
<td>End</td>
<td>To add an End workstep. This type is only available when there is no successor task specified under the <strong>Successors</strong> column.</td>
</tr>
<tr>
<td>External Activity</td>
<td>To add a monitoring Activity workstep.</td>
</tr>
<tr>
<td>External Sub-Process</td>
<td>To add an external subprocess.</td>
</tr>
<tr>
<td>External Adapter</td>
<td>To add a monitoring Adapter workstep.</td>
</tr>
<tr>
<td>Managed</td>
<td>To add a managed adapter workstep.</td>
</tr>
<tr>
<td>Message</td>
<td>To add a Message workstep. This workstep type is not available for Web applications.</td>
</tr>
<tr>
<td>OR Join</td>
<td>To add an Or-Join gateway.</td>
</tr>
<tr>
<td>Option</td>
<td>Purpose</td>
</tr>
<tr>
<td>-------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Start</td>
<td>To add a Start workstep. This option is available only for the first added task, and not for subsequent added tasks.</td>
</tr>
<tr>
<td>XOR Join</td>
<td>To add an Exclusive Or-Join gateway. This gateway is not available for Web applications.</td>
</tr>
</tbody>
</table>

4. To add more tasks, click the **Click to add** icon.

The **Successor** column for the previous task now displays the default task name (“Activity 2”) of the added task.

**Performing other operations**

After adding tasks, you can perform any of the following operations using the toolbar in the **Overview** tab.

- You can expand (and collapse) the entire task list in order to view (or hide) all elements. To expand the list, click the **Click to expand all nodes** icon. To collapse the list, click the **Click to collapse all nodes** icon.

- To remove a task, select the task and click the **Click to remove** icon.

- To group tasks into an inline subprocess, select the tasks and click the **Group tasks** icon. This inserts a subprocess task of type, “Embedded subprocess” and contains the grouped tasks between a Start and End workstep. To ungroup the tasks, select the subprocess task and click the **Ungroup Tasks** icon.

  **Note:** You cannot add nor delete group tasks for sorted and filtered (by workstep type and by advanced properties) data.

- To change the position of a selected task, click the **Move up** icon or the **Move down** icon. Changing the position of a task does not alter the task’s predecessor and successor.

- To view any task in the Diagram view, select the task and then switch to the Diagram view.

- You may need to restore the added tasks to its original order. To do so, click the **Restore Default Order of Tasks** icon.

  **Note:** You can design an entire process template in the **Overview** tab, without switching to the **Diagram** tab. To ensure that all changes in the Overview page are integrated seamlessly in the Diagram view of the process, see that the Auto Layout functionality is enabled in **Preferences** dialog box (see Setting Business Process Modeler preferences on page 76).
Introducing Path Analysis

This chapter describes how you can perform process path analysis using the Path Analysis view.

For details, see the following topics:

• Using the Path Analysis view
• Exploring the Path Analysis view

Using the Path Analysis view

Business Process Modeler provides the Path Analysis functionality in the Path Analysis view, which enables you to analyze the timing of process execution.

Path Analysis provides the following functionalities:

• Ability to drill down through a specific path and estimate the time required for the process execution to reach a particular point in the process.

• Displays workstep attributes including duration, priority, and performer.

• Provides process timeline information with:
  • Graphical display of workstep duration.
  • Grid and markers for duration units including days, weeks, and months.
  • Alternate coloring between weeks, to identify week boundaries.

• Displays all process paths from Start to End workstep using nested paths.
• Displays the estimated start time for each workstep, which is calculated by adding the sum of duration of all previous worksteps in that path.

**Figure 4: A Sample Approval Process Template** on page 72 shows a sample approval process that requires the reviewer to decide if the request meets specific critical criteria. If the performer of the Review Request workstep decides it is non-critical, then it is sent by e-mail to a group at a remote location for submission.

**Figure 4: A Sample Approval Process Template**

The **Review Request** workstep assigned to any member from "MgrGroup" has an assigned work time of two hours. The **Submit Request** workstep assigned to any member from the "ebmsgroup" has a work time of 50 minutes.

If any member from the "MgrGroup" decides the request is critical, then it is sent to the **Exec Approve** workstep (with assigned work time of 50 minutes): a senior executive (performer, "exec") then approves or rejects it. The approved requests are sent to the **Submit Request2** workstep (work time of 50 minutes). Any member of the "MgrGroup" can view the request status in the **Request Status** workstep (with default duration of 2 hours). Each of the Adapter worksteps has an estimated duration of 10 minutes. The entire process has an estimated duration of 6 hours.

**Exploring the Path Analysis view**

To open the Path Analysis view for any process template (for instance, the process shown in **Figure 4: A Sample Approval Process Template** on page 72), open the process template and then click the **Path Analysis** content pane tab.

**Figure 5: Path Analysis view**

The Path Analysis view displays the name of each task and the following default columns.
### Table 22: Column Information In Path Browser

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Displays the task name, with the adjoining icon indicating the shape used.</td>
</tr>
<tr>
<td>Est. Start</td>
<td>Indicates the time interval in which the task is estimated to start. If there is no time interval, this column displays &quot;(none)&quot; (for instance, in the case of the Start workstep). This value is derived by adding the duration for previous tasks. For instance, the estimated start of 4 hours for the Notify Reject task is a sum of the duration for Review Request and Exec Approve tasks. An asterisk beside an estimate (in this case, for “Request Status” and “End1” tasks), indicates that the estimate may not be accurate because there are parallel paths to reach that point.</td>
</tr>
<tr>
<td>Duration</td>
<td>Displays the time required to complete the task. The colors representing the duration are indicated as follows and are relative to the duration of the other tasks.</td>
</tr>
<tr>
<td></td>
<td>• Red for the tasks with the maximum duration (in this case, Review Request and Exec Approve).</td>
</tr>
<tr>
<td></td>
<td>• Green for the tasks with the minimum duration (in this case, Notify Reject and Notify Submit).</td>
</tr>
<tr>
<td></td>
<td>• Yellow for the tasks with the average duration (that is, an average of maximum and minimum duration values). For some processes, if all the tasks have the same duration, their duration is also represented in yellow.</td>
</tr>
<tr>
<td></td>
<td>• All durations that measure between the average and maximum values are represented in gradient colors from yellow to red.</td>
</tr>
<tr>
<td></td>
<td>• All durations that measure between the minimum and average values are represented in gradient colors from green to yellow.</td>
</tr>
<tr>
<td>Priority</td>
<td>Displays the workstep priority. Supported values are: Low, Medium, High, Critical, or dataslot name.</td>
</tr>
<tr>
<td>Performer</td>
<td>Displays the performer for Activity, Adapter, and Subprocess worksteps.</td>
</tr>
<tr>
<td>Timeline</td>
<td>Provides a visual representation of the Estimated Start and Duration data for each task, without displaying the actual numbers. Each timeline starts from the Estimated Start value and continues for the specified Duration. The timeline is tabulated based on the total process time (in this case, 6 hours) with each task timeline representing the work breakdown structure. Timelines also depict the dependencies between tasks (that is, a particular task cannot start before another task is completed). If the timeline for a particular task is displayed in orange (in this case, the Request Status task), it indicates that the estimated start time may not be accurate because there are parallel paths to reach that point.</td>
</tr>
</tbody>
</table>

**Note:** You can expand (and collapse) the process path in order to view (or hide) all elements. To expand the list, click the **Click to expand all nodes** (확장) icon. To collapse the list, click the **Click to collapse all nodes** (감소) icon.

The Path Analysis view displays all the possible paths that a process execution can take. When you search a particular workstep type (or name) by entering the keyword in the **Search** box (검색), the Path Analysis view displays only those paths that contain the keyword you have searched.
You can also filter the paths by selecting the appropriate filtering criteria. You can apply filtering on basis of the type of tasks (for example, Adapter) and on basis of advanced properties (for example, "Worksteps that have loop" and "Worksteps that can be skipped").

**To apply filtering:**

1. Click the **Click to filter** icon.
   
   The **Filter** dialog box appears.

2. To enable filtering, select the **Enable filtering** check box.
   
   To filter the paths on basis of the workstep type, select one (or more) check boxes in the **Type** list. To filter the list of tasks on basis of advanced workstep properties, select one (or more) check boxes in the **Advanced** list.

3. Click **OK** to apply the selected filtering to the paths in the **Path Analysis** view.
Defining process properties

This chapter describes how you can define process properties of process models or Web applications. You can define process properties for the first time or modify some of the properties that you have defined when creating the application.

For details, see the following topics:

• Setting process properties
• Setting Business Process Modeler preferences

Setting process properties

Business Process Modeler provides the Properties view where you can set (and modify) properties of the process and process template elements (as described in Setting workstep properties on page 109).

Note: To display the Properties view in Business Process Modeler perspective, click View > Properties.

The procedures for defining the properties of a process are similar for Process Models and Web applications.

1. Open the Process Model (SPT) or Web application (SWT) file, whose properties you want to define.
2. Click a blank area of the Diagram tab to view the process properties in the Properties view. By default, the General tab appears.
3. Click the Description tab and enter a description of the application (optional) in the text area.

4. Click the History tab to review past actions in the process. This read-only tab provides information on when the process was created or checked into the process repository.

5. Click the Attributes tab to review existing attributes and modify their values. You can create attributes only in the Administration module of Business Process Portal.

To review and modify attributes and their values:

a) From the Attributes tab, you can view process attributes and values. If many attributes listed are listed, then you can enter a string of letters in the Search box and an attribute name containing that string is displayed in the table provided.

b) By default, the Attributes tab lists the ProcessType attribute with value, BusinessProcess or SystemProcess. To add attributes, click More to open the Attributes dialog box, which lists the default attributes—Executable, Goal, Influencers, Objective, Organizational Unit, Process Type, Risks, Rewards—as well as any attributes that have already been defined in BPM Portal.

c) If you can access Business Process Portal, then click the Add ( ) icon to go to Business Process Portal, in which you can add more attributes, if required.

Click the Refresh ( ) icon to refresh the view of the listed attributes.

d) Select one or more attributes (except Process Type) listed in the Attributes dialog box and click OK to add it to the Attributes tab.

e) To modify the value of an attribute, select the attribute and click Modify. You can only modify an attribute if it has been defined as editable in Business Process Portal.

f) Click Clear to clear the value of a selected attribute. To remove an attribute, click More to open the Attributes dialog box, and clear the checkbox of the attribute that you want to remove from the process.

6. Use the Monitoring tab (available only for process models with a monitoring workstep) to define the configurations for a monitoring process. For more information, see Introducing Monitoring process on page 131.

Setting Business Process Modeler preferences

Business Process Modeler provides the Preferences dialog box, a Configuration interface that enables you to easily modify the more commonly used configuration parameters. Once you have defined these configuration parameters in the Preferences dialog box, they are automatically set for each new project.

To set your preferences in Business Process Modeler:

1. From Tools menu, click Preferences, to open the Preferences dialog box.

2. Expand OpenEdge > Business Process Modeler in the left pane: the following options are displayed:

   • Activity: to set the default properties of an Activity workstep. For more information, see Using the Activity page on page 77.

   • Application: to set the default properties and attributes for a process. For more information, see Using the Application page on page 77.
• **Diagram**: to set the default size of the Diagram view, appearance, and other settings. For more information, see Using the Diagram page on page 77.

• **Export**: to set the width and height (in pixels) of the process template diagram, when exported in JPG format. For more information, see Using the Export page on page 78.

• **Simulation**: to set the default simulation-related properties in Simulation perspective. For more information, see Using the Simulation page on page 78.

3. After defining the above preferences, click **OK** to close the Preferences dialog box.

**Note**: To apply the changes made in each page, click **Apply**. Click **Restore Defaults** if you want to restore the values of all options in the page to the default values.

### Using the Activity page

You can use the Activity page to configure the default properties of an Activity workstep.

1. From the Presentation drop-down list, select the default presentation format (Auto-generated) for Activity workstep.

2. Select the default priority (Low, Medium, High, or Critical) for the Activity workstep in the Priority drop-down list.

3. Use the Duration boxes to change the default duration (2 hours) of the Activity workstep.

### Using the Application page

You can use the Application page to configure the default properties of a process, the default attributes, and database settings.

1. From the Default Properties section, set the default properties for a process including the default manager, group, duration, category, subcategory, and author.

2. From the Default Attributes section, view (or modify) the default server location from where you can import attributes.

3. From the Database section, view (or modify) the database system to be used for dataslots in the process.

### Using the Diagram page

You can use the Diagram page to configure the following default properties of the Diagram tab in the Business Process Modeler interface.

#### Table 23: Diagram Page Settings

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default Size</td>
<td>To set the configuration parameters for width and height of the diagram page. Values range from 1 to 10.</td>
</tr>
<tr>
<td>Show pages</td>
<td>Select to display the page boundary, as it appears on your default printer. Use this feature to create appropriate page breaks in a lengthy process template diagram.</td>
</tr>
</tbody>
</table>
Select this to view the process template diagram with a grid. The Business Process Modeler grid is always active, whether visible or not. In the Grid size box, set the space between grid points. Although grid size ranges from 1 - 50, use values that are multiples of 4. By default, grid size is set to 12.

Note: Due to Java limitations, a process template diagram may not display correctly if you select a grid size of 10 or less.

Select this to view a solid fill for diagram components. Clear this option to view transparent components. You can also view a gradient fill for diagram components by selecting the Gradient fill option.

Select this to align each new workstep with the center of neighboring components. If you want to move a shape when the Snap to shapes feature is activated, then select the workstep and use the arrow keys to move the workstep.

Select the quality of the auto layout functionality in the Overview page (as described in Working with the Overview page on page 65). Options are low (fast), normal, and high (slow). Clear the Run auto layout after using Tabular View checkbox to disable the auto layout functionality.

Allows you to enable or disable the Gestures functionality (see Using mouse gestures on page 49). You can view and modify the default location of the Gestures file.

Using the Export page

You can use the Export page to enter the width and height (in pixels) of the process template diagram when exported in JPG format. For information on exporting, see Exporting the process template on page 59.

Using the Simulation page

You can use the Simulation page to configure the simulation settings for the simulation project. For details regarding simulation, see Configuring and running simulation on page 151.

To configure the simulation settings for the simulation project:

1. Use the Start Simulation and Stop Simulation sections to set the default configurations (for the default scenario) for the Simulation Start and Stop settings. For details regarding each of these parameters, see Modifying simulation settings for a scenario on page 154. Use the Currency section to set your default currency symbol.
2. From the Performer page, set the default settings for the performer types—Group, Individual, and System. For details regarding each of these settings, see Managing performers on page 161.
3. From the Process page, you can set the default simulation settings for added processes in the default scenario. For detailed information regarding each of these parameters, see Configuring simulation parameters for a process on page 156.
4. From the **Workstep** page, you can set the default worktime distribution method and other settings for supported workstep types in the default scenario. For details regarding each of these parameters, see For worksteps on page 157.

5. From the **Resource** page, you can set the default cost and count for consumable and non-consumable resources. For more information, see Managing resources on page 162.

6. From the **UI** page, you can set (or modify) your preferred settings for switching between simulation-related perspectives in Business Process Modeler. The perspective switches are listed as follows:

   - **Open Progress OpenEdge BPM Simulation perspective on launching editor**, when creating or opening a simulation project.
   - **Open OpenEdge BPM Run Simulation perspective on simulation run**, when running a process simulation.
   - **Open Progress OpenEdge BPM Simulation perspective on simulation run exit**, when exiting the OpenEdge BPM Run Simulation perspective after running a process simulation.

   The available options for each of the above switches are **Always** (to launch the respective perspective without any user prompt), **Never** (to always perform the requested operation in the current perspective without switching the perspective), or **Prompt** (the default option, which prompts you to switch to the respective perspective).

   You can also choose the color settings for status bars and progress bars used in the Simulation perspective. To choose another color, click the bar and then the adjoining color button to open the **Color** dialog box, where you can select another color. The available bars are listed in Table 24: Appearance Settings on page 79.

### Table 24: Appearance Settings

<table>
<thead>
<tr>
<th>Bar</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>For <strong>Status</strong> Bar</td>
<td></td>
</tr>
<tr>
<td>Inactive</td>
<td>Indicates the Simulation and Process Status bars before the simulation run.</td>
</tr>
<tr>
<td>Required</td>
<td>Indicates the total count of required process instances in the Processes Runtime View during the simulation run. It also indicates the time limit for the simulation project in the Simulation Status section of the Simulation Control Editor, during the simulation run.</td>
</tr>
<tr>
<td>Created</td>
<td>Indicates the progress status of created process instances in the Processes Runtime View during the simulation run.</td>
</tr>
<tr>
<td>Completed</td>
<td>Indicates the progress status of completed process instances in the Processes Runtime View during the simulation run. Indicates the progress status of simulation project in the Simulation Status section of the Simulation Control Editor, during the simulation run.</td>
</tr>
<tr>
<td>For <strong>Probability</strong> Bar (For details of the <strong>Probability</strong> bar used in the Probability tab of the Properties view in Simulation Perspective; for details, see Setting the probabilities on page 160)</td>
<td></td>
</tr>
<tr>
<td>Bar Fill Color</td>
<td>Indicates the graded colors (smooth shading of one color to another color) used for the filled portion of the probability bar.</td>
</tr>
<tr>
<td>FG/BG</td>
<td></td>
</tr>
<tr>
<td>Bar Empty Color</td>
<td>Indicates the graded colors (smooth shading of one color to another color) used for the empty portion of the probability bar.</td>
</tr>
<tr>
<td>FG/BG</td>
<td></td>
</tr>
</tbody>
</table>
### Chapter 9: Defining process properties

<table>
<thead>
<tr>
<th>Bar</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text</td>
<td>Indicates the color of the text displayed on the probability bar.</td>
</tr>
<tr>
<td>Shadow</td>
<td>Indicates the color of shadow bar accompanying the probability bar.</td>
</tr>
<tr>
<td>Color when selected</td>
<td>Indicates the color of the probability bar, when selected.</td>
</tr>
<tr>
<td>Border</td>
<td>Indicates the border color of the probability bar.</td>
</tr>
</tbody>
</table>
Using dataslots

You can use dataslots to manage information flow in a business process. Dataslots are global variables in business processes that enable the process to support exchange of data across worksteps. Typically, a dataslot is defined as the output of one workstep and the input of the successor workstep. Information—in this case, the value of the dataslot—is therefore passed from one workstep to the next workstep.

This chapter describes how to use dataslots in Business Process Modeler, and covers the following features:

• Business Process Modeler provides a set of predefined system dataslots for Process Model projects.

• Business Process Modeler supports a wide range of dataslot types.

• Business Process Modeler enables you to define customized dataslots that are specific to your requirements and can be used in process templates.

• Business Process Modeler supports importing and exporting dataslots singly or in bulk.

**Note:** You can assign dataslots to individual worksteps in the process, using the **Fields** tab in the workstep's **Properties** view. For more information, see **Setting workstep properties** on page 109.

For details, see the following topics:

• **Reviewing the Datasets tab**

• **Supported dataslot types**

• **Using system dataslots**

• **Creating user-defined dataslots**

• **Exporting and importing dataslots**
### Reviewing the Dataslots tab

You can review existing dataslots in a process and define new dataslots in the **Dataslots** tab of the Business Process Modeler interface. If you are adding a new process template for a process model, then only predefined system dataslots are listed.

If you are modifying an existing process template, then predefined dataslots as well as dataslots that you have created for this process template are listed.

**Note:** Web applications do not include any predefined system dataslots.

Click the **Dataslots** tab for a new BPM process, to view the **All Dataslots** section, which contains all the dataslots available to the process template.

You can perform the following operations in the **Dataslots** tab:

**Table 25: Dataslots tab operations**

<table>
<thead>
<tr>
<th>Operation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create a user-defined dataslot</td>
<td>See <a href="#">Creating user-defined dataslots on page 85</a></td>
</tr>
<tr>
<td>Remove a dataslot</td>
<td>Select the dataslot to be removed, then click <strong>Remove</strong>. You cannot remove any of the system dataslots. You cannot remove any user-defined dataslot assigned to a workstep.</td>
</tr>
<tr>
<td>Modify existing dataslots</td>
<td>Select the dataslot to be modified, then modify its properties in the respective sections of the <strong>Dataslots</strong> tab. You cannot modify the properties of any system dataslot.</td>
</tr>
<tr>
<td>Import or export dataslots</td>
<td>See <a href="#">Exporting and importing dataslots on page 92</a></td>
</tr>
<tr>
<td>Filter the dataslot list</td>
<td>Enter text in the <strong>type filter text</strong> box to filter the dataslot list and display all dataslots whose names contain the matching letters.</td>
</tr>
<tr>
<td>Group the dataslot list by type (or by tag)</td>
<td>By default, all dataslots are grouped under dataslot type category, as discussed in <a href="#">Supported dataslot types on page 83</a>. To group the dataslot list by tag namely, <strong>System</strong> (for system dataslots) or <strong>User</strong> (for user-defined dataslots), click the <strong>Group by Tags</strong> () icon in the <strong>All Dataslots</strong> section. To group the dataslot list by type, click the <strong>Group by Type</strong> () icon in the <strong>All Dataslots</strong> section.</td>
</tr>
<tr>
<td>Collapse the dataslot list</td>
<td>Click the <strong>Collapse All</strong> () icon.</td>
</tr>
</tbody>
</table>
## Supported dataslot types

Table 26: ABL Dataslot Types Supported by Business Process Modeler on page 83 lists the supported ABL dataslot types for both Process Model projects and Web applications.

For more information on ABL datatypes and their default values, see the OpenEdge Development: ABL Reference guide.

### Table 26: ABL Dataslot Types Supported by Business Process Modeler

<table>
<thead>
<tr>
<th>Dataslot Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CHARACTER</td>
<td>A dataslot containing a text string. CHARACTER is the most common type of dataslot, and is selected by default. CHARACTER dataslot supports three display formats, namely Text field (default), Text area, and Combo box.</td>
</tr>
<tr>
<td>INTEGER</td>
<td>A dataslot containing 32-bit data (whole numbers).</td>
</tr>
<tr>
<td>INT64</td>
<td>A dataslot containing 64-bit data (whole numbers).</td>
</tr>
<tr>
<td>LOGICAL</td>
<td>A dataslot containing logical data that is evaluated as TRUE or FALSE.</td>
</tr>
<tr>
<td>DECIMAL</td>
<td>A dataslot containing decimal numbers up to 50 digits in length, including up to 10 digits to the right of the decimal point.</td>
</tr>
</tbody>
</table>
| DATETIMETZ    | A dataslot containing dates. DATETIMETZ datatype has three parts: date, time, and an integer representing the time zone offset from Coordinated Universal Time (UTC). The unit of time is milliseconds from midnight. The unit of time zone offset is minutes. Supports the following DATETIME-TZ formats in OpenEdge:  
  - yyyy-MM-dd'T'HH:mm:ss.SSS(+-)zz:zz or yyyy-MM-dd  
  - yyyy-MM-dd'T'HH:mm:ss.SSS or yyyy-MM-dd  
  - yyyy-MM-dd'T'HH:mm:ss or yyyy-MM-dd  
  - yyyy-MM-dd  
  For example, 1995-01-17T12:12:12.234+05:30 or 1995-01-17 12:12:12.234+05:30. |
<p>| Handle        | A dataslot containing a handle which is a pointer to an ABL handle-based object. This can be a static object defined during compilation or a dynamic object defined at runtime. |
| Rowid         | A dataslot containing a unique internal identifier for a row within a single database storage area. |
| Memptr        | A dataslot containing a sequence of bytes in memory. You can use this dataslot type to manipulate the contents of a BLOB database or temp-table field in ABL language. |
| Raw           | A dataslot containing any data, including data from databases other than OpenEdge. |</p>
<table>
<thead>
<tr>
<th>Dataslot Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dataset</td>
<td>A dataslot containing the values of ABL ProDataset. This dataslot can be mapped to a DataSet or DataSet-Handle in ABL.</td>
</tr>
<tr>
<td>Table</td>
<td>A dataslot containing the values of ABL temp-table. This dataslot can be mapped to a Table or Table-Handle in ABL.</td>
</tr>
<tr>
<td>List</td>
<td>Treats a collection of related data items as a single entity. For example, a List dataslot can be used to hold choices for CHARACTER dataslots where the choices are dynamically determined by querying a database.</td>
</tr>
<tr>
<td>Map</td>
<td>A dataslot which enables you to select from a list of choices that can change dynamically. It also stores the choices that are made and these choices can be viewed and used in other worksteps.</td>
</tr>
<tr>
<td>Number</td>
<td>A dataslot containing a numeric value. The Number dataslot contains Double as a subtype. The numeric value is displayed as a decimal; for example, 2.2.</td>
</tr>
<tr>
<td>Object</td>
<td>A dataslot containing a serializable Java object. Typical Object dataslot types include Vector and Array which are passed as input or output dataslots to Adapters.</td>
</tr>
<tr>
<td>Business Object</td>
<td>A dataslot which encapsulates all the data and behavior associated with an entity of a business process. This dataslot type can retrieve data from internal and external database sources.</td>
</tr>
</tbody>
</table>

For more information on ABL datatypes, see the *Openedge Development: ABL Reference* guide.

**Using system dataslots**

Business Process Modeler provides predefined system dataslots for a Process Model project, which are displayed by default in the Dataslots tab in the System category and are designed to extend the functionality of user-defined dataslots. Predefined system dataslots are read-only and their values are assigned at runtime.

**Note:** You cannot modify, remove, or export a System dataslot.

The following table summarizes the predefined system dataslots.

**Table 27: Predefined System Dataslots**

<table>
<thead>
<tr>
<th>Dataslot Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AllDataslots</td>
<td>Contains (at runtime) all the user-defined dataslots and the associated values for the user-defined dataslots in a Hashtable. The Hashtable key is the dataslot name.</td>
</tr>
<tr>
<td>Creator</td>
<td>Contains the creator (at runtime) of the process instance. The value of this box can be the login name of a Business Process Portal user.</td>
</tr>
<tr>
<td>Priority</td>
<td>Contains the priority (at runtime) of the process (not the workstep priority). This box appears in all automatically generated HTML forms. Restrict priority values to Low</td>
</tr>
</tbody>
</table>
Creating user-defined dataslots

You can create dataslots, which are specific to a process. You can create a dataslot from any of the supported dataslot types (see Supported dataslot types on page 83) as described in the following procedures.

To define dataslots:

1. From the Dataslots tab, click Add.
   
   The first page of the New Dataslot wizard appears.

2. Enter a unique name for the dataslot in the Enter a unique ID box. Valid dataslot names must start with a letter and can contain only include alphanumeric characters and the underscore (_). The maximum length of a dataslot is 28 characters.

   The following restrictions apply to dataslot names:

   • Although Business Process Modeler accepts reserved Java words (or Java identifiers) as dataslot names, do not use them as dataslot names or the application fails to publish. For example, do not use “LOGICAL” or “object” as a dataslot name, however, you can use “myboolean” or “myobject”.

3. Select the dataslot type from the Select a type list. The options are: CHARCATER, INTEGER, INT64, LOGICAL, DATETIMETZ, Number, List, Map, Object, and Business Object. For more information, see Table 26: ABL Dataslot Types Supported by Business Process Modeler on page 83.

4. Specify the dataslot tags in the Enter tags... box. Process Modeler provides a default tag named “User” for all user-defined dataslots. You can either retain this default tag or type your own tag in the Enter tags... box. You can then assign these tags to new and existing dataslots.

5. Click Next. You can use the Value page to set the initial value of the dataslot. The appearance of the Value page depends on the type of dataslot that you have selected. For detailed information about setting the initial value, see the respective sub-section for the dataslot type in Dataslot properties on page 86.

6. Click Next. In the Description page, enter a brief description of the dataslot.

7. Click Finish to create the new dataslot, and add the defined dataslot to the Dataslots tab.

### Creating user-defined dataslots

<table>
<thead>
<tr>
<th>Dataslot Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ProcessInstanceId</td>
<td>Contains the instance ID of the running process at runtime. This value is a unique identifier of each instance of this process.</td>
</tr>
<tr>
<td>ProcessName</td>
<td>Contains the process name (at runtime). The process name is a string formed by concatenating the process template name with a unique number.</td>
</tr>
<tr>
<td>ProcessTemplateName</td>
<td>Contains the process template name (SPT).</td>
</tr>
<tr>
<td>StartTime</td>
<td>Contains the date (at runtime) when the process instance was started.</td>
</tr>
<tr>
<td>WorkstepName</td>
<td>Contains the name (at runtime) of the workstep the process is currently executing.</td>
</tr>
</tbody>
</table>

**Note:** Business Process Modeler processes can only read the values of predefined system dataslots. The system dataslots are only available as input dataslots to the process.
Dataslot properties

After defining a dataslot, you can configure the dataslot properties in the respective sections of the **Dataslots** tab. The variations in the dataslot properties are described in the following sub-sections.

For a CHARACTER dataslot

You can configure the properties of a CHARACTER dataslot in the following sections of the **Dataslots** tab:

**Table 28: CHARACTER dataslot properties**

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dataslot</td>
<td>To modify the ID, type, and tags of the dataslot (defined in <em>Creating user-defined dataslots</em> on page 85). You cannot modify the dataslot ID if the dataslot is assigned to any workstep in the process.</td>
</tr>
<tr>
<td>Description</td>
<td>To specify the dataslot description, as discussed in <em>Defining the dataslot description</em> on page 89.</td>
</tr>
<tr>
<td>Initial Value</td>
<td>To specify the initial value of the dataslot. Enter text in the text area provided to create a static value; that is, a value that is displayed for each instance of the process. For example, entering “Carl” as the value for a dataslot, “Assignee”, it results in Carl being the Assignee for each process instance. Alternatively, to create a dynamic value, enter a dataslot name, preceded by the @ symbol, that displays the value of the designated dataslot at runtime. In this case, entering “@Creator” as the value for the Assignee dataslot means that the person who created the instance is the assignee. This value can change from instance to instance and can reflect changes made at runtime. <strong>Note:</strong> When you select Combo as the format type for a CHARACTER dataslot from the <em>Default Format</em> section and then define a choice list, you must assign the CHARACTER dataslot's initial value from the defined list. Otherwise, the process fails to publish. The CHARACTER dataslot’s initial value should not contain the bar (“</td>
</tr>
<tr>
<td>Default Format</td>
<td>To configure dataslot properties including the presentation format, label, and validations. For more information, see <em>Defining the dataslot format</em> on page 89.</td>
</tr>
<tr>
<td>Usage</td>
<td>If you have assigned the dataslot to a workstep, this section specifies how the dataslot is used in the process. For example, &quot;Input for Activity 1&quot; indicates that this dataslot is an input (or non-editable) dataslot for this workstep. For information on how to assign dataslots to individual worksteps in a process, see <em>Setting workstep properties</em> on page 109.</td>
</tr>
</tbody>
</table>

For a INTEGER and INT64 dataslot

You can configure the properties of a INTEGER and INT64 dataslot in the respective sections (same sections as that for CHARACTER dataslot) of the **Dataslots** tab. For information on CHARACTER dataslot properties, see *For a CHARACTER dataslot* on page 86. The only difference is in the **Initial Value** section, which is described below.

You can use the **Enter an initial value** box to specify the initial value of the dataslot.
For a LOGICAL dataslot

You can configure the properties of a LOGICAL dataslot in the respective sections (same sections as that for CHARACTER dataslot) of the Dataslots tab. For information on CHARACTER dataslot properties, see For a CHARACTER dataslot on page 86. The only difference is in the Initial Value section, where you can select true or false (default) option as the initial value of the dataslot.

For a DATETIMETZ dataslot

You can configure the properties of a DATETIMETZ dataslot in the respective sections (same sections as that for CHARACTER dataslot) of the Dataslots tab. For information on CHARCATER dataslot properties, see For a CHARACTER dataslot on page 86. The only difference is in the Initial Value section, which is described below.

You can use the Initial Value section to specify the initial value of the dataslot.

Select the Date option to use the calendar to set the date. You can modify the default date by clicking the icon. You can also enter the specific time in hour, minute, and second, which you want to use for the dataslot. This dataslot converts string to date-time formats and vice versa.

Alternatively, select the Start Time option to use the “@STARTTIME” dataslot value as the starting time for the DATETIMETZ dataslot.

For an List dataslot

You can configure the properties of an List dataslot in the respective sections (same sections as that for CHARACTER dataslot) of the Dataslots tab. For information on CHARCATER dataslot properties, see For a CHARACTER dataslot on page 86. The only difference is in the Initial Value section, which is described below.

You can use the Initial Value section to specify the initial value of the dataslot.

• Click Add to add a list element to the Value table.

To remove a value from the dataslot, select the value in the Value table and click Remove.

To change the order of the values, select the value in the panel and click Move Up or Move Down to move it up or down a row.

Values in a List dataslot are now read from a <Values> tag. The <Value> tag is compatible with the the <DataValue> tag used in earlier releases is also read.

Note: For more information, see About List Dataslots in the Application Developer’s Guide.

For a Map dataslot

You can configure the properties of a Map dataslot in the respective sections (same sections as that for CHARACTER dataslot) of the Dataslots tab. For information on CHARACTER dataslot properties, see For a CHARACTER dataslot on page 86. The only difference is in the Initial Value section, which is described below.

You can use the Initial Value section to specify the initial value of the dataslot.

To add a name/value pair to the table:
1. To add name/value pairs as choices in a multi-select list, click Add to open the Add dialog box, in which you can define your name/value pair.

   The Name of the option you enter will be displayed as its label. The Value you enter can be “true” or “false”. If “true”, it is selected by default when displayed; if “false”, it is not selected.

2. Click OK to add the defined name/value pair to the Initial Value table.

   You can also change the options displayed for a Map dataslot or provide localized values for the options.

For a Number dataslot

You can configure the properties of a Number dataslot in the respective sections (same sections as that for CHARACTER dataslot) of the Dataslots tab. For information on CHARACTER dataslot properties, see For a CHARACTER dataslot on page 86. The only difference is in the Initial Value section.

You can use the Enter an initial value box to specify the initial value of the dataslot.

For an Object dataslot

An object dataslot contains a serializable Java object of a class available on the BP Server server. You can use a project-specific class file (JAR) or common JAR files which are available on publishing a Common Resource project. The class object is instantiated when a BP Server application instance is created or when a Web application is accessed.

You can configure the properties of an Object dataslot in the respective sections (same sections as that for CHARACTER dataslot) of the Dataslots tab. For information on CHARACTER dataslot properties, see For a CHARACTER dataslot on page 86. The only difference is in the Initial Value section, which is described below.

You can use the Initial Value section to specify the initial value of the dataslot.

1. In the Java Class Name box, enter a unique name for the serializable Java object. Specify the Class Name (including the package name).
   • Classes, which are project-specific, are stored in <project_name>\lib folder (for BPM processes) or in <project_name>\WEB_INF\lib folder (for Web applications).
   • Classes, which are available on the BP Server server after you publish a Common Resource project, are stored in OEBPS_Home\ebmsapps\common\classes folder (for a BPM process) or in WebApp_Home\WEB-INF\classes folder (for Web application) wherein the WebApp_Home is application-server-specific and is the value of the oebs.webappdir property in OEBPS_Home\conf\oebps.conf file.

2. Use the Constructor Parameters section to define the parameters of the class constructor, which is invoked when the process instance is created. The object variables are initialized by invoking the proper constructor with the appropriate parameter values.
   a) Define the parameters by clicking Add, to open the Add dialog box.
   b) Specify the Java class name in the Type box and enter the value of the parameter.

      You can use Progress Developer Studio for OpenEdge to specify the methods for this class object in the Before Activation and When Completed tabs of the Advanced tab in workstep properties. For more information regarding using these tabs, see Progress Developer Studio for OpenEdge User's Guide.

3. Click OK to add the constructor parameter in the Constructor Parameters section.
For a Business Object dataslot

You can configure the properties of a Business Object dataslot in the respective sections (same sections as that for CHARACTER dataslot) of the Dataslots tab. For information on CHARACTER dataslot properties, see For a CHARACTER dataslot on page 86. The only difference is in the Initial Value section, which is described below.

For a Business Object dataslot:

1. Click Browse to open the Business Object dialog box.

2. Select a java file and click OK, and a valid business object is displayed in the Initial Value box. These values are derived from business objects that were previously created. For more information, see Managing business objects on page 189.

Defining the dataslot description

You can add a description (optional) for a dataslot by selecting the dataslot and entering the description text in the Description section of the Dataslots tab. The Description text area can accept any character or symbol, and has no restrictions on the amount of characters you can enter.

Defining the dataslot format

You can use the Default Format section of the Dataslots tab to set properties such as the presentation format and the label of the dataslot in Business Process Portal, validation (if required). You can also specify whether the dataslot is editable and required.

Note: The Default Format tab is not available for the Business Object dataslot.

Table 29: Default Format for Dataslots on page 89 lists the format properties, their descriptions, and the dataslot types for which they are available.

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
<th>Supported Dataslot Types</th>
</tr>
</thead>
</table>
| Type    | Determines how the dataslot should be presented in the interface page. | • As a text box, text area, or combo box for a CHARACTER dataslot.  
|         |             | • Additionally, as a radio button, checkbox and label for CHARACTER dataslot in case of web applications.  
<p>|         |             | • “Date and Time” or “Date Only” for DATETIME-TZ dataslot. |
| Label   | Defines the label of the dataslot in the interface. | For all dataslots. |
| Editable| Specifies whether the dataslot is editable or read-only in the interface page. The Editable check box is selected, by default. | For all dataslots. |</p>
<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
<th>Supported Dataslot Types</th>
</tr>
</thead>
<tbody>
<tr>
<td>Required</td>
<td>Specifies whether the dataslot is mandatory or not.</td>
<td>Not available for LOGICAL dataslot.</td>
</tr>
<tr>
<td>Validation</td>
<td>Configures validation settings.</td>
<td>Available only for CHARACTER, INTEGER, INT64, and DATETIME-TZ dataslots. For more information, see <strong>Specifying validation at the dataslot level</strong> on page 90.</td>
</tr>
</tbody>
</table>

You can modify the format of a dataslot at the workstep level, allowing each workstep in a process to have a different format. For example, you can set the format of a dataslot as a combo box with the label “Please enter a choice” in one workstep; and as a text box with the label “You selected:” in the next workstep. To modify the format of a dataslot at the workstep level, see the Dataslot Properties section for the workstep type; for instance, for an Activity workstep, see **Defining properties of Activity worksteps** on page 113.

**Presentation formats for the CHARACTER dataslot**

Business Process Modeler enables you to display a CHARACTER dataslot as a text box (single line of text), a text area (multiple lines of text), or a Combo box. In the case of Web applications, the CHARACTER dataslot has three additional formats, namely Radio button, Check box, and Label (read-only text). Each of these formats are described in the following bulleted list.

- **Text Field** format: Select this format and then do the following:
  1. Enter data in the **Size** and **Length** box (only for Web applications) to define the dimensions of the dataslot as it appears in the interface.
  2. Select the **Password** checkbox to present text entered in this field as asterisks, same as the way passwords are commonly displayed.

- **Text Area** format: Select this format and enter the width and height of the text area in the respective fields.

- **Combo box** format: Select this format and then do the following:
  1. To add a new choice for the combo box, click **Add** to open the **Choice** dialog box.
  2. Enter a Value and a Label in the **Choice** dialog box. A choice can only include alphanumeric characters and underscores (_).
  3. Click **OK** to add the choice you created to the Choices table.

  To modify an entry, select the choice in the Choices section and click **Modify**. To remove a choice, select the choice and click **Remove**. To change the order of choice entries, select the choice and click **Move Up** or **Move Down**.

- **Radio button** and **Checkbox** formats (only for Web application): The procedure for defining the options for these controls are same as those for defining Combo box.

- **Label** format (only for Web applications): You can enter only a label for the dataslot.

  Changing the presentation format at the workstep level does not affect the presentation at the process level.

**Specifying validation at the dataslot level**

Business Process Modeler introduces a new validation framework that enables you to specify validation at the dataslot level. You can now associate validation rules with a CHARACTER, a INTEGER, or a DATETIMETZ dataslot type.
Table 30: Validation Rules for User-Defined Dataslots on page 91 lists and describes the dataslot validation rules and the dataslot type for which they are available.

### Table 30: Validation Rules for User-Defined Dataslots

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Length</td>
<td>Available only for CHARACTER dataslots. Enter a Minimum Length and a Maximum Length for the string text.</td>
</tr>
<tr>
<td>Number validation</td>
<td>Available for CHARACTER and INTEGER dataslots. Select the Number type (Integer or Float) and enter the minimum value and the maximum value in the respective text boxes.</td>
</tr>
<tr>
<td>Decimal validation</td>
<td>Available for CHARACTER, DECIMAL, and Number dataslots. Enter the number of digits to the left and to the right of the decimal point in the respective text boxes.</td>
</tr>
<tr>
<td>Decimal validation (advanced)</td>
<td>Available for CHARACTER, DECIMAL, and Number dataslots. In addition to the Decimal validation rule, this rule enables you to set a range of digits allowed to the left and to the right of the decimal point.</td>
</tr>
<tr>
<td>IP Address</td>
<td>Available only for CHARACTER dataslots. Define the Minimum Port Allowed or the Maximum Port Allowed. Default values are 0 for Minimum and 65535 for Maximum.</td>
</tr>
<tr>
<td>U.S. Social Security Number</td>
<td>Available only for CHARACTER dataslots. The predefined format (at runtime) is xxx-xx-xxxx.</td>
</tr>
<tr>
<td>Currency</td>
<td>Available only for CHARACTER dataslots. You can modify the Currency Character (default is &quot;&quot;), Grouping Character (default is &quot;,&quot;) and Decimal character (default is &quot;.&quot;).</td>
</tr>
<tr>
<td>U.S. Zip Code</td>
<td>Available only for CHARACTER dataslots. You can modify the Separator (default is &quot;)&quot;). You need to enter a 5-digit or 9-digit zip code at runtime. For the 9-digit zip code, the predefined format (at runtime) is xxxxx-xxxx.</td>
</tr>
<tr>
<td>U.S. Style Phone No.</td>
<td>Available only for CHARACTER dataslots. Select either Loose or Strict format.</td>
</tr>
<tr>
<td></td>
<td>• For Strict format, you need to enter the phone number (at runtime) as (xxx) xxx-xxxx or (xxx) xxx xxxx.</td>
</tr>
<tr>
<td></td>
<td>• For Loose format, you can enter a phone number (at runtime) without the brackets or hyphen or without both.</td>
</tr>
<tr>
<td>Email Address</td>
<td>Available only for CHARACTER dataslots. The format is predefined.</td>
</tr>
<tr>
<td>URL</td>
<td>Available only for CHARACTER dataslots. Select any of the allowed protocols (http, https, ftp, or all) and whether the Query strings are allowed.</td>
</tr>
<tr>
<td>Date</td>
<td>Available only for DATETIME-TZ dataslots. The format is predefined.</td>
</tr>
</tbody>
</table>

**To assign a validation rule to a dataslot:**

1. Select the CHARACTER, INTEGER, INT64, or DATETIMETZ dataslot in the **All Dataslots** section.
2. From the **Default Format** section, click **Browse** beside the **Validation** box.
The Validation dialog box appears.

3. Select any of the available rules from the Validation Rule drop-down list. Depending on the validation rule you selected, you may have to enter additional information, as described in Table 30: Validation Rules for User-Defined Dataslots on page 91.

**Note:** If you want to apply any of the decimal validation rules to a INTEGER dataslot using the Decimal validation option in the Validation Rule drop-down list, make sure that you have selected either the Double or Decimal options in the Storage section.

4. Click OK to save the changes you made to the dataslot properties.

**Exporting and importing dataslots**

Business Process Modeler enables you to import or export dataslots, either singly or in bulk, to a file, which is only available to you or to a repository, which is available to all Process Modeler users.

**Exporting dataslots**

You can export one or more user-defined dataslots to an existing file or to a file, which you specifically create for the dataslots.

**To export dataslots:**

1. From the Dataslots tab, click the Export icon. The Export Dataslots wizard appears.

2. From the first page of the Export Dataslots wizard, select any of the following options, then click Next:
   - CSV (Comma-delimited) File: to export the dataslots to a CSV (comma-delimited) file.
   - XML File: to export the dataslots to an XML file.

3. If you select the CSV (Comma-delimited) File option, the CSV (Comma-delimited) File page of the Export Dataslots wizard appears.
   a) If you want to export the dataslots to an existing CSV file, select the Overwrite existing file without warning checkbox to replace the contents of the existing file without any user warning.
   b) To create a new dataslot file, click Browse File System.
   c) Enter a name in the File name box and click Save. Alternatively, to export the dataslots to an existing file, select the file and click Save.
      The dataslot file and its location is displayed in the text box provided in the CSV (Comma-delimited) File page.

4. If you select the XML File option, the XML File page of the Export Dataslots wizard appears.
Exporting and importing dataslots

You can export user-defined dataslots from an existing data slot XML file or from an existing process template file.

To export dataslots:

1. From the Dataslots tab, click the Import ( ) icon.

2. Click Next to display the Dataslots page of the Export Dataslots wizard.

You can use the Dataslots page to select the dataslots that you want to export. The Dataslots page displays all user-defined dataslots in your process.

a) Select the checkbox of each dataslot or the dataslot type (for example, "CHARACTER") check box (to select all dataslots of that type). Alternatively, click Select All to select all of the listed dataslots. To deselect the dataslots, click Deselect All.

5. Click Next to display the Dataslots page of the Export Dataslots wizard.

You can use the Dataslots page to select the dataslots that you want to export. The Dataslots page displays all user-defined dataslots in your process.

a) Select the checkbox of each dataslot or the dataslot type (for example, "CHARACTER") check box (to select all dataslots of that type). Alternatively, click Select All to select all of the listed dataslots. To deselect the dataslots, click Deselect All.

6. Click Finish to export the dataslots. If you are exporting the dataslots to a file and have not selected the Overwrite existing file without warning checkbox, you will be prompted to click Yes to replace the content of the file with the exported dataslots.

Importing dataslots

You can import user-defined dataslots from an existing data slot XML (or CSV) file or from an existing process template file.

To import dataslots:

1. From the Dataslots tab, click the Import ( ) icon.

2. Click Next to display the Dataslots page of the Import Dataslots wizard.

You can use the Dataslots page to select the dataslots that you want to import. The Dataslots page displays all user-defined dataslots in your process.

a) Select the checkbox of each dataslot or the dataslot type (for example, "CHARACTER") check box (to select all dataslots of that type). Alternatively, click Select All to select all of the listed dataslots. To deselect the dataslots, click Deselect All.

6. Click Finish to export the dataslots. If you are exporting the dataslots to a file and have not selected the Overwrite existing file without warning checkbox, you will be prompted to click Yes to replace the content of the file with the exported dataslots.
You can use the **Dataslots** page to select the dataslots that you want to import.

a) Select the checkbox of each dataslot or the dataslot type (for example, "CHARACTER") check box (to select all dataslots of that type). Alternatively, click **Select All** to select all of the listed dataslots. To deselect the dataslots, click **Deselect All**.

6. Click **Finish** to import the dataslots.
Defining and assigning performers

You can define performers and assign them to worksteps. Business Process Modeler supports three types of performers—User (human performers), Adapter (a Java class as the performer), and Subprocess (another process, which can be assigned to a workstep).

Note: Web applications do not support user-type performers.

This chapter describes how to define and assign performers, as well as use swim lanes.

For details, see the following topics:

• Reviewing the Performers tab
• Defining performers
• Assigning performers
• Using swim lanes

Reviewing the Performers tab

You can review existing performers and define new performers in the Performers tab of the Business Process Modeler interface.

Click the Performers tab for a new Process Model project, to view the All Performer section, which contains all the performers available to the process template.

You can perform the following operations in the Performers tab:
Table 31: Operations in Performers tab

<table>
<thead>
<tr>
<th>Operations</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add a performer</td>
<td>See Defining performers on page 97.</td>
</tr>
<tr>
<td>Remove a performer</td>
<td>Select the performer to be removed, then click Remove. You cannot remove the default performer, @CREATOR.</td>
</tr>
<tr>
<td>Modify the performer details</td>
<td>Modify the performer details. You cannot modify the details of the default performer, @CREATOR.</td>
</tr>
<tr>
<td>Filter the performer list</td>
<td>Enter text in the type filter text box to filter the performer list and display all performers whose names contain the matching letters.</td>
</tr>
<tr>
<td>Group (or ungroup) the performer list</td>
<td>By default, all performers are grouped under performer type categories, namely, User (for human performer), Adapter (for adapter performers), or Sub-Process (for subprocess performer). To ungroup the performer list, click the No Grouping (≠ ) icon in the All Performer section. To group the performer list under categories, click the Group by Type (≠ ) icon in the All Performer section.</td>
</tr>
<tr>
<td>Collapse the performer list</td>
<td>Click the Collapse All (≠ ) icon.</td>
</tr>
</tbody>
</table>

You can assign any performer defined in the All Performer section to a workstep. The Performer page stores all performers defined for the process template, whether they are assigned to a workstep or are not assigned.

**Default performers**

In addition to the Performers tab, you can view existing performers by clicking the Assign Participants link in the Tasks pane.

Expand each Performer type to see the available performers for that type. Business Process Modeler provides the following default performers:

1. For Process Models, expand the Users folder to display two subfolders, namely:
   - Process, which stores user-type performers defined for the process template. This includes a default user named “Creator.” “Creator” is a dynamic dataslot value, which specifies the creator of the process instance: value can change from instance to instance and can reflect changes made at runtime.
   - Organization, which contains users defined using the User Management tool (see Working with User Management tool on page 179) under three subcategories namely, Users, Groups, and Queues.

2. Managed adapters enable you to define configuration and mapping between dataslots in a process template and inputs/outputs from a group of out-of-the-box adapters at process design time. These predefined managed adapters provide examples of specialized adapters that are commonly used in managing business processes. For more information, see Using managed adapters on page 99.
Defining performers

You can define performers of any type from the Performers tab. Alternatively, you can define and assign a performer to an Activity workstep using the Assign Participants link in the Tasks pane (see Using the Tasks pane on page 103).

This section describes how to define performers in the Performers tab.

Defining a user as a performer

You can add a new user (human performer), group (group of human performers), or a queue for a Process Model.

To define a user as a performer:

1. From the Performers tab, click Add.
   The first page of the New Performer wizard appears.

2. Select the User type of performer from the available options, then click Next. Options for Process Models include User, Adapter, and Sub-Process.

3. Enter an appropriate name for the User performer in the Enter a name box. Alternatively, for performer type, "User," you can link the performer to a CHARACTER dataslot. Type '@' in the Enter a name box to display the list of CHARACTER dataslots in the process. Select the dataslot to be linked to this performer.

   Note: If your process contains a business object dataslot (for example, "bo1"), you can also create an individual user mapped to the business object attribute of type, String. Enter the performer name as @<dataslot_name>. (in this example, @bol.) and then enter the attribute name (only of type, String) of the business object. If the business object contains another business object (example, "bo2") as an attribute, you can use a nested expression (in this example, @bol.bo2.) to enter the attribute name (only of type, String) of business object, "bo2."

   Alternatively, click Browse to select a user, group, or queue defined in the User Management tool (as discussed in Working with User Management tool on page 179). The dialog box that appears depends on the performer type that you select in the Select a type section; for example, if you select "User" as the performer type, the User dialog box listing all users defined in the User Management tool appears. Select a user (or group or queue) from those listed, then click OK to display the name in the Enter a name box.

4. Select the user type in the Select a type section to indicate whether the human performer is an individual user, queue, or a group.

   Table 32: Human performer type on page 97 describes each of the human performer types.

<table>
<thead>
<tr>
<th>Performer Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Individual user</td>
<td>A single human performer.</td>
</tr>
</tbody>
</table>
Chapter 11: Defining and assigning performers

<table>
<thead>
<tr>
<th>Performer Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group of users</td>
<td>A group of human performers. Select Any member(s) of the group if only one member from the group is required to complete a task OR select All if each performer from the group is required to complete the task. You can filter the members of a selected group by entering a valid role (as defined in the Administration module) in the Role box. For example, if All option is selected, and Manager is entered in the Role box, then all managers from this group are required to complete the workstep task.</td>
</tr>
<tr>
<td>Queue</td>
<td>A queue is defined as a group of users with the Any member(s) of the group option selected. At this time, queues created in Progress Developer Studio for OpenEdge do not automatically appear in Business Process Portal, but the same queue name must be created again in Business Process Portal. Also, queues created in the Administration module of Business Process Portal do not appear in the list of performers in the Performer tab.</td>
</tr>
</tbody>
</table>

Note: When you assign a User performer type to a workstep, Business Process Modeler checks if the performer is an Individual User, then checks if it is a Group of users, then if it is a Queue. If it is none of these, then the task is assigned to Manager. For this reason, names for User, Group, and Queue must be unique.

5. Click Finish to add the new performer to the Performers tab.

Note: To modify the user performer details, select the performer to be modified and make your changes in the User section of the Performers tab.

Defining an adapter as a performer

An adapter (previously called an external performer or EP) is a Java class that provides a mechanism that integrates external third-party classes and actions with Business Process Modeler; for instance, an adapter can automate some functions and tasks performed by a server or an external system.

Adapters are the “performers” of Adapter worksteps. Depending on your application requirements, you can use a predefined managed adapter provided by Business Process Modeler; or you can develop your own adapters to carry out specific tasks. Business Process Modeler provides a series of managed adapters that have complex, specific features. Advanced users can find out more about Managed Adapters in the Managed Adapters Guide.

To define an adapter and add it as a performer:

1. From the Performers tab, click Add.
2. From the first page of the New Performer wizard, select the Adapter type of performer, then click Next.
3. Type the adapter name in the Enter a name box. Specify the Java class and method in the appropriate boxes.
4. Select the Generate Java code checkbox if you want to generate a Java file for the Adapter workstep.
5. Click Next. In the Description page, enter a brief description of the custom adapter.
6. Click Finish to create the custom adapter and add it to the Performers tab.
Using managed adapters

Business Process Modeler provides Managed adapters that enable you to define configuration and mapping between datasets in a Process Model and inputs/outputs from a group of out-of-the-box adapters at process design time. Managed adapters are compatible with Business Process Modeler’s adapter configuration and mapping framework.

Process Modeler provides the following “out-of-the-box” Managed adapters for Process Models:

- **DB Adapter**: Provides connections to one or more specified databases, and enables you to quickly access SQL statements and parameters.
- **Email Adapter**: Enables Business Process Modeler to generate and send e-mail messages.
- **File Adapter**: Reads from and writes to a variety of file formats.
- **FTP Adapter**: Enables you to transfer files from and to your local file system, or an FTP server.
- **JMS Adapter**: Enables you to use Java Message Service (JMS) to communicate asynchronously with external systems and facilitates data exchange between processes and external applications.
- **OpenEdge Adapter**: Enables you to integrate Business Process Server applications with Progress® OpenEdge® solutions.
- **Sonic ESB Adapter**: Enables you to interact with Sonic® ESB to invoke a Sonic ESB process or service or send a message to a Sonic ESB endpoint.
- **Web Service Adapter**: Provides a connection to a specified Web Service, and enables you to map Web service methods to a dataset in a Modeler process.

To specify a managed adapter as the performer of a workstep:

1. Click the Assign Participants link in the Tasks pane and expand the Adapters > Managed folder to display the managed adapters folders available by default.
2. Expand the respective managed adapter folder, then drag the adapter to an existing workstep (or a blank area of the Content pane) to add the adapter workstep.

The managed adapter is now assigned as a performer of an Adapter workstep.

Defining a subprocess performer

A Subprocess is a process template that can be included into another process template by using a subprocess workstep. In this case, the performer of the subprocess workstep is the subprocess itself.

You can define a subprocess in a local or remote server as a subprocess performer in your process template without exiting Business Process Modeler by performing the following steps.

1. From the Performers tab, click Add.
2. From the first page of the New Performer wizard, select the Sub-Process type of performer, then click Next.
3. Enter a name for the subprocess in the Enter a name box.
4. You can use an alias to appear as the subprocess instance name in Business Process Portal instead of the lengthy subprocess name that appears by default. In the Enter an alias box (available only for Process Model), enter the alias name. Alternatively, you can use a CHARACTER dataslot as the alias. Type '@' in the Enter a name box to display the list of CHARACTER dataslots in the process. Select the dataslot to be used as the alias. When you use an alias, the subprocess name is in a format (<alias>#<sub-pid>) that controls the length of the subprocess name.

**Note:** To use aliases in multiple subprocesses, the Sub-Process box should contain a mapped dataslot for multiple processes and the Alias box must use dataslots of LIST type. In this way, each index can specify the alias for the respective subprocess. For more information, see “Subprocess Alias” in Chapter 16 of the BP Server Developer’s Guide, or the “Subprocess Alias” example in BM_Home\BP Server\examples.

5. In the Select a process box, enter a valid name for the process you want to use as a subprocess. Alternatively, you can select one of the following options:

- Assign a dataslot as a dynamic performer of the subprocess. Type '@' in the Select a process box to display the LIST of CHARACTER dataslots in the process. Select the dataslot to be used as the subprocess performer.
- Click Browse to select a specific process template file to be assigned as a static subprocess performer.

Placing an existing process template in the subprocess box converts that process template to a subprocess.

6. Use the Enter a server URL box (available only for process models) to connect to a remote server (provided your Business Process Server administrator has already set up this connection). Enter a valid path to the external server using the following format: jndi://$RemoteMachine>$jndiName>. Alternatively, type '@' in the Enter a server URL box to assign a CHARACTER dataslot as the dynamic performer on the remote server.

7. Select the Indexed checkbox (available only for process models) if you want to pass data from a LIST dataslot in a parent process to multiple subprocesses, with each subprocess containing a Primitive dataslot that asynchronously receives specific information from, and sends specific information back to, the LIST dataslot. You can map dataslots in the parent process to dataslots in each subprocess; or, if the dataslot name in each subprocess matches the dataslot name in the parent process, then no mapping is necessary.

This Indexed feature ensures that dataslot values in a subprocess are not overwritten, and that the correct value from a INTEGER dataslot is returned to its specific slot in the LIST dataslot.

If you are using a LIST dataslot as the subprocess performer and the Indexed check box is not selected, then each subprocess that is completed and submits data to the parent process may overwrite data from subprocesses that were completed earlier. Therefore, use a non-Indexed subprocess only when no data is to be returned or when overwriting of data does not matter. For more information about using a LIST dataslot to invoke multiple subprocesses, see Chapter 4, “Using a LIST Dataslot to Invoke Multiple Subprocesses” in the Application Developer’s Guide.

8. Click Next. In the Description page, enter a brief description of the subprocess.

9. Click Finish to create a subprocess performer and add it to the Performers tab.

**Note:** To modify the subprocess performer details, select the subprocess performer and make your changes in the Sub-Process and Description sections of the Performers tab.
Defining an inline subprocess

The Inline Subprocess is a self-contained subprocess that contains the same dataslots and other data variables as its parent process, and opens within the same File tab as its parent. By creating a process and subprocesses that share the same data variables, you can avoid using external processes as subprocesses to the active project. You may also avoid creating or assigning duplicate dataslots for these external processes, and performing complex dataslot mapping. Inline Subprocesses also reduce overheads by avoiding the checking out of multiple external subprocesses that might be part of other Process Model projects.

Note: The Inline Subprocess is not available for Web applications.

Note the following restrictions on the use of Inline Subprocesses:

- You cannot convert an inline subprocess to a conventional subprocess.
- The Rollback function is not supported for Inline Subprocesses.

You can use one of the following three methods to create an inline subprocess:

- Use the New Embedded Subprocess icon from the Tasks pane (see Using the New Embedded Subprocess icon on page 101).
- Use the Collapse functionality to collapse a group of worksteps having a single input link and a single output link to form an inline subprocess (see Using the Collapse functionality on page 101).
- Use a process model from the Repository Browser into the diagram (see Using a process model on page 103).

Using the New Embedded Subprocess icon

To define an embedded subprocess:

1. From the Tasks pane, click the Assign Participants link, then drag the New Embedded Sub-Process icon into the process template diagram. Notice that the Embedded Subprocess is indicated by the icon.
2. Open the subprocess workstep’s Properties view and define workstep properties as required.
3. Right-click the subprocess workstep and click Open to open a blank interface in which you can add shapes, connectors, and other data to create an inline subprocess.
4. To return to the parent process or to a higher level subprocess, in the Business Process Modeler toolbar, click the One Level Up ( ) icon or select the parent process or higher subprocess from the adjacent drop-down list.

Using the Collapse functionality

You can define an Inline Subprocess using the Collapse feature by quickly selecting several related worksteps and creating a self-contained inline subprocess, which is represented in the diagram as a single workstep.
1. Use the Select tool ( ) from the palette bar to select a workstep or a group of worksteps. The Collapse feature is enabled only if all these worksteps match the criteria of a single point of entry and a single point of exit.

2. Right-click the selected worksteps, then select the Collapse option to convert the selected workstep or group of worksteps to an inline subprocess.

3. The inline subprocess workstep is indicated by an Expandable ( ) icon (Figure 6: Inline Subprocess Workstep in Process Template on page 102). Open the workstep’s Properties view and assign a Label, Priority, and other properties, as required.

   Figure 6: Inline Subprocess Workstep in Process Template

4. To view the inline subprocess, right-click the inline subprocess workstep and then select Open. The grouped worksteps are displayed, as shown in Figure 6: Inline Subprocess Workstep in Process Template on page 102. The current subprocess, Subprocess 1 in this example, is contained under the tab of the parent process and is displayed in the drop-down list adjacent to the Up One Level icon ( ).

   Figure 7: Inline Subprocess Opened in the Parent Tab
5. To move up one level and, in this example, return to the parent process, click 🔄. You can use 🔄 to move up the chain of processes, or you can select a process from those listed in the adjacent box. The current subprocess always appears as the last name in the list of parent process and subprocesses; therefore, the combo box is disabled when the parent process is active.

6. If the worksteps you have grouped include Subprocess worksteps, then you can drill down further into the subprocesses by right-clicking the workstep and selecting Open. To move up the chain, click 🔄 or select from the parent process/subprocesses list, which displays all visited inline subprocesses.

### Using a process model

You can also create an Inline Subprocess by dragging a process model from the Repository Browser into the process template diagram. For details, see Adding an application to an existing process in *Progress OpenEdge Business Process Modeler: User's Guide*.

All dataslots present in the parent process are added to the inline subprocess and any dataslots present in the inline subprocess are merged with the parent's dataslots.

### Assigning performers

After defining a performer, you must assign the performer to a workstep. By default, when you drag an Activity shape (활동) from the Tasks pane to the content pane, you create an activity with no performer assigned. In certain cases, you may want to add this type of activity with an unspecified performer to your process template.

You can then perform any of the procedures, described in the following sections, to assign a performer:

### Using the Tasks pane

You can use the Assign Participants link in the Tasks pane to define a new performer and then add the appropriate workstep (depending on the performer type) to the process template.

The new performer icons provided by Business Process Modeler for Process Model projects are listed in Table 33: Assign Participants link in Tasks Pane on page 103.

#### Table 33: Assign Participants link in Tasks Pane

<table>
<thead>
<tr>
<th>Icon</th>
<th>Purpose</th>
<th>Navigation path</th>
</tr>
</thead>
<tbody>
<tr>
<td>New User</td>
<td>To create a new user type performer.</td>
<td>Expand Users &gt; Process.</td>
</tr>
<tr>
<td>New Adapter</td>
<td>To create a custom adapter performer.</td>
<td>Expand Adapters &gt; Custom.</td>
</tr>
<tr>
<td>New Sub-Process</td>
<td>To create a subprocess performer.</td>
<td>Expand Sub-Process &gt; External References.</td>
</tr>
<tr>
<td>New Embedded Sub-Process</td>
<td>To create an embedded subprocess (not available for web applications).</td>
<td>Expand Sub-Process.</td>
</tr>
</tbody>
</table>
You can drag any of these performers into the process template diagram to open the respective dialog boxes for a User, an Adapter or a Subprocess. After you have created the performer, a workstep is automatically inserted in the process template diagram. This workstep is performed by the performer you just created. This new performer is also added to those listed in the Tasks pane under the respective Users, Adapters, or Subprocesses folder.

1. Click the Assign Participants link in the Tasks pane to open a list of performer types.
2. Expand the folder of the Performer type you want to assign to the activity. Select a specific new performer icon and drag it on an existing activity shape or on the blank template.

**Note:** To assign a performer created using the User Management tool, expand Users > Organization, then drag the performer from the respective subcategory to an existing activity or on the blank template. The assigned performer is also added to the performer list in Users > Process and to the Performers tab.

Table 34: Activity Shape with assigned performer on page 104 illustrates the appearance of the activity shape after a performer is assigned to it.

<table>
<thead>
<tr>
<th>Activity Shape Appearance</th>
<th>Performer Type</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Activity 1" /></td>
<td>For an individual performer or a group member (with Any option selected).</td>
</tr>
<tr>
<td><img src="image2" alt="Activity 1" /></td>
<td>For a group member (with All members option selected).</td>
</tr>
<tr>
<td><img src="image3" alt="Activity 1" /></td>
<td>For a custom adapter.</td>
</tr>
<tr>
<td><img src="image4" alt="Activity 2" /></td>
<td>For a managed adapter. The shape varies according to the managed adapter used. In this case, it is an e-mail adapter.</td>
</tr>
<tr>
<td><img src="image5" alt="Activity 6" /></td>
<td>For a subprocess performer.</td>
</tr>
</tbody>
</table>

**Changing the workstep performer**

You can change the assigned performer of an activity workstep to any other performer or performer type.

1. Right-click an Activity, Adapter, or Subprocess workstep and then select the Change Performer option to open the Change Performer dialog box.
2. From any of the listed performer types, select a specific performer and click OK.
You can also change the performer through the Activity or Subprocess workstep’s Properties view. This procedure, however, only enables you to change to a performer of the same performer type.

**Using swim lanes**

A swim lane is a horizontal colored lane across the process template, which displays the worksteps performed by a specific user-type performer. Process template designers can use swim lanes to associate human performers with the worksteps they perform. You can also add a swim lane that has no specific performer, and any workstep added to this blank swim lane retains its original performer. Performers of Activity worksteps are automatically updated when an Activity workstep is added to a swim lane or moved from one swim lane to another. Other workstep types can be included in a swim lane, but, unlike Activity worksteps, their performers are not automatically updated.

**Note:** Swim lanes are not supported for Web applications.

**Creating swim lanes**

**To add a new swim lane:**

1. From the Tasks pane, click the Create Phases and Swim Lanes link in the Design Tasks panel, and then click the Swim Lane ( ) icon to open the New Lane dialog box.
2. Enter the ID and Name of the new swim lane in the respective boxes.
3. To assign a performer to the swim lane, click the ellipsis button beside the Performer box and then select the Select a performer option to open the Select a Performer dialog box, which displays a list of available performers that you can assign to the swim lane.

**Note:** You can use the Clear performer option to create a swim lane without assigning a performer to it.

4. Click the Appearance tab to apply a unique color to the swim lane.
5. Select an option from the colors listed. You can also click More to display more color options.

   You can also change the color of multiple swim lanes by selecting the lanes and clicking the Color Chooser ( ) icon in the Modeler Palette to open the color palette, where you can select one of the listed colors, or click More to display more color options.

6. Click OK to add a new swim lane for the specified performer to the process template diagram. Move the workstep that this user is performing into its swim lane.

Swim lanes have two headers. The primary Pool Header contains all the swim lanes and displays the name of the Process Model. The Lane Header displays the Name, ID, or Performer of each lane, as determined by selecting one of these options from the View menu in the Lane Popup Menu. The Pool Header remains as a black and white header, but you can define a color for each Swim Lane.
By default, Business Process Modeler adds a new swim lane below existing swim lanes. You can also insert a swim lane between existing lanes.

**Figure 8: Process Template with Swim Lanes**

You can assign the same performer to different swim lanes. You need not add all worksteps that have the same performer to the performer’s swim lane; these worksteps can also be placed in that part of the diagram outside the swim lanes.

**Resizing swim lanes**

You may need to resize a swim lane either to add a shape to the swim lane or to quickly move a shape into (or out of) this swim lane.

- To increase the width of a swim lane, select the Move shapes when resizing swim lanes checkbox, before resizing the swim lane. Shapes, adjacent to the swim lane, move as you resize the swim lane.
- To make the performer of the adjacent worksteps to that of this swim lane or to remove a shape from this swim lane, clear the Move shapes when resizing swim lanes checkbox, before resizing the swim lane. Shapes, adjacent to the swim lane, do not move as you resize the swim lane.

You can resize a swim lane by passing your cursor over the space between two swim lane headers and using the slider to adjust the swim lane’s size up or down.

**Performing additional swim lane operations**

You can perform additional operations on swim lane by right-clicking the swim lane header. Additional operations include:

- Changing the swim lane header display.
- Inserting a new lane between existing swim lanes.
- Removing a swim lane
- Modifying existing lane properties.

To change the swim lane display header:

- From the View menu, select either Name, ID, or Performer to view your selection in the header of each swim lane.
To remove a swim lane:

- Click **Remove Lane**, after removing all worksteps from the swim lane.

To change the properties of a swim lane:

- Click **Properties** to display the current swim lane properties (as defined in the **New Lane** dialog box) in the **Properties** view. You can modify each property, as described in **Creating swim lanes** on page 105.
Setting workstep properties

This chapter describes how to set properties of worksteps and other shapes that are used to create process templates in Process Modeler. Each process template must have one Start workstep, one or more intermediate worksteps, and one or more End worksteps, with the worksteps connected by links.

For details, see the following topics:

- About worksteps
- Defining properties of Start workstep
- Defining properties of Activity worksteps
- Defining properties of Adapter worksteps
- Defining properties of Subprocess worksteps
- Defining properties of Message worksteps
- Defining properties of End worksteps
- Defining properties of Decision gateways
- Defining properties of Or-Join gateways
- Defining properties of Exclusive Or-Join gateways
- Defining properties of AND gateways
- Defining link properties
- Defining a Rollback
- Defining a Timeout in worksteps
Managing multiple worksteps

About worksteps

Worksteps define the flow of business processes. In Business Process Modeler, you can create a workstep:

- In process models by dragging one of the these shapes into the Content pane: Start, Activity, Decision, Or-Join, Exclusive Or-Join, AND Gateway, Message, and End.
- In Web applications using these shapes: Start, Activity, Decision, Or-Join, and End.

Table 35: Types of Worksteps on page 110 lists and describes the types of worksteps and how they appear in a process template.

Table 35: Types of Worksteps

<table>
<thead>
<tr>
<th>Workstep Type</th>
<th>Appearance</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activity</td>
<td><img src="Activity.png" alt="Activity" /></td>
<td>This workstep is performed by a User (human performer). In a Process Model, an activity can be performed by an individual or group user, or by a queue. In a Web application, this workstep is performed only by a single user. For details, see Defining properties of Activity worksteps on page 113.</td>
</tr>
<tr>
<td>Adapter</td>
<td><img src="Adapter.png" alt="Adapter" /></td>
<td>This is an activity workstep, performed by an adapter. For details, see Defining properties of Adapter worksteps on page 117.</td>
</tr>
<tr>
<td>Subprocess</td>
<td><img src="Subprocess.png" alt="Subprocess" /></td>
<td>This workstep is a process by itself with its own process diagram and is external to the main process, including the subprocess workstep. For details, see Defining properties of Subprocess worksteps on page 119.</td>
</tr>
<tr>
<td>External Activity</td>
<td>![External Activity](External Activity.png)</td>
<td>This is a monitoring workstep, performed by an external human performer. This workstep type is only available for process models. For details, see Introducing Monitoring process on page 131.</td>
</tr>
<tr>
<td>External Adapter</td>
<td>![External Adapter](External Adapter.png)</td>
<td>This is a monitoring workstep, performed by an external adapter performer. This workstep type is only available for process models. For details, see Introducing Monitoring process on page 131.</td>
</tr>
</tbody>
</table>

Although the properties of an Activity, Adapter, and Subprocess worksteps vary according to their performers, these worksteps have the following properties in common:
• **Name.** Business Process Modeler assigns each workstep a default name; for instance, the first Activity workstep added to a process template is displayed as Activity 1. You can replace the default name with a more descriptive name in the **Properties** view for the workstep.

• **Dataslots.** Dataslots are used to transfer information between worksteps. You can define editable inputs (information that flows into the workstep) and read-only outputs (information that is sent out to other worksteps) in the **Dataslots** tab of the **Properties** view for Adapter, Message and Subprocess worksteps; in the **Fields** tab of the **Properties** view for Start and Activity worksteps; and in the **Configuration** tab of the **Properties** view for Managed Adapter worksteps.

• **Performers.** Each of these worksteps can be assigned a performer. Performer types include: User, Adapter, and Subprocess.

### Workstep properties

You can configure properties of a workstep, using the **Properties** view for that workstep.

**Note:** The **Properties** view is available for each process template element in **Diagram** and **Overview** tabs.

The **Properties** view for worksteps supports the following dynamic features:

• **General** tab: Allows you to define performers for Activity (see **Specifying general properties of Activity workstep** on page 113) and Adapter (see **Specifying general properties of Adapter workstep** on page 117) worksteps. You can also specify the workstep label (as it appears in BPM Portal) as well as define Overdue and Loop settings. For Start and Activity worksteps, you can also define the presentation format for the workstep.

• **Dataslots** tab (or in the **Configuration** tab for Managed Adapter worksteps or the **Fields** tab for Start or Activity worksteps): Allows you to assign dataslots to the workstep and modify them as they would appear on Business Process Portal. For more information on defining dataslots for a workstep type, see the Dataslot Properties description for that workstep type; for instance, for the Start workstep, see **Using the Fields tab of Start workstep properties** on page 112.

• **Collaboration** tab (only available for Activity worksteps): Allows you to select a level of collaboration and indicate the performers with whom you want to collaborate. You can also add such options to the workstep as reassigning tasks, adding Notes to a process, or sending Email or Instant Messaging.

• **Messaging** tab (only available for Start, Message, and End worksteps in Process Models): Allows you to select a message to initiate a process or a workstep; and to generate an outgoing message on the completion of a workstep or a process. Using this type of workstep provides a way to synchronize process events and to define actionable events at various stages of the process execution.

• **Alerts** tab (only available for Process Models): Allows you to add alerts to be associated with activation or completion of the workstep.

**Note:** You can also configure workstep properties using the **Properties** dialog box. You can open the **Properties** dialog box for any workstep by double-clicking the workstep or right-clicking the workstep and clicking **Properties** option.
Defining properties of Start workstep

The Start workstep (☐) indicates the beginning of a Business Process Server process template. Each process must have one Start workstep. The Start workstep only contains output dataslots, which can be mapped to specific locations.

**Note:** The Properties view for worksteps in Process Models have more features than those for Web Applications. In the following sections, only Properties view for Start worksteps in Process Models are presented, which are applicable for Web applications as well, unless otherwise stated.

Click the Start workstep to view its properties in the Properties view. The Properties view includes five tabs (Start worksteps in Web applications include three tabs).

Specifying general properties of Start workstep

From the General tab of the Properties view:

1. Identify the workstep by entering a name in the Name box. The workstep name appears in the process template diagram. Workstep names can only include alphanumeric characters and underscores (_).
2. Enter a label for the workstep in the Label box. Once you assign a label to a Start workstep, it always appears in the Start workstep in the process template diagram and in Business Process Portal—the Name of the Start workstep no longer appears.
3. To modify the default look and feel of the presentation pages for the Start workstep in Business Process Portal, click the ellipsis button beside the Presentation box (for more information, see Defining workstep presentation format on page 137).

**Note:** You can enter a description (optional) for the workstep in the Description tab. By default, the description can have up to 4095 characters.

Using the Fields tab of Start workstep properties

For Process Models, you can use the Fields tab to assign and manage dataslots, which control the information flow from the Start workstep. In Web applications, the Dataslots tab replaces the Fields tab.

The Header section displays the options—Instructions, Priority—to be displayed in the header section of Business Process Portal's task details page (corresponding to this workstep). You can choose to show or hide such information as Instructions for the workstep in the Header section of the Start workstep.

**To do this:**

1. Select any or all of the checkboxes in the Options section, to display the corresponding fields in the user’s Business Process Portal page.
2. Enter instructions for the workstep in the Instructions box. Instructions can be up to 255 characters. These instructions appear in Business Process Portal.

   Alternatively, you can link the instructions to a specific CHARACTER dataslot. To do so, select the Link instructions to Dataslot checkbox, then select the dataslot (if any) from the adjoining drop-down list. To create a new dataslot, click the ellipsis button beside the Link instructions to Dataslot checkbox to open the New Dataslot dialog box (Creating user-defined dataslots on page 85).
The user-defined dataslots assigned to the workstep are listed in the Fields section, which contains a table displaying the Icon, Name, Type, Category, Label, Editable, and Required columns. For information regarding these dataslot parameters, see Using dataslots on page 81.

### Adding dataslots

You can add user-defined dataslots to the Fields section in the Fields tab.

**To do so:**

1. Click **Add** to open the Add dialog box, which lists all the dataslots available to the process.
2. Select one or more dataslots and click **OK** to add them to the workstep.

You can modify a dataslot listed in the Fields section by selecting it and clicking **Modify**, displaying the Field Properties dialog box where you can edit the selected dataslot's properties.

To remove a dataslot listed in the Fields section, you can click **Remove**. Click **Move Up** or **Move Down** to change the sequencing of a selected dataslot.

**Important:** We recommend that you do not use dataslots with predefined values in a Start workstep.

**Note:** For Process Models, you can use the Alerts tab to associate an alert with a Start workstep when it is completed. For more information, see Associating an alert with a workstep on page 149.

### Using the Messaging tab of Start workstep properties

In Business Process Modeler, you can open the Messaging tab, but then you can only set the Enabled value to "True" in the Start workstep's Properties view. This action results in the Start workstep displaying a Message (▱) icon, and is for notational purposes only—you must open the process in Progress Developer Studio for OpenEdge to enable the Start workstep to receive a message. To remove the Message icon from the Start workstep, you must delete the workstep and create a new Start workstep.

### Defining properties of Activity worksteps

Activity worksteps are the basic unit of work, and must be performed in their entirety. An Activity workstep in a Process Model is an activity assigned to an individual user or to a group of users. An Activity workstep in a Web application can only be assigned to an individual user.

**Note:** The Properties view for worksteps in Process Models have more features than those for Web applications. In the following sections, only Properties view for Activity worksteps in Process Models are described unless otherwise stated.

Click the Activity workstep to view its properties in the Properties view which contains five tabs (Activity worksteps in Web applications contains three tabs).

### Specifying general properties of Activity workstep

From the General tab of the Properties view:
1. Identify the workstep by entering a name in the **Name** box. The name of the workstep is displayed in the process template diagram. Workstep names can only include alphanumeric characters and underscores (_).

2. Enter a label for the workstep in the **Label** box. This label of the workstep appears in Business Process Portal.

3. The **Performer** box (available only for Process Models) displays the performer assigned to the Activity workstep (as described in Assigning performers on page 103). To assign another performer, click the **ellipsis** button beside the **Performer** box to open the **Performer** dialog box.
   
a) All the User performer types available in the process are listed in the **Performer** dialog box. If there are many performers listed, then you can search the performer using the Search box and any User name containing that string is displayed in the text area. You can create a performer by clicking **New** to open the **Performer** dialog box (Defining a user as a performer on page 97).

b) Click **OK**, to select the user as the workstep performer and to return to the **General** tab.

4. From the **Default Performer** box (available only for process models), specify the default performer, to whom the Activity workstep is assigned if the workstep performer is not available. The default performer can be an individual user or a dataslot. This is an optional field. To assign a default performer, click the **ellipsis** button beside the **Default Performer** box, then select the **Select a Performer** option to open the **Performer** dialog box.

5. The **Presentation** box defines the look and feel of the presentation pages for the Activity workstep. To change the presentation format, click the **ellipsis** button beside the **Presentation** box to open the **Presentation** dialog box (for more information, see Defining workstep presentation format on page 137).

6. To set the priority of the workstep, select any of the predefined options from the **Priority** drop-down list (available only for process models). Predefined options include: **Low**, **Medium**, **High**, **Critical**, and **Use a dataslot**. If you select **Use a dataslot**, then you can use the **Select Dataslots** dialog box to select any of the listed dataslots of CHARACTER type.

7. The **Overdue in** box displays the default duration (2 hours) in which the workstep needs to be completed. Modify the time in which the workstep is overdue by clicking the **ellipsis** button beside the **Overdue in** box, and select either of the following options:
   
   - **Enter a duration** option to open the **Duration** dialog box. Enter the number of days, hours, minutes, or seconds to specify the workstep’s duration. Click **OK**.
   - **Use a Dataslot** option to open the **Select Dataslots** dialog box, which lists the INTEGER dataslots available in the process. Select a INTEGER dataslot to specify a dynamic duration for the workstep, and click **OK**. You can use only INTEGER dataslots with integer values for duration.

   **Note:** The value of this INTEGER dataslot must be in seconds, since this is the unit of time that BP Server expects for the duration until workstep completion. For example, if you want to set the workstep overdue duration to two minutes, then enter the dataslot value as 120 seconds.

8. Select the **Skippable** checkbox to allow an individual or member of a group to skip this work item (or task) at runtime. When the application is published on Business Process Portal, the task that represents the work item includes a **Skip** button that performers can click to skip the task. For example, if a work item is assigned to three performers and two of the performers choose to skip the work item, the third performer can perform the task. This feature is present only in Activity worksteps for Process Models.
9. Select the **Collect Work Time** check box if you want to force the performer to enter the time it took them to complete the task. By selecting this checkbox, you create a footer in Business Process Portal that requires the user to enter the Days, Hours and/or Minutes they needed to complete the task. This feature is present only in Activity worksteps for Process Models.

10. To make the Activity workstep execute multiple times, select the **Loop** check box. Follow the Defining a Loop condition on page 115 procedure. This feature is not available for Web applications.

### Defining a Loop condition

A Loop occurs when the workflow is repeated through the current workstep until a specified loop condition is met. To track the number of times the workstep is executed, you can define a counter that increments every time the loop is executed.

**To define a Loop condition:**

1. From the **General** tab of an Activity workstep’s **Properties** view, select the **Loop** check box, enabling the field and ellipsis button.
2. Click the **ellipsis** button to open the **Loop** dialog box, in which you can define the Loop condition.
3. Enter a variable (note that the variable must be an INTEGER dataslot type) by clicking the **ellipsis** button beside the **Variables** box. From the **Select Dataslots** dialog box, select an INTEGER dataslot type from those listed. Each time the workstep executes the loop, this variable is incremented by one.
4. From the **Condition** section, build a condition by selecting a dataslot from the drop-down list on the left and an operator from the middle drop-down list, and then selecting or entering a value in the drop-down list on the right. To enter a value:
   a) From the drop-down list on the right, select **Enter Value** option to open the **Enter Value** dialog box.
   b) Enter the value and click **OK**.
5. Click **OK** after defining the loop condition for this workstep.

As long as the defined condition is “true”, the workstep executes a loop. When the condition reads “false”, the workflow passes to the next workstep.

When a workstep is defined as a Looping workstep, the **Loop** (🔗) icon appears within the workstep shape, indicating to other users that a loop occurs in this workstep.

**Note:** If a workstep has both a Skip condition and a Loop condition, then the Skip condition is evaluated first. If it evaluates to true, then the workstep is skipped; if false, then the workstep is executed and the Loop condition is evaluated. If the Loop condition is evaluated as true, then the Skip condition is evaluated again.

**Note:** You can enter a description (optional) for the Activity workstep in the **Description** tab. A description can have up to 4095 characters.

### Using the Fields tab of Activity workstep properties

You can use the **Fields** tab to assign and manage dataslots that control the information flow into and out of an Activity workstep. You can manage existing dataslots and add dataslots using the **Fields** tab, as described for the Start workstep (see Using the Fields tab of Start workstep properties on page 112).
Defining collaboration tasks

The Collaboration feature is available only for Activity worksteps in Process Models. Collaboration allows you to set a number of options in Business Process Modeler, which displays the activity workstep as a collaborative task in Business Process Portal. Collaborative tasks allow application users to complete their work by collaborating with other users or groups (referred to as Collaborators). These options include the ability to select a level of collaboration as well as indicating the performers with whom you want to collaborate. You can also select other options such as reassigning tasks, adding Notes to a process, or sending Email or Instant Messaging.

To define collaboration properties:

1. Click the Collaboration tab in the Properties view for an Activity workstep.
2. From the Options section, select one or more of the following options that you want to include in Business Process Portal.
   - **Collaborative Tasks.** Select the appropriate options in the drop-down list to indicate whether you want to allow Business Process Portal user to edit the dataslots associated with the workstep, or only view the dataslots that are now read-only, or see no dataslots.
   - **Notes.** Specify whether you want the Business Process Portal user to see notes at the Instance Level (for all worksteps in the instance) or at the Workstep Level (for the current workstep). For more details regarding Notes, see the Business Process Portal User’s Guide.
   - **Reassign.** By default, the assigned performer of this workstep can reassign the task to another performer. To disable reassigning, clear this checkbox.
   - **Email.** To allow the assigned performer of this workstep to communicate with any of the collaborators using e-mail.
   - **Instant Messaging.** To allow the assigned performer of this workstep to chat with any of the collaborators using Instant Messaging.
3. From the Collaborators section, add the collaborators and also specify the operations the workstep performer can perform with each collaborator in BPM Portal. Note that there is a column added for each option that you select in the Options section.
   a) To add a collaborator, click Add to open the Select Users dialog box, in which you can select one or more of the users or groups, and click OK to add them to the Collaborators list.
   
   **Note:** You cannot add (or create) a queue as a collaborator. Further, you cannot add a group with ‘Any’ member selected as a collaborator or a group with a defined role.
   
   b) For each of the specified collaboration options, select either “true” or “false” from the drop-down list.
   
   **Note:** To delete a collaborator from the list, select the user or group and click Remove.

For worksteps with default presentation, the options selected in the Options section are displayed in the Task Details page of the workstep and all the collaborators defined in the Collaborators section are available in the Collaborators list in the Create Collaboration page in Business Process Portal.

**Note:** For Process Models, you can use the Alerts tab to associate an alert with an Activity workstep when it is initially activated or completed. For more information, see Associating an alert with a workstep on page 149.
Defining properties of Adapter worksteps

An adapter workstep is an activity workstep performed by an adapter, which runs an external system, remote device, or an application that is on a remote server external to Process Modeler. You can create an adapter workstep using a custom adapter or any of the eight predefined managed adapters.

Note: Properties view for worksteps in Process Models have more features than those for Web applications. In the following sections, only Properties view for Custom Adapter worksteps in Process Models are described, unless otherwise stated.

Click the Adapter workstep to view its properties in the Properties view. The Properties view contains four tabs (Adapter worksteps in Web applications contains three tabs).

Specifying general properties of Adapter workstep

Similar to that for an Activity workstep (Specifying general properties of Activity workstep on page 113), you can use the General tab to define the general properties of an Adapter workstep.

1. Identify the workstep by entering a name in the Name box. Workstep names can only include alphanumeric characters and underscores (_).

   Note: There is no default duration shown in the Overdue in box for Custom and Managed Adapters. There is no Performer box for managed adapters.

2. To define other general properties of an Adapter workstep that are identical to those already described for Activity worksteps, refer to Specifying general properties of Activity workstep on page 113.

   Note: You can enter a description (optional) for the adapter workstep in the Description tab. A description can be up to 4095 characters.

   Note: For Process Models, you can use the Alerts tab to associate an alert with the Adapter workstep when it is initially activated or completed. For more information, see Associating an alert with a workstep on page 149.

Using the Dataslots tab of Adapter workstep properties

You can use the Dataslots tab to control the information flow into and from a workstep performed by a custom (user-defined) adapter. From the Dataslots tab, you can assign dataslots to the adapter workstep and manage existing dataslots.

Note: For a managed adapter, the Configuration tab replaces the Dataslots tab. For information on configuring the managed adapter and mapping dataslots between Managed Adapter inputs/outputs and dataslots in processes, see the Managed Adapters Guide.

Dataslots assigned to the adapter workstep are listed in a table in the Dataslots tab. You can add, modify, or remove the dataslots.
The Name column provides the name of the dataslot. The other two columns show whether the dataslot provides Input to the Adapter or Output from the Adapter. For information on mapping dataslots, see Mapping dataslots in an Adapter workstep on page 118.

To add dataslots to those listed in the table:
1. Click Add to open the Select Dataslot dialog box.
2. Select one or more dataslots and click OK to assign them to the adapter workstep.

You can modify the Input and Output adapter settings for the existing dataslots in the Dataslots tab. Click in the Input to Adapter or Output to Adapter column for the dataslot you want to modify, then select true or false in the drop-down list.

Note: To remove a listed dataslot, select it and click Remove.

Mapping dataslots in an Adapter workstep

Mapping dataslots play an important role in adapter worksteps. Mappings enable you to pass data between dataslots in a process and methods in an adapter, and to automatically handle occasions when the names of the dataslot do not match the names of the adapter methods.

When you define a dataslot as an input to an adapter, BP Server invokes a corresponding set method in the adapter to assign the dataslot value to the variable in the set method (adapter). Similarly, to retrieve a variable from an adapter to a dataslot, BP Server invokes a get method at run time.

Note: For information on configuring and mapping any of the managed adapters, see the relevant chapters in the Managed Adapters Guide.

To map dataslots in an adapter workstep to a method in an external adapter:
1. From the adapter workstep Properties view, assign the dataslots for the adapter workstep, as described in Using the Dataslots tab of Adapter workstep properties on page 117.
   The Fields view, which is displayed by default, shows dataslots as Input to the adapter, Output from the adapter, or both.
2. Select the Advanced option from the drop-down list.
   The Advanced view automatically creates and displays the set methods used for Adapter inputs and the get methods used for Adapter outputs.
3. To edit an adapter input (set method), select an adapter input as displayed in the Advanced View and click Modify to open the Field properties dialog box.
4. Click the ellipsis button beside the Adapter input(s) box to open the Adapter input(s) dialog box.
5. Enter a new set method name in the text box provided and click Add, which adds it to the list in the Adapter input(s) dialog box.

Note: To delete a set method, select it from the list and click Remove. To change the sequence of listed set methods, use the Move up and Move down buttons.

6. After defining the set methods, click OK to return to the Field properties dialog box.
7. To add an adapter output (get method), enter a name in the Adapter output box.
8. Click OK, returning to the Dataslots tab of the Properties view.
Defining properties of Subprocess worksteps

The Subprocess workstep is an activity workstep performed by another process. It allows you to nest a complete Business Process Modeler process into another process template.

Specifying general properties of Subprocess workstep

From the General tab of the Properties view:

1. Identify the workstep by entering a name in the Name box. The name of the workstep appears in the process template diagram. Workstep names can only include alphanumeric characters and underscores (_).

2. When specifying the Performer in a Subprocess workstep, you must select a process to serve as the subprocess in the workstep. You can specify a process installed either on your local server or on a remote server.

   To define a performer (that is, to select a process) for the Subprocess workstep, click the ellipsis button beside the Performer box to open the Performer dialog box.

   a) All the subprocesses available in the process are listed in the Performer dialog box. If many subprocesses are listed, then you can search the Subprocesses performer type using the Search box and any name containing that string is listed.

   b) After selecting a subprocess, click OK to return to the Subprocess workstep and returning to the Subprocess Properties view. The subprocess is defined as the performer of the Subprocess workstep.

3. To define other general properties of a Subprocess workstep, which are the same of those described for Activity worksteps, refer to Specifying general properties of Activity workstep on page 113.

Note: You can enter a description (optional) for the subprocess workstep in the Description tab. A description can be up to 4095 characters.

Note: For Process Models, you can use the Alerts tab to associate an alert with the Subprocess workstep when it is initially activated or completed. For more information, see Associating an alert with a workstep on page 149.

Using Dataslot tab of Subprocess workstep properties

You can use the Dataslots tab to assign and manage dataslots, which control the information flow into and from the Subprocess workstep.

Note: The Dataslots tab is not available for inlines subprocesses.

You can add, modify, or remove dataslots assigned to the Subprocess workstep in the Dataslots tab, an easy-to-use interface where you can add new or modify existing dataslots.

By default, the Fields view is displayed, with dataslots listed in a table. The Name column lists the name of the dataslot. The other two columns indicate whether the dataslot is input or output for the subprocess.

You can add, modify, or remove dataslots, the same way as you manage dataslots for an Adapter workstep (as described in Using the Dataslots tab of Adapter workstep properties on page 117).
To assign a data slot as input to or output from the **Fields** view, click in the **Input to Sub-Process** or **Output from Sub-Process** column for the data slot you want to modify, then select **true** or **false** in the drop-down list.

**Mapping dataslots in a Subprocess workstep**

If the name and data type of the dataslots in a Business Process Model and the dataslots in a Web Application are identical, then default mapping occurs between the processes. If the name or data type differ, then default dataslot mapping does not work correctly.

**Note:** Default dataslot mapping is case-sensitive. For example, dataslots called “Budget” and “budget” are not mapped by default and must be mapped in the workstep Properties.

**To map dataslots in a Subprocess workstep:**

1. From the drop-down list under Dataslots, select **Advanced** option, which displays the **Set dataslot(s)** and **Get dataslot** columns in the table below that.

   The Advanced view enables you to pass dataslot values from the subprocess to an input (Set) dataslot or to an output (Get) dataslot in a parent process.

2. Select a dataslot and click **Modify**, to launch the **Field Properties** dialog box. You can enter multiple Set dataslots and one Get dataslot for the Subprocess dataslot.

3. To map a parent process dataslot to one or more inputs in the subprocess, click the **ellipsis** button beside the Set dataslot(s) box to open the Set Dataslots dialog box.

   a) In the text box, enter the name of the dataslot in the parent process that you want to map to the subprocess dataslot and click **Add**. The parent process dataslot is added to the dataslot list. Use the other command buttons to delete, or move a selected dataslot up or down.

   b) Click **OK** to return to the **Field Properties** dialog box.

4. In the **Field Properties** dialog box, enter an output dataslot name in the **Get dataslot** box to map a subprocess dataslot to an output dataslot in a parent process.

5. Click **OK**.

   The dataslots to which you mapped the subprocess dataslots are displayed in the Set dataslot(s) and Get dataslot columns.

**Defining properties of Message worksteps**

In Business Process Modeler, the Message workstep (.spawn) is for notational purposes only—that is, you can only use this workstep as a symbol in the process template diagram. You cannot define the properties of a Message workstep in Business Process Modeler. You must open the process in Progress Developer Studio for OpenEdge to enable the **Properties** view for the Message workstep.

In Progress Developer Studio for OpenEdge, the Message workstep enables users to use an incoming event or message to initiate a process or a workstep; and conversely to generate an outgoing message with the completion of a workstep or a process. Using this type of workstep provides a way to synchronize process events and to define actionable events at various stages of the process execution.
Defining properties of End worksteps

End worksteps (◇) mark the end of the process flow. A process template must have at least one End workstep.

Click the End workstep to view its properties in the Properties view. The Properties view of the End workstep for process models contains four tabs. For Web applications, it contains three tabs.

From the General tab, enter the label for the workstep in the Label box. Once you assign a label to an End workstep, it always appears in the process template diagram and in Business Process Portal. If no label is entered, then the End workstep appears blank.

**Note:** You can enter a description (optional) for the End workstep in the Description tab. A description can be up to 4095 characters.

**Note:** For Process Models, you can use the Alerts tab to associate an alert with an End workstep when it is activated or when it is completed. For more information, see Associating an alert with a workstep on page 149.

Using Messaging tab of End workstep properties

The Messaging tab is only seen in End worksteps in Process Models—it is not available in End worksteps in Web applications.

You can open the Messaging tab, but then you can only set the Enabled value to “true” in the End workstep’s Properties view. This action results in the End workstep displaying a Message (◇) icon, and is for notational purposes only—you must open the process in Progress Developer Studio for OpenEdge to enable the End workstep to send a message upon process completion.

Using the Dataslots tab for Web applications

The Dataslots tab is available for End worksteps in Web applications only. If you are planning to use the process as a subprocess, then you can use the Dataslots tab to assign dataslots to the End workstep that passes information onto the parent process.

You can add, modify, and remove dataslots assigned to the End workstep, similar to how you manage dataslots for other worksteps.

Defining properties of Decision gateways

The Decision gateway (◇) represents a division of the control flow of the process. A Decision gateway can contain multiple incoming and outgoing links. For each Decision gateway, at least one of the outgoing links must have an empty Condition (the Default link), and the other links can each contain a condition. Business Process Modeler follows BPMN notation by automatically displaying the default link as a line with a slash (/) through it.
Alternatively, you can get the equivalent of a Decision gateway by adding multiple outgoing links to a successor Activity workstep, and assigning a specified condition to some of the links. With this type of link, any links with conditions are indicated by a small diamond at the start of the link, and the default link as a line with a slash through it. Once the predecessor workstep is completed, one or more successor worksteps are activated if conditions in the links are fulfilled.

**Note:** It is possible that the number of outgoing links for a Decision gateway can be more than the number of incoming links. This can occur when a Decision gateway has more than two outgoing links and two or more of these links fall within the probability range and are activated, resulting in an apparent discrepancy in simulation data. For an Exclusive Decision (see Defining Exclusive Decisions on page 122), however, only one outgoing link is activated and the number of outgoing links is always equal to the number of incoming instances.

Click the Decision gateway to view its properties in the Properties view. The Properties view of a Decision gateway includes two tabs—General and Description.

**To define properties for the Decision gateway:**

1. From the General tab, modify (if required) the name of the Decision gateway in the Name box. Enter the label for the gateway in the Label box. Once you assign a label to a Decision, it always appears in the process template diagram. If no label is entered, then the Decision is blank.

2. To make the Decision gateway an exclusive decision gateway, select the Exclusive checkbox (available for Process Models only). For details, see Defining Exclusive Decisions on page 122.

3. The Links section contains a table that lists all the multiple outgoing links (and conditions, if any) from this gateway. You can modify or remove any link by selecting it and then clicking Modify or Remove. For information on defining link properties, see Defining link properties on page 124.

**Note:** You can enter a description (optional) for the Decision gateway in the Description tab. A description can be up to 4095 characters.

## Defining Exclusive Decisions

An Exclusive Decision indicates that the workflow can go through only one outgoing link, while the typical Decision executes all links that meet specified conditions.

To set the Decision gateway as an Exclusive Decision gateway, select the Exclusive check box. When you select the Exclusive checkbox, the Move Up and Move Down buttons are displayed, allowing you to establish the sequence of the outgoing links.

This ordering is important because links are evaluated in sequence, and the first link that fulfills the specified condition is executed. The remaining links are not evaluated.

In an Exclusive Decision, there must be only one default link (that is, a link with no condition). This link is executed when conditions on the other links are not fulfilled. If there is more than one default link or if there is no default link, then an error message is displayed.

Once you have defined the Decision as an Exclusive Decision gateway, it is displayed as a Decision gateway with an ‘X’ through it ( ). According to BPMN conventions, the appearance of the Exclusive Decision icon is the same as that of the Exclusive Or-Join (XOR) icon. The Exclusive Decision differs in that it has a single predecessor workstep and multiple successor worksteps.

**Note:** The Exclusive Decision gateway is not available for Web applications.
Defining properties of Or-Join gateways

You can use an Or-Join gateway to connect multiple predecessor worksteps to one successor workstep. The successor workstep is performed only when any one of the predecessor worksteps are completed. The most common use of an Or-Join gateway is with a loop back or to connect to an End workstep. Alternatively, you can get the equivalent of an Or-Join by adding multiple incoming links to an Activity workstep, and this workstep is activated when any of its predecessor worksteps are completed.

Click the Or-Join gateway to view its properties in the Properties view. The Properties view of the Or-Join gateway contains a General tab and a Description tab.

Defining properties of Exclusive Or-Join gateways

You can use an Exclusive Or-Join gateway (X) to direct the process workflow to proceed only once from multiple predecessor worksteps to a successor workstep. When the Exclusive Or-Join (XOR) gateway is completed, any other predecessor human-performed worksteps that immediately precede the XOR are terminated. According to BPMN conventions, the Exclusive Or-Join (XOR) icon is the same as that of the Exclusive Decision icon. The Exclusive Or-Join (XOR) differs in that it has multiple predecessor worksteps and a single successor workstep.

Click the Exclusive Or-Join gateway to view its properties in the Properties view, which is similar in functionality to that for Or-Join gateway.

Note: The Exclusive Or-Join gateway is supported only in Process Models.

Figure 9: Exclusive Or-Join Example

Figure 9: Exclusive Or-Join Example on page 123 illustrates an example of the Exclusive Or-Join (XOR), wherein three companies are scheduled to collect a package. When any of these companies pick up the package, the XOR gateway is activated and the predecessor worksteps are terminated. The XOR gateway then proceeds to activate the Confirmation workstep.

Important: The XOR gateway functions correctly (that is, terminates the remaining predecessor worksteps) only if the predecessor worksteps are all human-performed Activity worksteps.
The XOR gateway allows workflow to proceed from only one of the predecessor worksteps. This action differs from the Or-Join, which would allow workflow to continue from Activity 1, 2, or 3 as each of these Activity worksteps are completed.

Defining properties of AND gateways

You can use an AND gateway (\(\text{\ding{130}}\)) to connect multiple worksteps to one successor workstep, or a single predecessor workstep to multiple successor worksteps. The successor workstep is activated only if all the predecessor worksteps are completed. This feature enables you to synchronize the completion of multiple predecessor worksteps. When an AND gateway has multiple incoming links, it must have a single outgoing link:—in this case, the AND Gateway acts as an And-Join. When an AND Gateway has a single incoming link, it can have multiple outgoing links:—in this case, the AND Gateway acts as an And Fork (or Split). These variations in incoming and outgoing links for AND gateways are illustrated in Using multiple incoming/outgoing links with gateways on page 47.

Click the AND gateway to view its properties in the Properties view, which is similar in functionality to that of the Or-Join gateway.

Note: The AND gateway is supported only in Process Models.

Defining link properties

You can use the Connect Shapes link in the Tasks pane (see Connecting worksteps on page 43) to define the workflow connection (or links) between process template elements. You can either use the Normal Flow to link worksteps in the workspace, or the Compensation Flow to define the workflow in the event of a rollback (see Defining a Rollback on page 126), or the Time-out Flow (see Defining a Timeout in worksteps on page 127).

You can define links with or without conditions. In Decision gateways (see Defining properties of Decision gateways on page 121), you can modify an existing link condition in the Properties view, as described in this section.

For process models

You can now assign a condition to a link in the process template diagram. In previous releases, you could assign a condition only to a link from a Decision gateway. Once you assign a condition to a link that does not have a Decision as a predecessor workstep, the link becomes the equivalent of a Decision gateway.

To define the properties of a standard link in process models:

1. Click the link to view its properties in the Properties view.
2. Assign a name to the link in the Name box and add a label in the Label box of the General tab.
3. To assign a condition to the link, clear the Default checkbox to view the Basic and Advanced settings. By default, the Basic setting is displayed. For information on Advanced settings, see Step 4 below.
4. Use the features of the Basic setting to build an expression based on existing conditions.
a) Select a dataslot from the drop-down list on the left (the Basic mode only includes CHARACTER, INTEGER, INT64, LOGICAL, and DATETIME-TZ dataslot types; the Advanced mode includes all data types). Select an operator from the adjacent drop-down list. Operator values change, depending on the dataslot type: For example, a CHARACTER dataslot displays more options than a INTEGER dataslot.

**Note:** If you want to evaluate a Null value for a CHARACTER dataslot, then you only need to select ‘is null’ from the Operator drop-down list.

b) Select a dataslot from the drop-down list on the right, or select Enter value option to open the Enter Value dialog box, in which you can enter a static value.

c) Click to add another condition, enabling the And/Or operand.

d) Select And or Or and add as many conditional expressions as required.

e) To remove a conditional expression, click 🗑️.

5. To configure the condition using Advanced settings, select the Advanced option to view a list of dataslots and a Condition text area wherein you can build more complex expressions or to cut and paste expression that have been defined elsewhere.

a) You can enter or paste an expression in the Condition text area, or drag a dataslot from the Dataslot list to add it to the advanced condition.

b) When you add an expression in the Advanced setting, it overwrites all expressions that you created in the Basic setting. Click Validate to verify if the expression is valid.

c) Select Basic option to delete the expressions in the Advanced setting and to return to the Basic setting.

**Note:** You can enter a description (optional) for the Link in the Description tab. A description can be up to 4095 characters.

---

**For Web applications**

To define the properties of a link from an Activity workstep in Web applications, click the link to view its properties in the Properties view.

1. Assign a name to the link in the Name box and enter the label in the Label box.

2. Business Process Modeler supports three types of links for Web applications, namely Submit button, Hyperlink, and Image. Select the link type from the Type list.

   • Select the Submit button option to display a Submit button on the interface page. Data is passed on from this interface page to the next interface page. Enter text in the Label box to be displayed as the name of the button, replacing the default Submit label for the button.

   • Select the Hyperlink option to create a line of text on the interface page that functions as a hyperlink.

   The hyperlink connection is displayed as a dotted line ( '*' ). In the Label box, enter the hypertext label to be displayed on the image or text link seen on the workstep interface page in your browser. You can also open the dialog box in your browser to add a brief description that will appear when you move the mouse over the image.

   • Select the Image option to create an image link on the interface page. In the Label box, enter the hypertext label to be displayed on the image or text link seen on the workstep interface page in your browser. Specify the image file name to be displayed on the workstep interface in the Image box. For images stored outside the Business Process Modeler installation directories (for example, in a Web server folder),
specify the full URL in the Image box. Select the **Submit** checkbox, to ensure that information from dataslots on the current interface page is passed on to the next interface page. If the **Submit** check box is cleared, then no data is passed on to the next interface page and the link in the process template diagram is displayed as a dashed line, not a solid line.

**Note:** You can enter a description (optional) for the Link in the **Description** tab. A description can be up to 4095 characters.

When using Links in Web applications, note that:

- You must select the **Submit** checkbox for Image types of links in order to pass on data to the next page.
- Activity worksteps that include output dataslots can use a link of the Link type. Image type links can be used only if the **Submit** check box is selected. Activity worksteps without output dataslots must contain links of the Image type or a Link type with a value.
- Selecting **Submit button** as the link type for an Activity workstep automatically creates a **Submit** button in the application interface. You can override the default "Submit" label by entering a label name in the Label box of the **Properties** view for the link.

## Defining a Rollback

Business Process Modeler allows you to add a “rollback” operation to a workstep in a Process Model, which has already been completed earlier in a process; that is, the workflow is restarted from the designated rollback workstep in the process. This process is required to restore the original information and eliminate the numerous changes that can occur to the process between the designated rollback workstep and the currently activated workstep.

To define the Rollback, you must set a workstep as a rollback point and specify which dataslot values are saved. In addition, you have the option of:

- Writing JavaScript code to handle a rollback request.
- Configuring an Activate workstep that, after the rollback is performed, activates the given workstep and returns to the same state as when that workstep was first performed.

In a rollback, the workflow is restarted from the workstep selected as the rollback point in the process. You can only apply a rollback point to Activity, Adapter and Subprocess worksteps in Process Models.

You can define a a rollback by using the **Compensation Flow** type of connector.

### Using the Compensation Flow connector

You can use the **Compensation Flow** connector (see **Connecting worksteps** on page 43) to define the workflow in case of a rollback.

To define a compensation flow:

1. Click the **Connect Shapes** link in the Tasks pane, to view the three supported Flow types.

2. Click the **Draw compensation flow connector** icon and connect the workstep that initiates the rollback to the rollback point workstep from where the workflow is restarted.
An example of a rollback is shown in Figure 10: Example of a Process with Rollback and Timeout on page 127, in which Activity 5 initiates the rollback and Activity 1 is the Rollback Point.

Figure 10: Example of a Process with Rollback and Timeout

Inserting a Compensation Flow automatically makes the target workstep the rollback point. As seen in Figure 10: Example of a Process with Rollback and Timeout on page 127, the Rollback Point workstep is marked with a icon and the start of the Compensation Flow link is indicated by the icon.

Defining a Timeout in worksteps

You can use the Timeout feature to indicate the direction of a process workflow after Overdue Actions for the workstep have been executed and the Last Overdue action is completed.

To define a Timeout:

1. Click the Connect Shapes link in the Tasks pane: the three supported Flow types are displayed.

2. Click the Draw time-out flow connectors icon and connect the workstep that begins the timeout flow to the next workstep in the timeout workflow.

In the example shown in Figure 10: Example of a Process with Rollback and Timeout on page 127, Activity 2 initiates the timeout and Activity 3 is the next step in the Timeout flow. The source workstep of a Timeout Flow is marked with a .

To remove the Timeout Flow, right-click the Timeout Flow link and click Remove.
Managing multiple worksteps

You can perform the same operation on multiple worksteps in a process template using the Select icon in Modeler palette.

Modifying multiple workstep properties

You can simultaneously edit multiple worksteps of the same type. For example, you can select all Activity worksteps in a process template and assign the same performer to all, or change the Priority of all Adapter worksteps at the same time.

To modify multiple worksteps:

1. Click the Select (_select_ ) icon in the Modeler palette and drag across the worksteps to be selected. Alternatively, you can press CTRL and then click the worksteps to be selected.

   The Properties view displays the name as "(multiple worksteps)" in a read-only box.

2. Modify properties such as the performer, priority, and duration, as required. For instance, change the priority to Critical.

Aligning and spacing worksteps

Business Process Modeler allows you to align selected worksteps and distribute selected worksteps at equal intervals.

To align worksteps or other components in a process template diagram:

1. Use the Select tool to select the worksteps and other components that you want to align.

2. Click the Select and Change Layout link in the Tasks pane, displaying the Layout options in the Layout Tasks panel.

   Table 36: Layout options on page 128 lists the available layout options.

<table>
<thead>
<tr>
<th>Layout Operation</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Align shapes horizontally</td>
<td>To align the selected components horizontally.</td>
</tr>
<tr>
<td>Align shapes vertically</td>
<td>To align the selected components vertically.</td>
</tr>
<tr>
<td>Distribute shapes evenly on the horizontal</td>
<td>To evenly space the selected components horizontally. If you select more than two components, then only the components between the one on the far left and the one on the far right are moved.</td>
</tr>
<tr>
<td>Layout Operation</td>
<td>Purpose</td>
</tr>
<tr>
<td>------------------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Distribute shapes evenly on the vertical</td>
<td>To evenly space the selected components vertically. If you select more than two components, then the uppermost and lowermost components are not moved and the other components are evenly distributed in reference to the upper and lower components.</td>
</tr>
<tr>
<td>Auto layout</td>
<td>Generates an ideal layout for process template elements, thus eliminating the need for manual adjustment.</td>
</tr>
</tbody>
</table>
Introducing Monitoring process

Business Process Modeler enables you to design and configure a Monitoring process, which uses business events to monitor an external process on Business Process Server platform. This chapter describes how you can use Business Process Modeler to create a monitoring process.

**Note:** For detailed description of the working of monitoring process, see Chapter 29:"Working with Monitoring process" in *BP Server Developer’s Guide*.

For details, see the following topics:

- Designing a monitoring process

Designing a monitoring process

You can create a process model that can be used as a monitoring process. The following restrictions apply to a monitoring process:

- It must include at least one monitoring workstep. A monitoring workstep can be of type, External activity or adapter, which receive external events for activation and completion.

- It must include a CHARACTER dataslot selected as the EIID, as discussed in Assigning EIID on page 133.

- Any dataslot, associated with a monitoring workstep, must be editable, so that its value can be modified by the external event. For more information, see Using dataslots on page 134.

**Note:** You cannot design a monitoring process using a Web application project.
Configuring monitoring workstep

Setting workstep properties on page 109 describes how you can add and configure activity, adapter and other workstep types in Business Process Modeler. Similarly, you can add and configure monitoring worksteps for tasks, performed by external users or adapters.

Business Process Modeler supports the following types of monitoring worksteps performed by external participants:

• **External Activity**: This workstep is performed by an external user, specified in the triggering event. In case the event does not include the performer’s name, you can configure a default performer for this workstep.

  **Note**: The name of the external performer, as well as the default performer, need not be defined in your monitoring process template.

• **External Adapter**: This workstep is triggered and performed by an external system performer.

To add a monitoring workstep:

2. From the Business Process Modeler Tasks pane, click the Assign Participants link and expand the External folder.
   a) To add an external activity workstep, drag the External User icon.
   b) To add an external adapter workstep, drag the External Adapter icon.

Similar to activity and adapter worksteps, you can use the Properties view to configure workstep properties for the external activity and adapter worksteps. The Properties view is similar to that for an Activity workstep (as discussed in Defining properties of Activity worksteps on page 113) with the following exceptions:

• From the General tab, you cannot assign or change the performer in the Performer box. This is because the performer is from the external system and need not exist in the current process template.

• In addition to selecting an individual performer or dataslot, you can use the Default performer box to specify a performer, who does not exist in the current process template. For more information, see Default performer for monitoring workstep on page 133.

• If you select the Wait For Activation checkbox, then the external activity workstep waits and processes the ACTIVATE_WORKSTEP event before proceeding with the COMPLETE_WORKSTEP event, even if it has arrived. If the Wait For Activation checkbox is not selected, then the workflow processes the event which comes first. For example, if COMPLETE_WORKSTEP event comes before ACTIVATE_WORKSTEP event, then it is processed and the ACTIVATE_WORKSTEP event is moved to invalid event table.

• The General tab does not contain Priority, Presentation, Skippable, and Collect Work Time fields, as they are not applicable to a monitoring workstep.

• You can use the Dataslots tab to add dataslots. For more information, see Using dataslots on page 134.

• There is no Collaboration tab, because it is not required in a monitoring workstep.

  **Note**: You can configure the remaining external activity properties, as discussed in Defining properties of Activity worksteps on page 113.

The Properties view is similar to that for an external activity workstep. The only exception is that there is no default performer, because this field is not applicable for an adapter workstep.
Default performer for monitoring workstep

You can specify a default performer for an external activity workstep by clicking the ellipsis button beside the Default performer box in the General tab and then performing any of the following operations by selecting the appropriate option:

- To assign an existing performer:
  1. Select the Select a Performer option. The Performer dialog box appears, which lists all the performers in the current process.
  2. Select any of the performers listed and click OK to assign the selected user as the default performer.

- You can create and assign a new performer as a default performer. To create and assign a new performer:
  1. Select the Select a Performer option.
  2. From the Performer dialog box, click New to open the Performer dialog box.
  3. Enter the name of the performer in the Name box.
     Alternatively, click the ellipsis button beside the Name box, then select either of the following options.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select an Existing User</td>
<td>To add a user defined in the User Management tool (see Working with User Management tool on page 179).</td>
</tr>
<tr>
<td>Use a Dataslot</td>
<td>To select a CHARACTER dataslot as the performer.</td>
</tr>
</tbody>
</table>

4. Click OK to add the selected performer to the list of performers in the Performer dialog box.
5. Click OK to assign the new performer as the default performer.

- You can add a performer that does not exist in the process template.
  1. Select the Enter a new value option
  2. From the Default Performer dialog box that appears, type the name of the performer.
  3. Click OK to assign the specified performer as the default performer.
     To specify another performer, click the ellipsis button beside the Name box, and select the Modify value option. Modify the default performer name in the Default Performer dialog box.
     To remove the selected default performer, click the ellipsis button beside the Default performer box, and select the Clear option.

Assigning EIID

You can assign an EIID to the monitoring process after adding a monitoring workstep. You can assign only one dataslot as the EIID.

The dataslot assigned as the EIID must satisfy the following requirements:

- Dataslot type must be CHARACTER.
- Value must be unique across all instances of the monitoring process.
• Storage type must be VARCHAR with size 128.

To assign the EIID to a monitoring process:

1. Click a blank area of the Diagram tab to open the Properties view. For details regarding process properties, see Setting process properties on page 75. The Properties view displays the additional Monitoring tab.

2. Click the ellipsis button beside the External Instance Id Dataslot box and then select one of the following options:
   • **Use a User Dataslot**: The Select Dataslot dialog box that appears lists the user-defined CHARACTER dataslots in this process. Select a dataslot, then click OK to assign it as the EIID. Alternatively, you can click New to create a CHARACTER dataslot and then assign it as the EIID.
   • **Use ProcessInstanceId**: Assigns the system dataslot, “ProcessInstanceId,” as the EIID. The assigned dataslot is displayed in the External Instance Id Dataslot box. To clear this selection, click the ellipsis button beside the External Instance Id Dataslot box and then select the Clear option.

### Using a subprocess

In some cases, you may need to use multiple EIIIds in the same monitoring process. For example, an “Order” process requires a unique Order ID during ordering, as well as Shipment ID during product shipment.

You can handle this requirement by using a subprocess. In the above example, the subprocess can handle the shipment process. For more information regarding subprocesses, see Defining a subprocess performer on page 99.

**Note**: You cannot use an inline subprocess to handle this requirement.

As the subprocess is an independent process model, it can have its own EIID (for instance, ShipmentID), which can be mapped to a dataslot from the parent process. If required, then the parent process can pass on its EIID (example, OrderID) to the subprocess at the time of its creation.

**Important**: Ensure that the value of the dataslot in the parent process, mapped to the EIID of the subprocess, is not null (or empty); otherwise, the subprocess instance is suspended.

### Using dataslots

Table 38: Supported dataslots on page 134 lists the dataslot types that you can assign to a monitoring workstep in the monitoring process. A business event only updates those dataslots assigned to monitoring worksteps.

**Table 38: Supported dataslots**

<table>
<thead>
<tr>
<th>Dataslot</th>
<th>Java Type</th>
<th>Comments (if any)</th>
</tr>
</thead>
<tbody>
<tr>
<td>CHARACTER</td>
<td>String</td>
<td>Any string length longer than the maximum length specified for the process template, is truncated.</td>
</tr>
<tr>
<td>INTEGER</td>
<td>Double, BigDecimal</td>
<td></td>
</tr>
<tr>
<td>INT64</td>
<td>Long</td>
<td></td>
</tr>
</tbody>
</table>
### Designing a monitoring process

<table>
<thead>
<tr>
<th>Dataslot</th>
<th>Java Type</th>
<th>Comments (if any)</th>
</tr>
</thead>
<tbody>
<tr>
<td>LOGICAL</td>
<td>Boolean</td>
<td></td>
</tr>
<tr>
<td>DATETIME-TZ</td>
<td>Long</td>
<td>Date must be specified in <strong>milliseconds</strong>.</td>
</tr>
<tr>
<td>LIST</td>
<td>List</td>
<td></td>
</tr>
<tr>
<td>Map</td>
<td>Map</td>
<td></td>
</tr>
</tbody>
</table>

**Note:** Dataslots of the type Object and Business Object are not supported for a monitoring process.

The following business events can modify the value of the dataslots in the monitoring process instance.

- **UPDATE_DATASLOT**: This event can update the value of any user-defined dataslot (of the type listed in Table 38: Supported dataslots on page 134) in the monitoring process, including those dataslots not added to the monitoring workstep. This event identifies the process instance using the EIID value, before updating the dataslot values. If the value of the dataslot passed on by the event is invalid, then the dataslot update fails.

- **COMPLETE_WORKSTEP**: This event can only update the values of the dataslots (of the type listed in Table 38: Supported dataslots on page 134) added to the monitoring workstep. This event triggers the completion of the monitoring workstep, only after updating the dataslot values. If the value of the dataslot passed on by the event is invalid, then the dataslot update fails.

**Note:** The UPDATE_DATASLOT and COMPLETE_WORKSTEP events cannot update the EIID value.

To add a dataslot to a monitoring workstep:

1. From the **Properties** view of the workstep (external activity or adapter), click the **Dataslots** tab.
2. Click **Add** to open the **Select Dataslots** dialog box, which lists all the user-defined dataslots in the monitoring process.

**Note:** You must add only editable dataslots to a monitoring workstep.

3. Select the dataslot to be added, then click **OK** to add the dataslot to the table provided in the **Dataslots** tab.
Defining workstep presentation format

Business Process Modeler allows you to change the presentation format of Start and Activity worksteps. The presentation formats available are:

- **Portal:**
  - **Auto-generated:** This is the default HTML presentation form, automatically generated at runtime in Business Process Portal.
  - **Custom:** Enables you to define a customized Java Server Page (JSP).
- **Flow:** Available only for BPM processes. Enables you to start and design a Web application from a BPM process.
- **Flow (private):** Available only for BPM processes. This is the same as the Flow format but can be used only in the process template in which it is placed.

In OpenEdge 11.7, the Form Editor has been removed from BPM projects. In earlier releases, the Form Editor enabled you to design a customized interface with *Form* as the presentation format for Activity worksteps (and for Start worksteps in Business Processes). This format in the **Portal** presentation type has been removed for both Business Processes and Web applications.
When you import an existing BPM Processor Web application that has worksteps with Form as the presentation format into OpenEdge 11.7, the worksteps are not affected as long as their presentation type is not modified. Modifying their presentation type and changing the current presentation format overrides the current format as it is not supported in OpenEdge 11.7, and you will NOT be able to use the imported forms. You can choose to continue or cancel the action in the confirmation message that appears while modifying the presentation type.

**Note:** When importing existing BPM projects, ensure that you build the projects before importing them into OpenEdge 11.7.

**Note:** You can use Kendo UI® Builder by Progress® (Kendo UI Builder) to create new forms in OpenEdge 11.7. In Progress Developer Studio, click Help > Samples to find the KUIB sample app in the Samples page.

- **Mobile:** Available only for BPM processes. Enables you to complete an activity workstep (in a BPM process) on a Mobile device.
- **GUI:** Available only for BPM processes. Enables you to complete an activity workstep from a GUI for .NET desktop application.
- **Tablet:** Available only for BPM processes. Enables you to complete an activity workstep on a Tablet.
- **Other:** Available only for BPM processes. You choose Other to complete an activity workstep using an interface other than the options listed above. For example, if you want to complete an activity workstep on an iPad, you select Other as the presentation type for the activity in BPM process.

This chapter describes how to define presentation (or interface) forms for Process Models. Similar to Process Models, you can define the look and feel of the presentation pages for Activity worksteps in Web applications. For Web applications, you cannot change the presentation format for the Start workstep.

After you have developed a Web application, you can view it as a series of presentation pages (or interfaces) in your Web browser by entering the appropriate URL. For example, to view the BarChartDemo Web application, enter the following URL:

```
http://<machine_name>.<domain_name>:<port_number>/sbm/BPM Workflow/BarChartDemo/Start.jsp
```

For details, see the following topics:
- Defining workstep presentation

### Defining workstep presentation

You can change the look and feel of the presentation pages for Start or Activity worksteps in Business Process or Web application. OpenEdge BPM Designer allows you to add multiple presentation types such as Portal, Mobile, GUI, and Tablet to a single activity workstep. This enables you to complete an activity from a browser, a Mobile device, a GUI for .NET application, or a Tablet device.

**Note:** The presentation types Mobile, GUI, Tablet, and Other are available only for BPM processes.

**To define the presentation format:**
1. Click the Start or Activity workstep in the process template to display its properties in the **Properties** view.

2. From the **General** tab, do one of the following:
   - Click the **ellipsis** button beside the **Presentation** box for an activity in a Web application.
   - Click the **Add** button from the **Presentation** section for an activity in a BPM process.
   
   The **Add Presentation** dialog box appears.

3. Select the presentation type option from the **Type** drop-down list. The options are: Portal, Mobile, GUI, Tablet, and Other for BPM process models. For Web applications, the presentation type is selected as Portal in the **Type** drop-down list and is disabled.

4. Select the presentation format option from the **Form Type** drop-down list. The options are: Auto-generated, Custom JSP, Flow, and Flow (private) for BPM process models. For Web applications, the options are: Auto-generated and Custom.

   **Note:** The **Form Type** drop-down is not available when you select the Mobile, GUI, Tablet, or Other from the **Type** drop-down list.

5. Modify (if required) the presentation name in the **Name** box. You cannot specify a name for the Auto-generated format.

   Alternatively, you can map worksteps (with Custom JSP and Flow presentations) to CHARACTER dataslots to dynamically associate the workstep with a JSP file or a Web application respectively. You need to set the initial value of the CHARACTER dataslot to a Web application (*.BIZSOLO) or a valid JSP file (existing in the `<project_name>/jsp` folder). This feature is not available for Web applications.

   a) From the **Form Type** drop-down list, select the appropriate option. The available options are **Custom JSP**, **Flow**, and **Flow (private)**. The **Form Type** drop-down is not available for Mobile, GUI, Tablet, or Other as the presentation types.

   b) Click the **ellipsis** button beside the **Name** or **URL** text field, then select **Use a Dataslot** option to display the **Add Dataslots** dialog box. Select the CHARACTER dataslot to be mapped to the workstep presentation, then click **OK** to add the dataslot in the **Name** or **URL** text field.

6. Click **OK** to return to the **Properties** view.

   **Note:** You cannot add the same presentation type twice to one activity workstep. If you do, an error message appears stating that the **Presentation Type already exists. Do you want to override?**. Click **OK** to override the presentation type.

For more details regarding each of the presentation formats available for Process Models, refer to **Table 39: Presentation Format for BPM project components** on page 140.
Table 39: Presentation Format for BPM project components

<table>
<thead>
<tr>
<th>Presentation Type</th>
<th>Presentation Format</th>
<th>See</th>
</tr>
</thead>
<tbody>
<tr>
<td>Portal</td>
<td>Auto-generated</td>
<td>Defining Auto-generated HTML presentations on page 140.</td>
</tr>
<tr>
<td></td>
<td>Custom</td>
<td>Defining custom presentations on page 140.</td>
</tr>
<tr>
<td></td>
<td>Flow</td>
<td>Using a Flow presentation on page 141.</td>
</tr>
<tr>
<td></td>
<td>Flow (private)</td>
<td>Using a Flow (private) presentation on page 142.</td>
</tr>
<tr>
<td>Mobile</td>
<td>-</td>
<td>Defining Mobile presentation on page 142.</td>
</tr>
<tr>
<td>GUI</td>
<td>-</td>
<td>Defining GUI presentation on page 143.</td>
</tr>
<tr>
<td>Tablet</td>
<td>-</td>
<td>Defining Tablet presentation on page 144.</td>
</tr>
<tr>
<td>Other</td>
<td>-</td>
<td>Defining Other presentation on page 145.</td>
</tr>
</tbody>
</table>

Defining Auto-generated HTML presentations

Business Process Modeler provides a default HTML presentation for Start and Activity worksteps, automatically generated at runtime in Business Process Portal. For instance, the Assignment sample application uses the auto-generated format.

Business Process Portal uses the Header options and dataslots specified in the workstep’s Properties view in Business Process Modeler. In addition to Header options that include the Instruction and Priority fields directly under the heading, Business Process Portal also displays fields corresponding to the read-only and editable dataslots specified in the Fields tab in the workstep’s Properties view. For example, the Task name, Assignee, Priority, Due Date, and Instructions boxes in the view are editable; that is, you can enter data in these fields and the data is passed on to the next workstep.

Defining custom presentations

The Custom presentation form for Process Models can be used with HTML forms to add custom JSP presentations. Like HTML presentations, the presentation of the JSP forms can be edited using an HTML editor that supports JSP tags. In addition, the logic part of the JSP (implemented in Java) can be modified to customize the content of the presentation using any text editor. For example, it is possible to add Java code to populate the content of a drop-down list from a database query.

If you select the Custom option in the Presentation dialog box in the Start or Activity worksteps properties, then Business Process Modeler creates a Java Server Page (JSP) workstep presentation.
Defining Flow presentations

You can use the Flow presentation (available only for Process Models) to execute a Web application without opening it from Business Process Portal. You need to only click on a link provided in the interface to launch a Web browser with this format. Business Process Modeler provides two Flow options in the Presentation dialog box:

- **Flow** starts a Web application from a workstep in the Process Model by redirecting the Web application to the BPM Workflow server (see Using a Flow presentation on page 141).

- **Flow (private)** creates a workstep that is restricted to the current process template and is not redirected to the BPM Workflow server. You must copy the files in the Web application to the webapp folder in Business Process Modeler. For more information, see Using a Flow (private) presentation on page 142.

Using a Flow presentation

You can define an Activity workstep (in a Process Model) with Flow presentation type to start a Web application. As this workstep runs in a Web browser, the Web application it calls must be published and installed.

To define and use a Flow presentation for a workstep:

1. From the General tab of the workstep's Properties view, click the ellipsis button beside the Presentation box to open the Presentation dialog box.
2. Select the Flow option from the Type drop-down list.
3. You can modify the name of the default Flow interface in the Name box. The default name is the name of the current workstep followed by the * .BIZSOLO extension.
   
   The .BIZSOLO extension indicates to the servlet that it should invoke the appropriate methods of the BPM Workflow server to get the URL for the BPM Workflow server and redirect the Web application to that page. The BPM Workflow server implements a dispatcher that takes as input the Web application name and produces the URL of the Start workstep of the Web application.

4. Alternatively, you can associate a dataslot with the Flow workstep. Click the ellipsis button beside the Name box, then select the Use a dataslot option to select the dataslot from the Use a Dataslot dialog box. Click OK to add the dataslot.
5. Click OK to define the Flow presentation format for this workstep.

After defining the presentation format of the workstep as Flow, you can now create the Web application.

6. Right-click the workstep with the Flow presentation, then click Open to launch the Open to WebApp dialog box.
7. Select either an existing web application (in Existing folder) or Web Application Project.
8. Click OK. If you select an existing web application (in Existing folder), the process template of this web application is displayed. Alternatively, if you select Web Application Project, the New Web application wizard is launched, using which you create a Web application.

**Note:** You can also check in the Flow presentation associated with a workstep to the Process repository, as described in Saving a process to the the process repository topic. After refreshing the Repository Browser, the process created from a Flow presentation is seen in the list of models under the Models tab.
Using a Flow (private) presentation

Unlike the Flow presentation type, the Flow (private) presentation type does not require you to publish and install the Web application in order to execute properly in its process template. Additionally, upon subsequent modifications to the input or output dataslots of the workstep in a Process Model with a Flow (private) presentation, the dataslots of the private flow are automatically updated to reflect the input and output changes in the workstep. This results in the automatic dataslot synchronization between Process Models and Flow (private) applications. Removing dataslots from the Process Model does not remove the corresponding dataslots in the Flow (private) application, but is interpreted as disassociating the dataslots in the Process Model from the dataslots in the Flow (private) application.

Important: If an application is used as a Flow (private) application in Process Modeler, then you cannot use it as a stand-alone Web (BPM Workflow) application; similarly, an installed Web (BPM Workflow) application cannot be used as a Flow (private) workstep.

To create a Flow (private) presentation for a workstep:

1. From the General tab of the workstep's Properties view, click the ellipsis button beside the Presentation box to open the Presentation dialog box.
2. Select the Flow (private) option from the Type drop-down list.
3. Modify, if required, the default name in the Name box. The default name is the name of the current workstep. Alternatively, you can associate a dataslot with the Flow (private) workstep. To do so:
   a) Click the ellipsis button beside the Name box.
   b) Select the Use a dataslot option to select the dataslot from the Use a Dataslot dialog box.
   c) Click OK to add the dataslot.
4. Click OK to define the presentation format for this workstep.
5. Right-click the workstep and click Open to open a Web application with the same name as the Flow (private) workstep.

The Flow (private) workstep is now confined to the current process template.

Defining Mobile presentation

You can define an activity workstep (in a BPM process) with presentation type as Mobile to complete the activity using a Mobile device. As the activity runs in a Mobile device, you must install a mobile app in the device. Then, you must map the mobile app's URL to the activity workstep (in a BPM process) to access the activity.

Note: You can build and install mobile apps using Progress Software’s Telerik Platform and you can access supported Progress data resources from mobile apps built in the Telerik Platform using Progress Data Services such as OpenEdge and Rollbase. For more information, see the Progress Data Services Guide and Reference, which you can reference from the http://clouddataobject.github.io/.

To define a Mobile presentation for an activity workstep:

1. Select an activity workstep in a BPM process for which you want to define the presentation type as Mobile.
2. From the Properties view, click the General tab to view the Presentation section.
3. Click Add to open the Add Presentation dialog box.
4. Select Mobile from the **Type** drop-down list.

5. Specify the mobile app file path or URL in the **URL** text field. For example, https://<host>:<port>/mobile/activity.html.

   Alternatively, you can map workstep with Mobile presentation format to CHARACTER dataslot to dynamically associate the workstep with a mobile app URL. You need to set the initial value of the CHARACTER dataslot to a valid mobile app URL.

   a) Click the **ellipsis** button beside the **URL** text field.
   b) Select **Use a dataslot** to open the **Add Dataslots** dialog box.
   c) Select a CHARACTER dataslot to be mapped to the workstep presentation.
   d) Click **OK** to add the dataslot and then close the **Add Dataslots** dialog box.

6. Click **OK** to add the Mobile presentation format for the activity workstep.

   **Note:** You cannot add the same presentation type twice to one activity workstep. If you do, an error message appears stating that the **Presentation Type already exists. Do you want to override?**. Click **OK** to override the presentation type.

   The Mobile presentation format is mapped to the selected activity workstep. The defined Mobile presentation type is displayed in the **Presentation** section.

   **Note:** You can add multiple presentation types such as Portal, Mobile, GUI, and Tablet to a single activity workstep. This enables you to complete an activity from a browser, a Mobile device, a GUI for .NET application, or a Tablet device.

---

### Defining GUI presentation

You can define an activity workstep (in a BPM process) with presentation type as GUI to complete the activity using a GUI for .NET desktop application. As the activity runs a GUI for .NET desktop application, you must develop a OpenEdge GUI for .NET application. Then, you must map the GUI for .NET application name (ABL class .cls filename) to the activity workstep (in a BPM process) to access the activity.

**Note:** For more information on developing OpenEdge GUI for .NET applications, see the *OpenEdge Getting Started: Introducing the Progress Developer Studio for OpenEdge Visual Designer* guide.

**To define a GUI for .NET presentation for a workstep:**

1. Select an activity workstep in a BPM process for which you want to define the presentation type as GUI.
2. From the **Properties** view, click the **General** tab to view the **Presentation** section.
3. Click **Add** to open the **Presentation Types** dialog box.
4. Select **GUI** from the **Type** drop-down list.
5. Specify an ABL class (.cls) file in the **Name** field. For example, *SampleApp.cls*.

   Alternatively, you can map workstep with GUI presentation format to CHARACTER dataslot to dynamically associate the workstep with an ABL .cls filename. You need to set the initial value of the CHARACTER dataslot to a valid ABL .cls filename.
a) Click the **ellipsis** button beside the **Name** text field.
b) Select **Use a dataslot** to open the **Add Dataslots** dialog box.
c) Select the CHARACTER dataslot from the **Add Dataslots** dialog box.
d) Click **OK** to add the dataslot and then close the **Add Dataslots** dialog box.

6. Click **OK** to add the Mobile presentation format for the activity workstep.

**Note:** You cannot add the same presentation type twice to one activity workstep. If you do, an error message appears stating that the **Presentation Type already exists. Do you want to override?**. Click **OK** to override the presentation type.

The GUI presentation format is mapped to the selected activity workstep. The defined GUI presentation type is displayed in the **Presentation** section.

**Note:** You can add multiple presentation types such as Portal, Mobile, GUI, and Tablet to a single activity workstep. This enables you to complete an activity from a browser, a Mobile device, a GUI for .NET application, or a Tablet device.

---

**Defining Tablet presentation**

You can define an activity workstep (in a BPM process) with presentation type as Tablet to complete the activity using a Tablet device. As the activity runs in a Tablet device, you must install a mobile app in the device. Then, you must map the mobile app’s URL to the activity workstep (in a BPM process) to access the activity.

**Note:** You can build and install mobile apps using Progress Software’s Telerik Platform and you can access supported Progress data resources from mobile apps built in the Telerik Platform using Progress Data Services such as OpenEdge and Rollbase. For more information, see the **Progress Data Services Guide and Reference**, which you can reference from the [http://clouddataobject.github.io/](http://clouddataobject.github.io/).

**To define a Tablet presentation for an activity workstep:**

1. Select an activity workstep in a BPM process for which you want to define the presentation type as Tablet.
2. From the **Properties** view, click the **General** tab to view the **Presentation** section.
3. Click **Add** to open the **Add Presentation** dialog box.
4. Select Tablet from the **Type** drop-down list.
5. Specify the mobile app file path or URL in the **URL** text field. For example, `https://<host>:<port>/tablet/activity.html`.

   Alternatively, you can map workstep with Tablet presentation format to CHARACTER dataslot to dynamically associate the workstep with a mobile app URL. You need to set the initial value of the CHARACTER dataslot to a valid mobile app URL.
   a) Click the **ellipsis** button beside the **URL** text field.
   b) Select **Use a dataslot** to open the **Add Dataslots** dialog box.
   c) Select a CHARACTER dataslot to be mapped to the workstep presentation.
   d) Click **OK** to add the dataslot and then close the **Add Dataslots** dialog box.

6. Click **OK** to add the Tablet presentation format for the activity workstep.
**Defining Other presentation**

You can define an activity workstep (in a BPM process) with presentation type as Other to complete the activity using a device other than the defined presentation types such as Portal, Mobile, GUI, or Tablet.

**To define a Tablet presentation for an activity workstep:**

1. Select an activity workstep in a BPM process for which you want to define the presentation type as Other.
2. From the **Properties** view, click the **General** tab to view the **Presentation** section.
3. Click **Add** to open the **Add Presentation** dialog box.
4. Select Other from the **Type** drop-down list.
5. Specify the filename in the **Other** text field.

Alternatively, you can map workstep with Other presentation format to CHARACTER dataslot to dynamically associate the workstep with a file. You need to set the initial value of the CHARACTER dataslot to a valid file that you want to use to complete the activity.

   a) Click the **ellipsis** button beside the **URL** text field.
   b) Select **Use a dataslot** to open the **Add Dataslots** dialog box.
   c) Select a CHARACTER dataslot to be mapped to the workstep presentation.
   d) Click **OK** to add the dataslot and then close the **Add Dataslots** dialog box.

6. Click **OK** to add the Other presentation format for the activity workstep.

**Note:** You cannot add the same presentation type twice to one activity workstep. If you do, an error message appears stating that the *Presentation Type already exists. Do you want to override?*. Click **OK** to override the presentation type.

The Other presentation format is mapped to the selected activity workstep. The defined Other presentation type is displayed in the **Presentation** section.

**Note:** You can add multiple presentation types such as Portal, Mobile, GUI, and Tablet to a single activity workstep. This enables you to complete an activity from a browser, a Mobile device, a GUI for .NET application, or a Tablet device.
Using alerts

Business Process Modeler provides the Alerts functionality for process models, which you can define and associate with selected worksteps. Using Alerts, you can notify application users in BPM Portal of a predefined event, such as change in the status of a process instance or in case of an exceptional condition being satisfied. In Business Process Modeler, you can use the Alerts tab to define a pool of alerts that can be associated with selected worksteps. These alerts can be associated with selected worksteps using the Alerts tab in the workstep’s Properties view, at various transition points (such as, “On activation” and “When completed”) during execution of the process.

The associated alerts appear in Business Process Portal under the My Alerts tab when, for example, a specific workstep is activated or when it is completed. Each alert must contain a message. Alerts can be assigned to one or more specified recipients or they can be triggered by a particular condition. For information on managing alerts in Business Process Portal, see the Business Process Portal User’s Guide.

For details, see the following topics:

• Reviewing the Alerts tab
• Defining an alert
• Associating an alert with a workstep

Reviewing the Alerts tab

You can view the "default" alert and define new alerts in the Alerts tab of the Modeler interface.

Click the Alerts tab for a new process model to view the All Alerts section, which contains all the alerts available to the process template.
You can perform the following operations in the **Alerts** tab:

**Table 40: Alerts tab operations**

<table>
<thead>
<tr>
<th>Operation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Define an alert</td>
<td>See <em>Defining an alert</em> on page 148.</td>
</tr>
<tr>
<td>Remove an alert</td>
<td>Select the alert to be removed, then click <strong>Remove</strong>. You cannot remove the &quot;default&quot; alert.</td>
</tr>
<tr>
<td>Modify existing alerts</td>
<td>Select the alert to be modified, then modify its properties in the respective sections of the <strong>Alerts</strong> tab.</td>
</tr>
<tr>
<td>Filter the alert list</td>
<td>Enter text in the <strong>type filter text</strong> box to filter the alert list and display all alerts whose names contain the matching letters.</td>
</tr>
<tr>
<td>Group (or ungroup) the alert list</td>
<td>By default, all alerts are grouped under alert severity categories, namely, Critical, High, Medium, and Low. To ungroup the alert list, click the <strong>No Grouping</strong> icon in the <strong>All Alerts</strong> section. To group the performer list under severity categories, click the <strong>Group by Severity</strong> icon in the <strong>All Alerts</strong> section.</td>
</tr>
<tr>
<td>Collapse the alert list</td>
<td>Click the <strong>Collapse All</strong> icon.</td>
</tr>
</tbody>
</table>

**Defining an alert**

You can define new alerts in the **Alerts** tab.

**To define an alert:**

1. Load the Process Model (**SPT**) for which you want to define the alert.
2. From the **Alerts** tab, click **Add**.
   
   The **New Alert** wizard appears.

3. From the first page of the **New Alert** wizard, you can specify the alert name, severity, and description of the alert.
   
   a) Type the name of the alert in the **Name** box. The name can only include alphanumeric characters and underscore ("_" ). Do not start the alert name with a numeric character. The name for an Alert should not exceed 64 characters.
   
   b) Select an option from the **Severity** drop-down list; options are: Critical, High, Medium, and Low. The **Severity** indicates to the alert recipients the urgency with which they should respond to the Alert.
   
   c) Enter a description (optional) of the alert in the **Description** box. This will enable other users of the application in Progress Developer Studio for OpenEdge to determine the intent of the alert.

4. Click **Next**. From the second page of the **New Alert** wizard, you can define a condition that activates the alert when the condition is satisfied.
a) To define an alert condition, click **Condition** to open the **Condition** dialog box.

b) Select a datatag from the drop-down list on the left. Only CHARACTER, INTEGER, INT64, LOGICAL, and DATETIME-TZ datatag types are listed.

c) Select an operator. To complete defining the condition, select a datatag from the drop-down list on the right or enter a value.

d) To add another condition, click ![+] and select **And** or **Or** option from the drop-down list. To remove a condition, click ![−].

e) Click the **Advanced** option to go to the advanced mode where you can create a condition by adding specific datatags or by entering (or copy-paste) a condition.

f) To verify the expression’s validity, click **Validate** in basic or advanced mode, and the “Validation successful” message appears.

5. Click **Next**. You can use the third page of the **New Alert** wizard to specify the alert message.

   In the **Message** box, enter the content of the message that you want the alert recipients to see when they open the Alert. You can enter static or dynamic values in the message. For dynamic values, you can use datatags (${dataslot_name} or ${@System_datatag})). Press CTRL+SPACE to view the list of datatags in the process. Select the datatag to be added and press ENTER to add the datatag in the **Message** box. For example, a message reading “Vacation request of ${days} has been filed by ${@CREATOR}” will use the days datatag (a datatag in the User category) and the @CREATOR datatag (a System category datatag) to obtain dynamic values for the number of days and the name of the person who filed the vacation request at runtime.

   **Note:** If you use a System datatag, it must be prefixed with “@”.

6. Click **Next** to define the recipients of the alert.

   a) Click **Add** to open the **Performer** dialog box, which lists performers of type, “User” and “Group” (group of sub-type, "All") in the process.

   **Note:** You cannot add queues, groups of type "Any," or comma-separated lists of multiple performers as alert recipients.

   b) Select a single (or multiple) performer and click **OK** to assign your selected user or group as the alert recipient.

   To delete a recipient, select the recipient and click **Remove**.

7. Click **Finish** to add the defined alert to the **Alerts** tab.

**Associating an alert with a workstep**

After defining the alert in the **Alerts** tab, you must associate the alert with a workstep at various workstep transition points (such as, “On activation” and “When completed”) during execution of the process. You can associate an alert with a Start, End, Activity, Adapter, or Subprocess workstep. In the case of the Start workstep, you can associate the alert only on completion of the workstep.

**To associate an alert with a workstep:**
1. From the workstep’s Properties view, open the Alerts tab.
   The Alerts tab displays the On Activation and When Completed sections. For the Start workstep, the When Completed section is only displayed.

2. To associate the alert with the workstep when the workstep is initially activated, add the alert to the table in the On Activation section.
   To associate the alert when the workstep is completed, add the alert to the table in the When Completed section.

3. Click Add to display the Add dialog, which lists all the available Alerts.
   a) Select an Alert from the drop-down list provided.
   b) Select the Send SMS check box, if you want to send the alert message as an SMS to the alert recipients. The alert message is sent to the recipient's phone number, as registered on Business Process Portal.

   **Note:** To enable using SMS for sending alerts, the Business Process Server property oebps.sms.enable must be set to TRUE in the oebps.conf configuration file. In addition, you can set the oebps.sms.failonerror property to TRUE for suspending a workstep when SMS sending fails. The oebps.conf file is located in the OEBPS_HOME\conf directory.

   Before you use the SMS option, you must update the oebpssms.properties file in the OEBPS_HOME\conf directory with the SMS gateway provider details.

The Alert is added to the table in the Properties view.
Configuring and running simulation

Business Process Modeler provides the Simulation project (see Creating a simulation project on page 37), which you can use to configure and run simulation for multiple processes. The Simulation project is implemented using a new simulation engine and is detached from the process workflow. You can perform simulation activities like defining and configuring scenarios, execution, and generating reports and analysis, using the new simulation perspective in Business Process Modeler.

Business Process Modeler provides two perspectives namely, Progress OpenEdge BPM Simulation perspective (for configuring simulation parameters) and the OpenEdge BPM Run Simulation perspective (for monitoring the simulation run and then generating simulation reports).

The Simulation perspectives provides:

• **Faster Testing for Design Flaws**: Allows you to quickly uncover potential problems in a process design. Instead of using a testing environment that requires two servers—one for production and one for testing—to create and test instances of the process, you can run a process in the Simulation perspectives as many times as required.

• **Estimated Cost of Resources**: Enables you to estimate the cost of the process, or the number of resources that the process will consume. You can define consumable (or single usage) resources (such as, equipment, electricity, and paper) and non-consumable (or reusable) resources (such as, computer and printer) at the process level to calculate the total estimated cost of the process.

• **Utilization of Business Calendar**: Allows you to set performer availability as defined in the organization-level business calendar. For details regarding business calendar, see Working with Business Calendar on page 185.

• **Identification of Bottlenecks**: Assigns worksteps to performing resources; for example, users or user groups for Activity worksteps. The simulation engine locks a performing resource during the execution of the workstep and releases it when the workstep is completed. Bottlenecks occur when another workstep needs the same performing resource, and must wait for the performing resource to be released from the previous workstep. Until then, the task for the next workstep is placed in a waiting queue. The simulation
engine keeps track of the number and status of instances in the waiting queues and indicates when a bottleneck occurs, that is, when a workstep has to wait for a performing resource to be released.

- **Randomization**: Supports two types of randomization techniques: randomizing the intervals between process instances; or randomizing the duration of work time for a specific workstep in the process. Business Process Modeler provides four probability distribution types: Constant distribution, Negative Exponential distribution, Normal distribution, and Uniform distribution.

For details, see the following topics:

- Adding a process model
- Exploring the Progress OpenEdge BPM Simulation perspective
- Configuring a simulation scenario
- Performing other operations
- Running a process simulation
- After completion of simulation

## Adding a process model

You can add a completed process to a simulation project from the Business Process Modeler perspective.

1. Open the Process Model (*.SPT) to be added to the simulation project.
2. From the Modeler toolbar, click **Start Simulation** icon ( ).
3. If the current project has been added as a process to a simulation project, then the **Simulate** dialog box appears, which lists the simulation projects containing the Process Model.

   For a Process Model that has not been added to a simulation project, the **New Simulation Project** wizard (Creating a simulation project on page 37) appears, using which you can create a new simulation project (as described in Creating a simulation project on page 37) and add the current project as a process.

4. From the **Simulate** dialog box, select an existing simulation project or **BPM Simulation Project** option to add the Process Model to a new simulation project.
5. Click **OK**.

## Exploring the Progress OpenEdge BPM Simulation perspective

The Progress OpenEdge BPM Simulation perspective in the Business Process Modeler interface provides a central location where you can view or edit all the simulation parameters for each of your simulation scenarios. This section describes the Progress OpenEdge BPM Simulation perspective user interface.

The commonly used panes and views in the Progress OpenEdge BPM Simulation perspective are described in the following table.
### Table 41: Progress OpenEdge BPM Simulation Perspective components

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project Explorer View</td>
<td>The Project Explorer displays the contents of active projects, including the Simulation project. It consists of a hierarchical view of all the files that make up the active project.</td>
</tr>
</tbody>
</table>
| Simulation Control Editor (or Simulation controller) | The Simulation Control editor contains the following three sections.  
  - **Scenarios**, to add and remove scenarios. For details, see Adding a scenario on page 154.  
  - **Processes**, to add (or remove) processes. It also displays the current processes, performers, and resources in the project. You can view (and edit) the properties for added scenarios, as well for each individual process (and its worksteps), connector, path, performer, and resource in the **Properties** view.  
  - **Controls**, which contains controls to start, stop, pause, exit the simulation run, as well as set the speed of the simulation. For operations, see Running a process simulation on page 167.                                                                                                                                                                                                                                        |
| Properties view                                 | Allows you to view (an edit) the properties for a selected item in the Simulation Control Editor. You can define (or edit) properties for the current simulation project, as well as for each of the added processes, worksteps, paths, performers, and resources. You can define the objectives for each of these components (see Defining objectives on page 163) and manage resources (see Managing resources on page 162).                                                                                                                                                                  |
| Processes view                                  | Consists of a **Process** tab for each of the added processes. Each Process tab comprises of the:  
  - **Show Process** drop-down list, which lists the current process and inline subprocesses (if any). For information regarding inline subprocess, see Defining an inline subprocess on page 101.  
  - **Diagram** view, which displays the process template diagram.                                                                                                                                                                                                                                                                                   |

### Configuring a simulation scenario

Business Process Modeler creates a single “default” scenario for each simulation project. You can add scenarios to the simulation project and configure simulation settings for each scenario independently. You can also import and export scenario information between simulation projects. After running simulation for each scenario, you can compare the results of the selected scenarios.

Configuring a simulation scenario consists of:

- **Simulation configuration**: includes setting the simulation start (and stop) date and time. For details, see Modifying simulation settings for a scenario on page 154.

- **Process configuration**: includes configuring simulation properties for each process (simulation start and stop date and time, number of instances, randomization method) and for each process workstep (specifying worktime with time deviation method, specifying the resources, specifying the probabilities in case of multiple outgoing links and for Decision gateway).
• **Performer and Resource configuration**: includes setting the cost of each workstep performer, as well as defining consumable and non-consumable resources and their properties.

• **Objectives definition**: includes setting simulation objectives for the process, workstep, path, and for the usage of performers and resources.

**Note:** Any process or resource that you add in the Simulation perspective, is independent of simulation scenarios.

The following sections describe how to add a scenario, configure simulation properties for individual scenarios, and import and export scenario information.

**Adding a scenario**

Business Process Modeler enables you to create simulation scenarios in which you can change resources, the size of a group, the probabilities out of Decisions, and other simulation parameters.

To define a new scenario:

1. From the Scenarios section in the Simulation Control Editor, click the **Add** icon ( ) to open the **Add Scenario** dialog box.
2. Enter a name for the scenario in the **Name** box. This is mandatory.
3. From the **Using scenario** drop-down list, select any of the existing scenarios to be used as a template for the new scenario. Resources, as well as processes and performers, defined in the scenario used are provided in the new scenario.
4. Click **OK** to add the new scenario to the Scenario drop-down list. Create as many additional scenarios as required.

   To remove the scenario displayed in the Scenario drop-down list, click .

**Modifying simulation settings for a scenario**

You can modify the simulation settings for the default scenario, as well as for any added scenarios. By default, any scenario created (see the preceding section) as a copy of the “default” scenario has the same simulation start and stop time as the default scenario.

To modify the simulation settings for a particular scenario:

1. From the Scenarios drop-down list in the Scenarios section (in the Simulation Control Editor), select the scenario to be configured.
2. From the Processes section, click the current simulation project (in this case, **TestSim**). In the Properties view, the **General** tab displays the details (name, label, and description) of the current simulation project.
3. Click the **Scenario** tab to view the simulation settings (including simulation start time and end time) for the selected scenario (as described in Step in Creating a simulation project on page 37 section). Modify the settings, as required.
4. From the Objectives tab, add the objectives for the selected scenario. For details, see Defining objectives on page 163.
5. From the Calendar tab, you can view the project calendar settings configured for the current scenario (as described in Step in Creating a simulation project on page 37 section). Modify the settings, as required.
Importing and exporting a scenario

You can import and export scenario information between simulation projects using the Simulation Control Editor. You can also import scenario real-time data from the server. Importing and exporting scenario information enables you to:

- Modify scenario information using any XML Editor, independent of Business Process Modeler.
- Replace the current scenario settings with the imported scenario information, thus eliminating the need to configure each parameter in the scenario.

Exporting a scenario

To export scenario information to a simulation scenario file (*.SSF):

1. From the Scenarios drop-down list in the Scenarios section (in the Simulation Control Editor), select the scenario to be exported.
2. Click the Export current scenario information ( ) icon to open the Export To dialog box.
3. Modify the default file name, if required, then click Save to save the *.SSF file in the Workspace_Home\<Application_Name>\exports folder.

Importing a scenario

You can import scenario information to the current scenario:

1. From the Scenarios drop-down list in the Scenarios section (in the Simulation Control Editor), select the scenario to be replaced.
2. Click the Import information into current scenario ( ) icon to open the Import Scenario Data wizard.
3. From the first page of the Import Scenario Data wizard, use either of the following sources from which you want to import data.
   - Select the Local file option to import scenario data from the local *.SSF file, then click Next.
     a) From the Import file details page, click the ellipsis button beside the Select file box, then select the *.SSF file containing the required scenario information.
     b) Click Finish to import the selected scenario information to your simulation project.
   - Select the Server (Real-Life) option to import real-time scenario information from the server, then click Next.
     a) Specify the server IP address and port number in the respective boxes.
     b) Enter the user name and password required to connect to the server.
     c) Modify (if required) the start date and end date in the Start Date and End Date boxes by clicking the adjoining ellipsis button. For details, see Specifying a date on page 166. Data of all the process instances that have been completed in this date range (between start and end date) are retrieved from the server.
     d) Click Connect to verify the connection to the server.
     e) Click Next to display the Scenario Difference Page.

   The left pane of the Scenario Difference page displays the simulation-related components of the current scenario including the added processes (and their individual worksteps), subprocesses (if any), performers, and resources. This structure is similar to the Processes section of the Simulation Control Editor.
f) Click any component to view the difference in the current and real-time data in the table provided in the right pane.

Table 42: Real-time data table on page 156 describes each column in the real-time data table.

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Displays the simulation-related properties for the selected component. For example, instance count, duration, randomization type, and start time for a process.</td>
</tr>
<tr>
<td>Old Value</td>
<td>Displays the current value.</td>
</tr>
<tr>
<td>New Value</td>
<td>Displays the real-time value. Once imported, this value replaces the old value.</td>
</tr>
</tbody>
</table>

Note: After running the simulation, you can also generate a real-time comparison report which compares the result of a simulation run with the server real-time data. For more information, see Generating Real-time Comparison Report on page 176.

Configuring simulation parameters for a process

You can use the Processes section in the Simulation Control Editor to add processes as well as configure simulation parameters for each of the added processes and its worksteps. You can also configure simulation properties for each of the workstep paths in the process.

To add and configure simulation parameters for each process for a particular scenario:

1. From the Processes section, click the Add ( ) icon to open the Required Project Selection dialog box, which lists the current projects in Business Process Modeler.

2. Click the project to be added, then click OK.

The selected process is added to the list of processes under the Processes folder. To remove a process from the simulation project, select the process from the list of processes, then click . You cannot remove a subprocess.

Note: In case you modify the process template after adding the process to the simulation project, select the process, then click the Refresh ( ) icon to reflect the changes made in the added process. You need to reconfigure the simulation settings for any process workstep, which has been impacted by the change.

3. From the Scenarios drop-down list in the Scenarios section (in the Simulation Control Editor), select the scenario to be configured.

4. Expand the Processes folder, and then click the process (for instance, Process1) whose simulation properties you want to configure. In the Properties view, the General tab displays the process details (name and label) of the selected process. You cannot modify any information in this tab.
5. Click the **Instances** tab to view the simulation settings (process start time, instances, and randomization type) for the selected process, as configured when adding the process in the **New Simulation Project** wizard (Creating a simulation project on page 37). Modify (if required) the settings, as described in Step b in Creating a simulation project on page 37 section.

**Note:** In a simulation project with multiple processes, if you do not want to include a particular process in the simulation run, enter “0” as the process instance count.

**Note:** The **Instances** tab does not appear for Subprocesses.

6. From the **Objectives** tab, add the objectives for the selected process. For details, see Defining objectives on page 163.

7. Use the **Calendar** tab to include calendar restrictions for the current process. For details, see Setting calendar on page 164.

Alternatively, you can view the entire list of added processes and subprocesses in a tabular format by clicking the **Processes** folder in the **Processes** section of the Simulation Control Editor. You can add, modify, or delete a main process by clicking the appropriate button.

You can also configure simulation properties for each workstep in the process and for each of the workstep paths and connectors, as described in the following sections.

### For worksteps

You can configure simulation settings for individual worksteps in a process. Workstep configuration is applied to the selected scenario only.

1. From the **Scenarios** drop-down list in the **Scenarios** section (in the Simulation Control Editor), select the scenario to be configured.

2. Expand the **Processes** folder, then expand the process (for instance, Process1). Expand the Worksteps folder to display the list of contained worksteps.

3. Click the workstep to be configured. Alternatively, you can click the workstep in the **Diagram** view.

   In the **Properties** view, the **General** tab displays workstep details including name and label. You cannot modify any information in this tab. The rest of the subtabs vary depending on the type of the selected workstep, and are described in Table 43: Configuring a workstep on page 158.
### Table 43: Configuring a workstep

<table>
<thead>
<tr>
<th>Workstep type</th>
<th>Tabs in the Properties view</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Activity/ Adapter/ Subprocess worksteps</strong></td>
<td>Task</td>
<td>For an Activity or Adapter workstep, review the workstep performer in the <strong>Performer</strong> box. From the <strong>Time Distribution</strong> section (available only for Activity worksteps), you can modify randomization method for workstep instances (see Choosing a randomization method on page 165). <strong>Note:</strong> You cannot configure the worktime distribution for an adapter workstep. By default, it is set to 1 second. For an Activity workstep with a Timeout link, use the <strong>Timeout</strong> section to enable the workstep timeout functionality. You can specify the timeout duration in terms of hours, minutes, and seconds in the respective boxes. For a Subprocess workstep, select the <strong>Using worktime</strong> option and specify the randomization method for the workstep instances in the <strong>Worktime Distribution</strong> section.</td>
</tr>
<tr>
<td><strong>Task</strong></td>
<td>Probability</td>
<td>Allows you to configure the probability setting for worksteps with multiple outgoing links. For details, see Setting the probabilities on page 160.</td>
</tr>
<tr>
<td><strong>Task</strong></td>
<td>Objectives</td>
<td>Allows you to add objectives for the workstep (example, the total completion time for all instances of the workstep must not exceed 10 hours). For details, see Defining objectives on page 163.</td>
</tr>
<tr>
<td><strong>Task</strong></td>
<td>Resources</td>
<td>Allows you to add resources (consumable and non-consumable) and the quantity likely to be consumed for this workstep. For non-consumable resources, you cannot specify a consumption count more than the available count.</td>
</tr>
<tr>
<td><strong>Start/ End workstep</strong></td>
<td>Objectives</td>
<td>Allows you to add objectives for the workstep (example, the total count of workstep instances created must exceed 10). For details, see Defining objectives on page 163.</td>
</tr>
<tr>
<td><strong>Decision gateway</strong></td>
<td>Probability</td>
<td>Allows you to configure the probability setting for the default link and the conditional link. For details, see Setting the probabilities on page 160.</td>
</tr>
<tr>
<td><strong>Other Gateway types</strong></td>
<td>Objectives</td>
<td>Allows you to add objectives for the particular gateway. For details, see Defining objectives on page 163.</td>
</tr>
</tbody>
</table>

Alternatively, you can configure (or modify) simulation settings for worksteps by clicking the **Workstep** folder for the selected process in the **Processes** section of the Simulation Control Editor.
The Properties view displays the **Activity Worksteps** section table (containing all the activity worksteps), **Adapter Worksteps** section table (containing adapter worksteps), **Decision Worksteps** section table (containing decision gateways), **Inline Worksteps** section table (containing inline subprocess worksteps), **Subprocess Worksteps** section table (containing subprocess worksteps), and **Other Worksteps** section table (containing additional worksteps such as Start and End). You can modify the simulation settings for any workstep by selecting it and then clicking the adjoining **Modify** button.

**For connectors**

You can use workstep connectors to configure a delay between the connecting worksteps. This introduces a time delay between workstep instance creation during the simulation run. This configuration is applied to the selected scenario only.

**To configure a connector delay:**

1. From the Scenarios drop-down list in the Scenarios section (in the Simulation Control Editor), select the scenario to be configured.
2. Expand the Processes folder, and then expand the process (for instance, Process1). Expand the Connectors folder to display the list of workstep connectors.
3. Click the connector to display the connector properties in the Properties view. In the Properties view, the General tab displays connector details including name, label, type (default or conditional) as well as the names of the connecting worksteps. You cannot modify any information in this tab.
4. Use the Delay tab to configure the connector delay.
   - From the Delay Distribution section, choose a method of randomizing the duration of delay between workstep instances in the simulation. For information regarding randomizing methods, see Choosing a randomization method on page 165.

**For paths**

A simple process consisting of a couple of Activity worksteps with Start and End worksteps, has an isolated path from start to completion. A complex process (for instance, a manufacturing system) can have a network of paths providing multiple routes between the same two locations. For such cases, Business Process Modeler provides path analysis functionality in order to determine the shortest path or the least expensive path.

You can define paths for individual processes in a simulation project. You can configure these added paths differently for different scenarios.

---

**Note:** A defined path must contain more than one Activity workstep.

**To define a path:**

1. Expand the Processes folder, and then expand the process (for instance, Process1).
2. Click Paths to display the Paths table in the Properties view.
   - This table displays the list of defined paths for this project. You can add new paths, and modify or delete existing paths.
3. Click Add to open the Path dialog box.
4. Enter the name and a brief description of the path in the Name and Description boxes respectively.
5. The **Available Choices** section displays a list of all the elements contained in the process. Select the element that denotes the starting location of your path, then click the **Move Left** (👈) icon to add the element to the **Current Path** section. The **Successors** section on the right, now displays the elements following the added element in the process.

6. Continue adding elements to build the path.

   To delete a path element, select the element in the **Current Path** section, then click 🗑️. You can only remove the last added element. To reset the path elements, click 🔄.

7. After building the path, click **OK** to add the path to the **Paths** table in the **Properties** view.

8. After you define a path, expand the **Paths** folder for this process to view the added path. Click the path to view the path properties in the **Properties** view, where you can modify the path properties, as well as define objectives. To define path objective for a particular scenario:
   a) Select a scenario from the **Scenario** drop-down list in the Simulation Control Editor.
   b) Click the added path to be configured.
   c) From the **Objectives** tab of the **Properties** view, add the objectives for the selected path. For details, see **Defining objectives** on page 163.

### Setting the probabilities

You can use the **Probability** tab in the **Properties** view to review or change probability settings for:

- Activity worksteps with multiple outgoing links.
- Activity worksteps with a defined loop condition (see **Defining a Loop condition** on page 115).
- Decision gateways.

**To configure the probability settings for any of these worksteps:**

1. Select a scenario from the **Scenario** drop-down list in the Simulation Control Editor.
2. Click the Activity workstep or Decision gateway to be configured, then click the **Probability** tab in the **Properties** view.

**Note:** To perform this operation, you need to understand how to configure multiple links originating from a workstep. For details, see **Using multiple links** on page 45.

The Probability tab displays the **Default** bar, which represents default links with no specified condition. Additionally, it may display the following bars:

- **Conditional** bars, which represent links with a specified condition.
- **Looping** bar (only for Activity worksteps), if the workstep contains a loop condition.
- **Compensation** bar (only for Activity worksteps), which represents links with a compensation flow.

The sum of the Probability values (on the right side) always equals 100%.
3. You can modify the probability value of all bars, except the Default bar. Use your cursor to move any of the probability bars to the right or left, or specify a value in the adjoining box. This automatically adjusts the value in the Default bar.

4. For worksteps with multiple conditional links, you can also add a Multiple Condition bar, which represents a condition when multiple conditional links are executed (that is, when the condition in all the links are satisfied).

Note: You cannot add a multiple condition bar for an Exclusive Decision gateway.

a) Click Add to open the Conditional links dialog box, which displays all the conditional links from the workstep.

b) Click the conditional link to be added. Press CTRL, and then click the other conditional link to be added. You need to select at least two conditional links to enable the OK button.

c) Click OK to add a multiple condition bar to the Probability tab. You can now adjust the probability value for this bar, as explained in Step 3.

To remove a multiple condition bar, select the bar and then click Remove. You cannot remove any of the other probability bars.

Managing performers

You can define the simulation properties for the assigned performers using the Performers section in the Simulation Control Editor. You can review (or modify) the settings for human performers (individual and group) and adapter performers. Performer configuration is applied to the selected scenario only.

To configure simulation settings for a performer:

1. From the Scenarios drop-down list in the Scenarios section (in the Simulation Control Editor), select the scenario to be configured.

2. From the Processes section in the Simulation Control Editor, expand Performers to display four subfolders namely, Systems (containing any adapter performers), Individuals (containing single human performers), Groups (containing a group of human performers), and Queues (containing any queue performers).

   In case you add (or modify) groups in the User Management tool after adding the process (containing the group performer) to the simulation project, select the Groups folder, then click the Refresh icon to reflect the changes made in the group members.

3. Expand these folders to view the respective performers assigned to the worksteps in the processes added to this project.

4. Click each performer to review the current performer information in the Properties view.

   • For an Adapter performer, review the name of the performer in the General tab. Enter a number (greater than 0) in the Limit box to specify the maximum number of times you want to invoke the adapter. Enter an amount (greater than 0) in the Cost box that provides a value for the cost per adapter invocation. Use the Objectives tab to add objectives for the performer, as described in Defining objectives on page 163.

   • For an individual performer, review the name of the performer in the General tab. Enter the hourly cost for the performer in the Per Hour box. Use the Objectives tab to add objectives for the performer, as described in Defining objectives on page 163. Use the Calendar tab to add calendar restrictions for the performer, as described in Setting calendar on page 164.
• The Properties view is similar for group and queue performers. Review the name of the performer in the General tab. In the Members tab, select the From User Management option to configure the performer settings as defined in the User Management tool. Alternatively, select the Virtual option to enter a virtual group size in the Number of Members box and the hourly cost of each group member in the Cost (per Hour) box. You need to specify a minimum virtual group size more than or equal to 1.

**Note:** The From User Management option is only enabled for groups and queues existing in the User Management tool and containing group members. For more information, see Managing groups on page 182 and Managing queues on page 183.

**Note:** You can use the Calendar tab to add calendar restrictions for the group or queue performer, as described in Setting calendar on page 164.

Alternatively, you can configure (or modify) simulation settings for performers by clicking the Performers folder in the Processes section of the Simulation Control Editor.

The Properties view displays the Individual Performers section table (containing individual performers), System Performers section table (containing adapter performers), Group Performers section table (containing group performers), and Queue Performers section table (containing queue performers). You can modify the simulation settings for any performer by selecting it and then clicking the adjoining Modify button.

**Tip:** You can also click any of the four subfolders under the Performers folder (in the Simulation Control Editor) to view and modify the simulation settings for the respective performer type.

### Managing resources

You can define resources independent of any process or scenario. Resources are any expendable items, but do not include personnel. Business Process Modeler supports two types of resources, namely:

• **Consumable** resources: These are the resources that are used up during the simulation and may typically include either Services (such as electricity, gas) or Supplies (such as paper, staples). These resources are usually modeled either as a function of time or associated with an event, such as the completion of an operation.

• **Non Consumable** resources: These are shared resources with multiple activities waiting for the same resource. These type of resources are most likely to affect system performance, as they may cause bottlenecks. An example of a non-consumable resource is machinery.

**To define a new resource (consumable or non-consumable):**

1. From the Processes section in the Simulation Control Editor, expand Resources to display the Consumables and NonConsumables folders.

2. Click each of the respective folders to display the Consumables or the Non Consumables table in the Properties view. This table displays the list of defined resources for this project. You can add new resources, modify existing resources, and delete resources from the respective Properties view.

3. Click Add in the respective Properties view to open the Consumable Resource dialog box, or the Non Consumable Resource dialog box.
a) For a consumable resource, enter the appropriate data in the **Name**, **Unit**, and **Cost** boxes. The name of the resource cannot contain any blank spaces. Data entered in the Unit box must contain only alphabetic characters.

b) For a non-consumable resource, enter the appropriate data in the **Name**, **Availability**, and **Cost** boxes. Enter a number in the Availability box, which indicates the quantity of the resource that can be shared.

4. Click **OK** to save the resource and add it to the respective table in the **Properties** view.

5. After you define a resource, expand the **Consumables** or **NonConsumables** folder (in the Simulation Control Editor) to view the added resources. Click the resource to view the resource properties in the **Properties** view.

   a) From the **General** tab, modify (if required) the respective resource properties.

   b) From the **Objectives** tab, add the objectives for the selected resource. For details, see the following **Defining objectives** on page 163 section.

Alternatively, you can view the entire list of added resources in a tabular format by clicking the **Resources** folder in the **Processes** section of the Simulation Control Editor.

The Properties view displays the **Consumable Resources** section table (containing list of consumable resources) and **Non Consumable Resources** section table (containing list of non-consumable resources). You can add, modify, or delete a consumable or non-consumable resource by clicking the appropriate button.

### Defining objectives

Business Process Modeler allows you to define objectives, which helps achieve goals for optimum time, cost, and resource utilization. You can define objectives at process, workstep, and path levels, as well as for defined performers and resources. Any violation of these objectives during simulation execution are listed in the **Violations** view in the Simulation perspective.

Business Process Modeler provides a predefined set of properties for objectives. You can define a condition for these properties, whose values are set according to cost, count or a time duration.

**To define an objective:**

1. Type the name of the objective in the **Name** box.

2. From the **Condition** drop-down list, select the operator. The available options are: == (equal to), != (not equal to), < (less than), > (greater than), <= (less than or equal to), and >= (more than or equal to).

3. In the adjoining text box, enter the condition value in terms of a number (for count- or cost-based objectives) or in terms of hours, minutes, and seconds (for duration-based objectives).

   *Table 44: Predefined properties* on page 163 provides the complete list of predefined properties and their description.

<table>
<thead>
<tr>
<th>Property name</th>
<th>Available for</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Completion Duration</td>
<td>Simulation project only</td>
<td>Sets the duration for the complete simulation.</td>
</tr>
<tr>
<td>Created instances count</td>
<td>Process and workstep</td>
<td>Sets the number of instances created for a process or workstep.</td>
</tr>
<tr>
<td>Completed instances count</td>
<td>Process and workstep</td>
<td>Sets the number of completed instances for a process or workstep.</td>
</tr>
<tr>
<td><strong>Property name</strong></td>
<td><strong>Available for</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>--------------------------------</td>
<td>-------------------------------</td>
<td>--------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Terminated instance count</td>
<td>Process and workstep</td>
<td>Sets the number of instances terminated for a process or workstep.</td>
</tr>
<tr>
<td>Aggregate completion time</td>
<td>Process and workstep</td>
<td>Sets the total completion time of all instances of a process or workstep.</td>
</tr>
<tr>
<td>Average completion time</td>
<td>Process and workstep</td>
<td>Sets the average completion time of all instances of a process or workstep.</td>
</tr>
<tr>
<td>Total Task Count</td>
<td>Individual Performer</td>
<td>Sets the total count of tasks performed by the performer.</td>
</tr>
<tr>
<td>Total Task Duration</td>
<td>Individual Performer</td>
<td>Sets the total duration of tasks performed by the performer.</td>
</tr>
<tr>
<td>Total Cost</td>
<td>Performer and Resource</td>
<td>Sets the total cost of a performer or resource.</td>
</tr>
<tr>
<td>Average Cost per Task</td>
<td>Individual Performer</td>
<td>Sets the average cost of a performer for each completed task.</td>
</tr>
<tr>
<td>Total Utilization</td>
<td>Individual Performer and Resource (Non-consumable)</td>
<td>Sets the utilization value of a performer or a non-consumable resource.</td>
</tr>
<tr>
<td>Total Count</td>
<td>Resource (consumable)</td>
<td>Sets the total count for a consumable resource.</td>
</tr>
<tr>
<td>Average Cost</td>
<td>Resource (Non-consumable)</td>
<td>Sets the average cost of a non-consumable resource.</td>
</tr>
<tr>
<td>Total Invocations</td>
<td>Adapter Performer</td>
<td>Sets the number of adapter invocations.</td>
</tr>
<tr>
<td>Traversal Count</td>
<td>Path</td>
<td>Sets the total count for traversing a path.</td>
</tr>
<tr>
<td>Summed Traversal Time</td>
<td>Path</td>
<td>Sets the total time for traversing a path for all process instances.</td>
</tr>
<tr>
<td>Average Traversal Time</td>
<td>Path</td>
<td>Sets the average time for traversing a path for all process instances.</td>
</tr>
</tbody>
</table>

The defined objective is added to a table in the **Objectives** tab of the **Properties** view in the Simulation perspective. You can also modify or remove the objective from the table by clicking the respective buttons.

**Setting calendar**

Business Process Modeler enables you to set calendar restrictions for each project added to your simulation project, as well as for each human performer (individual and group) and queue performer in your simulation project.

You can use the **Calendar** tab in the **Properties** view for the process or performer to configure the calendar restriction.
You can select any of the following options to configure calendar settings:

- **None** (without any calendar restrictions)
- **User management** to include calendar restrictions as specified in the calendar created using the Business Calendar tool, as discussed in Working with Business Calendar on page 185.
- **Project** to include calendar restrictions as specified in the project calendar for the current simulation project.
- **Local** to configure process-specific calendar settings using the **Workdays** and **Sessions** sections provided. This operation is similar to configuring the project calendar, as discussed in Step in Creating a simulation project on page 37 section.

### Performing other operations

This section describes commonly used simulation-related operations such as selecting a randomizing method and selecting a date.

### Choosing a randomization method

Business Process Modeler supports two types of randomization in the Simulation perspective; namely, randomizing the time of intervals between process instances; or randomizing the duration of work time for a specific workstep in the process.

- To randomize the time interval between process instances, use the **Instances** tab of the **Properties** view for a process, as described in Step 5 in Configuring simulation parameters for a process on page 156 section.
- To randomize the work time for a specific workstep instance, use the **Task** tab of the **Properties** view for a Activity, Adapter, or Subprocess workstep, as described in Step 3 in For worksteps on page 157 section.

Business Process Modeler provides four probability distribution types, which are described below:

**Table 45: Probability distribution types**

<table>
<thead>
<tr>
<th>Distribution Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Constant</td>
<td>Use this option to maintain the same interval between instances in the simulation. You can define the mean interval between instances in the adjoining boxes in terms of hours, minutes, and seconds. This is used when the duration is fixed, and does not change over time.</td>
</tr>
<tr>
<td>Negative Exponential</td>
<td>A continuous probability distribution that is often used to characterize the time between events or the durations of activities. It does not assume a predetermined pattern of distribution. A Negative Exponential distribution is used when the probability decreases over time.</td>
</tr>
<tr>
<td>Distribution Type</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Normal</td>
<td>Use this option to define the symmetrical, bell-shaped distribution pattern that is often used for a simulation. This distribution pattern is determined by its mean and the standard deviation. You can use the adjoining <strong>Mean</strong> and <strong>Std-dev</strong> boxes to set the mean and standard deviation in terms of hours, minutes, and seconds. In a typical normal distribution, 70% of results fall between one standard deviation above and one standard deviation below the mean. The standard deviation is a measure of how tightly items are clustered around the mean in a set of data. A low standard deviation means that the results are tightly clustered; a high number that the distribution is widely spread. <strong>Note:</strong> If the Standard Deviation setting is more than the Work Time value for a workstep and results in the range of the deviation being a negative value, then only the absolute value of the deviation (not the negative value) is used for running the simulation.</td>
</tr>
<tr>
<td>Uniform</td>
<td>A discrete uniform distribution option that represents a uniform distribution pattern within a finite set of possible values. The possible values are set within the minimum and the maximum value specified in hours, minutes, or seconds. This is used when the process instance count (or the worktime duration of a workstep instance) is fixed over a specified range of values.</td>
</tr>
</tbody>
</table>

**Specifying a date**

You can enter (or modify) a date (and time) in the **At time** box for a Date, for instance, when specifying the simulation start and stop time for a simulation project and for process worksteps.

**To specify the date and time:**

1. Select the **At time** option (if you are specifying a date for the first time) to display the current system date and time in the adjoining text box.
2. To specify another date (or time), click the **ellipsis** button beside the **At time** option to open the **Calendar** dialog box, which display the current month’s calendar. By default, the calendar highlights today’s date and current time.
3. To select a date from the displayed month, click the desired date.
4. To display the calendar for another month, use the arrows provided beside the month. Click the arrow pointing right for the next month, or the arrow pointing left for the previous month. Alternatively, to select any other month, you can click on the current month and then select the desired month from the list.
5. Similarly, to display the calendar for another year, click the current year and then type the desired year. Alternatively, you can use the adjoining controls to increment (or decrement) the year by one. Click outside the year control to accept the changed year.
6. To change the default time from the **Time** box, click the hour, minute, and second boxes and type the respective values. Alternatively, you can use the adjoining controls to increment (or decrement) the respective value. You can also use these controls to switch between **AM** and **PM**.
7. Click **OK** to display the selected date and time in the text box beside the **At time** option.
Running a process simulation

After designing the process simulation in the Progress OpenEdge BPM Simulation perspective, you can run the simulation in the OpenEdge BPM Run Simulation perspective to discover potential design flaws. For example, you can now quickly identify such problems as loops that repeat too frequently or bottlenecks in the process.

Each simulation run represents a simulation for a set of resources. It could have single or multiple processes running in parallel.

The commonly used panes and runtime views in the OpenEdge BPM Run Simulation perspective are described in the following table.

Table 46: OpenEdge BPM Run Simulation Perspective components

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
</table>
| Simulation Control Editor (or Simulation controller) | The Simulation Control editor contains the following additional sections.  
  • **Simulation Status**, which displays the progress status of the simulation project.  
  • **Generate**, to view the results of a simulation run for a scenario and to generate a report, as described in Generating a simulation report on page 173. |
| Individuals view | Allows you to view the runtime performance of the individual human performers (including group members) during the simulation run. Performance parameters include total task count and usage time, total cost, and cost per hour for the defined performers. |
| Systems view | Allows you to view the runtime performance of the system (or adapter) performers during the simulation run. Performance parameters include cost per invocation, number of invocations, and total cost for system performers. |
| Consumables view | Allows you to view the consumable resource usage during the simulation run. |
| NonConsumables view | Allows you to view the non-consumable resource usage during the simulation run. |
| Violations view | Allows you to view any violations in the defined objectives after completion of the simulation run. |
| Recommendations view | Lists any workstep bottlenecks due to non-availability of performers and resources after the completion of the simulation run, and recommends a possible solution for the same. |
| Processes view | Consists of a **Process** tab for each of the added processes. Each Process tab comprises of the:  
  • **Diagram** view, which displays the process template diagram, and indicates the status of each workstep across all instances during the simulation run.  
  • **Details** view: You need to click Details to display this view. For details, see Viewing process information on page 168. |

To run a process simulation:
1. From the Scenarios drop-down list in the Scenarios section (in the Simulation Control Editor), select the scenario for which you want to run the simulation.

2. From the Controls section of the Simulation Control Editor, click \(\text{play}\) to begin the process simulation.

3. If you are currently not in the OpenEdge BPM Run Simulation perspective, then Business Process Modeler prompts you to switch to this perspective. Click Yes to run the process simulation in the OpenEdge BPM Run Simulation perspective. Alternatively, click No to run the process simulation in your current perspective. If you select the Remember my decision checkbox, then Business Process Modeler does not display any prompt and executes your selected command the next time you run a process simulation.

**Note:** You can modify the above selected configuration for running the process simulation using the Simulation > UI page in the Preferences dialog box. For information, see Using the Simulation page on page 78.

During the simulation run, you can perform any of the following operations from the Controls section of the Simulation Control Editor:

**Table 47: Simulation controls**

<table>
<thead>
<tr>
<th>Control</th>
<th>Operation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pause ( (\text{pause}) )</td>
<td>To pause the simulation. Click (\text{play}) to resume the simulation.</td>
</tr>
<tr>
<td>Stop ( (\text{stop}) )</td>
<td>To stop the simulation and return to the start of the simulation.</td>
</tr>
<tr>
<td>Exit ( (\text{exit}) )</td>
<td>To stop the simulation and exit from the OpenEdge BPM Run Simulation perspective. Process Modeler prompts you to switch to the Progress OpenEdge BPM Simulation perspective. You can click the appropriate button, similar to as described in Step 3 above.</td>
</tr>
<tr>
<td>Speed control</td>
<td>To control the simulation speed between low and high.</td>
</tr>
</tbody>
</table>

You can view the overall progress of the simulation project in the Simulation Status section.

The Start date and time displays the Simulation Start setting, as configured for this scenario in the Scenario tab of the Properties view (see Modifying simulation settings for a scenario on page 154). The Current date and time indicates the progress of the simulation in date and time values, with its final value calculated according to the Simulation Stop setting, as configured for this scenario in the Scenario tab of the Properties view.

During the simulation run, you can view the process-related information in the Processes view (as described in the following Viewing process information on page 168 section).

You can also monitor the usage of performers and resources, as well as review objective violations and performance bottlenecks (and recommendations) in their respective views. For details, see Viewing project information on page 170.

**Viewing process information**

The Processes View consists of a Process tab for each of the added process in the simulation project. Click each Process tab to view the simulation information for the process in the Diagram and Details views. By default, the Details view is hidden. To show (or hide) either of the views for each Process tab, click the respective button in the Processes view.
The **Details** view displays the progress status of the completed process instances during the simulation run. It also displays the instance count (required, completed, created, terminated), the workitem cost (total, average, minimum, maximum), and the duration (total, average, minimum, maximum) of the completed process instances. The adjoining table contains the:

- **Worksteps** tab, which lists the worksteps of the current process and the number of workstep instances, which have been created, activated, completed, terminated, and timed out, along with the total, average, maximum, and minimum duration taken to complete the instances.

- **Workitems** tab, which lists the workitem tasks for each instantiated workstep, along with number of workitems completed, the total worktime for each workitem, and the cost (total, minimum, maximum, average) for completing each workitem. Additionally, this tab displays the number of tasks waiting in queue for the performer to become available, with the total, minimum, maximum, and average waiting time.

- **Connectors** tab, which lists the workstep connectors of the current process and the number of connector traversals, which have been created, completed, and terminated, along with the total completion and termination duration taken for each connector.

- **Consumables** tab, which indicates the consumption details of consumable resources for each assigned workstep. Resource details for each workstep include cost per unit, workitem count, consumption count, and total cost.

- **Non Consumables** tab, which indicates the consumption details of non-consumable resources for each assigned workstep. Resource details for each workstep include cost per hour, workitem count, requirement, usage time, and total cost.

- **Paths** tab, which displays information for each defined path in the process. Path information includes path name, the number of times the path was traversed, and the duration (total, minimum, maximum, average) of path traversal. Additionally, this tab displays the cost (total, minimum, maximum, average) of traversing a path. For details regarding paths, see **Configuring simulation parameters for a process** on page 156 > **For paths** on page 159.

Additionally, the **Details** view displays simulation information for the current process in the following sections:.

### Table 48: Details View information

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Count</td>
<td>Displays the same data as in Process Status section, but in numeric values. Additionally, it displays the number of terminated process instances.</td>
</tr>
<tr>
<td>Cost</td>
<td>Displays the cost data for workitem tasks (or instantiated worksteps). Cost includes the cost of workitem performers and resources (if any). The <strong>Total</strong> cost indicates the total completion cost of all workitems, the <strong>Average</strong> cost indicates the average cost of workitems, the <strong>Minimum</strong> cost indicates the least expensive workitem, and the <strong>Maximum</strong> cost indicates the most expensive workitem.</td>
</tr>
<tr>
<td>Completed Instance Time</td>
<td>Displays the duration of completed process instances in terms of hours, minutes, and seconds. The <strong>Minimum</strong> value indicates the shortest completion time, the <strong>Maximum</strong> box indicates the longest completion time, and the <strong>Average</strong> box indicates the average completion time for process instances. The <strong>Total</strong> value indicates the cumulative completion time for all instances.</td>
</tr>
</tbody>
</table>

Additionally, each Process tab contains the following components:

- **Show Process** drop-down list, where you can also view the runtime data for an inline subprocess by selecting the process. For information regarding inline subprocess, see **Defining an inline subprocess** on page 101.
Contains the **Status** progress bar, which indicates the total number of process instances required, along with the number of instances created and completed. The total number of process instances required are depicted in light green color, those created (and in progress) in olive green, and those completed in bluish green. You can also move your pointer over the progress bar, to view the same information in numeric terms.

In the **Diagram** view (which is displayed by default), each process workstep displays a number in parenthesis, which indicates the number of activated instances.

Each workstep (and associated path) displays a color-coded heatmap, which enables you to:

- Determine the number of activations for each workstep, relative to the rest of the worksteps in the workflow.
- Identify potential bottlenecks in the process.

**Table 49: Heatmap color coding** on page 170 describes the color coding used for heatmaps.

<table>
<thead>
<tr>
<th>Color Gradient</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Blue to White</td>
<td>For workstep activations from minimum to median value(^2).</td>
</tr>
<tr>
<td>White to Red</td>
<td>For workstep activations from median(^a) to maximum value.</td>
</tr>
</tbody>
</table>

A bottleneck can be identified by a red-colored workstep immediately followed by one or more white-colored worksteps.

**Tip:** When unexpected results occur during a simulation, such as the number of activations of a workstep not matching the number of instances, it may result in the presence of Inclusive Decisions. We recommend that you use Exclusive Decisions in this type of process.

### Viewing project information

The **OpenEdge BPM Run Simulation** Perspective provides additional views—**Individuals**, **Systems**, **Consumables**, **NonConsumables**, **Violations**, and **Recommendations**—where you view overall simulation information, independent of the processes. Click the **Individuals**, **Systems**, **Consumables**, and **NonConsumables** views after starting the simulation run. Click the **Violations** and **Recommendations** views after completing the simulation run (as described in **After completion of simulation** on page 173).

- **Individuals** view: indicates the utilization of individual (or human) performers in the process, and the current task (if any) for each performer.

\(^2\) Median is calculated by dividing the sum total of all activated workstep instances by the number of worksteps
The **Individuals** view displays the following runtime information of individual performers:

**Table 50: Individual performer information**

<table>
<thead>
<tr>
<th>Heading</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Displays the name of the performer. A blue icon indicates that the performer is available. A grey icon indicates that the performer is unavailable.</td>
</tr>
<tr>
<td>Cost per Hour</td>
<td>Displays the cost per hour defined for each performer.</td>
</tr>
<tr>
<td>Available For</td>
<td>Displays the total duration (in terms of hours, minutes, seconds) for which this performer is available.</td>
</tr>
<tr>
<td>Total Cost</td>
<td>Displays the total cost of the performer, which is the product of the hourly cost of the performer and the total time (in hours) for which the performer is available.</td>
</tr>
<tr>
<td>Task Count</td>
<td>Displays the number of tasks currently assigned to this performer.</td>
</tr>
<tr>
<td>Total Usage Time</td>
<td>Displays the total work-time (in terms of hours, minutes, seconds) for this performer.</td>
</tr>
<tr>
<td>Utilization %</td>
<td>Displays the percentage of the total usage time of the performer, relative to the available time.</td>
</tr>
</tbody>
</table>
| Current Tasks    | Indicates the current task (if any) performed by this performer. The format used is: `<processname>-<taskname>`.

**• Systems** view: indicates the utilization of system (or adapter) performers in the process, and the current task (if any) for each performer.

The **Systems** view displays the following runtime information of adapter performers:

**Table 51: Adapter performer information**

<table>
<thead>
<tr>
<th>Heading</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Displays the name of the adapter performer. A blue icon indicates that the performer is available. A grey icon indicates that the performer is unavailable.</td>
</tr>
<tr>
<td>Cost per Invocation</td>
<td>Displays the cost per invocation as defined for each adapter.</td>
</tr>
<tr>
<td>Invocations</td>
<td>Displays the total number of invocations of this adapter.</td>
</tr>
<tr>
<td>Total Cost</td>
<td>Displays the total cost of the adapter, which is the product of the cost per invocation and the number of invocations.</td>
</tr>
<tr>
<td>Current Tasks</td>
<td>Indicates the current task (if any) performed by this adapter. The format used is: <code>&lt;processname&gt;-&lt;taskname&gt;</code>.</td>
</tr>
</tbody>
</table>

**• Consumables** view: displays the utilization of consumable resources in the simulation run for this scenario.
The **Consumables** view displays the following runtime information of consumable resources:

**Table 52: Consumable resource information**

<table>
<thead>
<tr>
<th>Heading</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Displays the name of the resource used.</td>
</tr>
<tr>
<td>Cost per Unit</td>
<td>Displays the cost of resource as defined for this scenario.</td>
</tr>
<tr>
<td>Consumer Count</td>
<td>Displays the total number of workstep instances that have used this resource.</td>
</tr>
<tr>
<td>Consumed Count</td>
<td>Displays the total number of the resource units consumed.</td>
</tr>
<tr>
<td>Total Cost</td>
<td>Displays the total cost of the resource, which is the product of cost of the resource and the consumed count.</td>
</tr>
</tbody>
</table>

- **NonConsumables** view: displays the utilization of non-consumable resources in the simulation run for this scenario.

The **NonConsumables** view displays the following runtime information of non-consumable resources:

**Table 53: Non-consumable resource information**

<table>
<thead>
<tr>
<th>Heading</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Displays the name of the resource used.</td>
</tr>
<tr>
<td>Units</td>
<td>Indicates the number of available resource units.</td>
</tr>
<tr>
<td>Cost per Hour</td>
<td>Displays the cost of resource as defined for this scenario.</td>
</tr>
<tr>
<td>Required in Tasks</td>
<td>Displays the number of workstep (or task) instances that require this resource.</td>
</tr>
<tr>
<td>Requirement</td>
<td>Displays the total count of the resource required.</td>
</tr>
<tr>
<td>Used in Tasks</td>
<td>Displays the number of workstep (or task) instances that have used this resource.</td>
</tr>
<tr>
<td>Total Usage Time</td>
<td>Indicates the total duration (in hours, minutes, seconds) of consumption of the resource.</td>
</tr>
<tr>
<td>Total Cost</td>
<td>Displays the total cost of the resource, which is the product of cost of the resource and the total usage time.</td>
</tr>
</tbody>
</table>

After the simulation run is completed, all status indicators are green (for completed) and the **Exit Simulation** button is activated.
After completion of simulation

You can view the final status of the performers (individual and system) and resources (consumable and non-consumable) used during this process simulation, from the respective views. You can view any violations and recommendations by clicking the respective view, as described in this section.

- **Violations** view: lists violations (if any) in the objectives defined (see Defining objectives on page 163) in the current scenario.

The table provides the following violation information.

**Table 54: Violations**

<table>
<thead>
<tr>
<th>Heading</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source</td>
<td>Indicates the source whose objective has been violated. Possible sources are the simulation project, process, workstep, performer, resource, and path.</td>
</tr>
<tr>
<td>Name</td>
<td>Displays the objective that was violated.</td>
</tr>
<tr>
<td>Condition</td>
<td>Displays the condition defined in the violated objective.</td>
</tr>
<tr>
<td>Path</td>
<td>Displays the path to the source whose objective has been violated. This is applicable only for defined paths and worksteps (including worksteps of an inline subprocess). The format used is: <code>&lt;processname&gt;-&gt;&lt;source&gt;</code>.</td>
</tr>
</tbody>
</table>

- **Recommendations** view: lists bottlenecks and other problems encountered during the simulation run. An example of a bottleneck can be that a particular workstep had a high waiting time, before using a particular resource or performer.

The table provides the following information.

**Table 55: Recommendations**

<table>
<thead>
<tr>
<th>Heading</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source</td>
<td>Indicates the source where the problem has arisen.</td>
</tr>
<tr>
<td>Problem</td>
<td>Displays the description of the problem.</td>
</tr>
<tr>
<td>Recommendation</td>
<td>Displays the statement of a possible solution to the problem. For example, &quot;Increase resources used by work-step.&quot;</td>
</tr>
</tbody>
</table>

**Generating a simulation report**

After running a simulation for a scenario, you can generate a Simulation result (*.SRF) and report (*.HTML or *.XLS) files.

- **Result**: Only one result (*.SRF) file is generated for each simulation run, which could have a single process or multiple processes. You can use the result file later to generate simulation reports. You can also generate
comparison reports (see Comparing simulation results on page 176) by using multiple result files. For example, you can generate multiple result (*.SRF) files after simulating with different scenarios.

- **Report:** You can generate a simulation report in HTML or Excel format either directly after a simulation run or later from the result (*.SRF) file. You can select and create reports according to your requirement.

**To generate the Simulation report:**

1. From the **Generate** section of the Simulation Control Editor, click the **Result** ( ) icon to open the **Simulation Report** dialog box.
2. Modify (if required) the name of the default result file.
3. Click **OK** to save the result file.
   
   You can view the result file in the **Project Explorer** view in the `<project>\results` folder.
4. Right-click the result file (*.SRF), then click **Simulation Report > Generate Report**.
   
   Alternatively, from the **Generate** section of the Simulation Control Editor, click the **Report** ( ) icon to open the **Simulation Reports** dialog box. In this case, you do not need to generate the simulation result file, as discussed in Step 1 to Step 3.
5. Depending on your requirement, you can generate any of the listed report types. Click each report type to view its description in the adjoining area.
6. From the **Output** section, select the format (HTML or Excel) from the **Format** drop-down list. Modify (if required) the name of the generated file in the **File** box.
7. Select the report type to be generated, then click **OK**. The Simulation report is generated.
   
   The Simulation report (in HTML format) contains the main section in links, which you can click to navigate to the respective topic. Additionally, it displays the summary charts (only in HTML format) displaying the overall cost per process and cost per resource (and performer) used in the simulation project. For more information, see the following Viewing simulation report details on page 174 section.

**Note:** Simulation reports in Excel format do not display charts.

---

**Viewing simulation report details**

The generated Simulation report contains the following main sections:

- **Process simulation result** on page 174
- **Resource usage results** on page 175
- **Violations and recommendations** on page 175
- **Setting calendar** on page 164

**Note:** The simulation report is saved directly under the simulation project folder `Workspace_Home\<project_name>\reports\`.

---

**Process simulation result**

This section provides the following sub-sections for each of the added processes and subprocesses:
• **Instance Completion Status**: (Can be viewed in Basic, Cost, and Time reports also) Displays the total number of process instances required, created, completed, and terminated.

• **Instance Execution Time**: (Can be viewed in Basic and Time reports also) Displays the duration of the completed process instances, along with the minimum, maximum, and average time.

• **Instance Completion Cost**: (Can be viewed in Cost report also) Displays the total completion cost of all workitems, along with minimum, maximum, and average cost.

• **Workstep Execution Status and Time**: (Can be viewed in Basic and Time reports also) Displays the instance count (created, activated, completed, terminated, timed out) for each of the process worksteps, along with the duration (total, minimum, maximum, average) taken to complete all the workstep instances. You can view this information in Tabular and Chart format.

• **Workitems Time and Cost**: (Can be viewed in Cost and Time reports also) Displays the workitem count (created, completed, terminated) for each task, along with the completion cost (total, average, minimum, maximum) of each workitem. Additionally, this section displays the number of workitem instances, which waited in queue for the performer to become available, along with the total, minimum, maximum, and average waiting time. You can view this information in Tabular and Chart format (which displays the workitem status and total cost).

• **Workstep Connectors**: (Can be viewed in Basic, Cost, and Time reports also) Displays the instance count (created, completed, terminated) for each of the workstep connector, along with the aggregate delay duration taken to complete or terminate the connector traversals. You can view this information in Tabular format only.

• **Path Analysis Status and Execution Time**: (Can be viewed in Basic, Cost, and Time reports also) Displays the traversal count, the traversal duration (total, minimum, maximum, average), and traversal cost (total, minimum, maximum, average) for each defined path. You can view this information in Tabular and Chart format.

### Resource usage results

This section provides a usage summary for both performers and resources in the following sub-sections. You can view this section in Basic, Cost, and Time reports also.

• **Human Performers**: Displays the cost (hourly, total), duration available for, assigned task count, total usage time, and utilization percentage for each human performer. You can view this information in Tabular and Chart format.

• **System Performers**: Displays the number of invocations, cost (hourly, total), duration available for, assigned task count, total usage time, and utilization percentage for each system performer. You can view this information in Tabular and Chart format.

• **Consumable Resources**: Displays cost, consumed count, and consumer count for each consumable resource. You can view this information in Tabular and Chart format.

• **Non-consumable Resources**: Displays cost, required in tasks, requirement, used in tasks, and total usage time for each consumable resource. You can view this information in Tabular and Chart format (similar in format to that of Consumable resource).

### Violations and recommendations

This section lists all the violations and recommendations generated for the simulation run. You can view this section in the Violations and Recommendations report also.
Calendar

You can view this section in the Time report also. This section contains the following sub-sections:

- **Process Calendar**: Displays the calendar settings for each of the added processes. The calendar information includes calendar type, workdays, and details of the work sessions.

- **Human Performer**: Displays the calendar settings for each human performer (individual and group). The calendar information includes calendar type, as well as workdays and work sessions for simulation calendar type.

Comparing simulation results

You can generate a comparison report (HTML or Excel) from multiple result (*.srf) files, each of which represent the result of a simulation run. You can also generate a real-time comparison report to compare the results of a simulation run with the real-time server data. You can select the type of the comparison report, similar to that for simulation report types (Generating a simulation report on page 173).

**Note**: You need to create at least two results files, before you can generate a comparison report. You can also compare result files generated across simulation projects.

To generate a comparison report:

1. If you are in the **OpenEdge BPM Run Simulation** perspective, then click the **Simulation Configuration** perspective to switch to the **Progress OpenEdge BPM Simulation** perspective.

2. From the **Project Explorer** view, select the result (*.SRF) files (located in <project>esults folder), which you want to compare.

3. Right-click the selected result files, then select **Simulation Report > Generate Comparison Report** to open the **Simulation Reports** dialog box (see Generating a simulation report on page 173).

4. Depending on your requirement, you can generate any of the listed report types. Click each report type to view its description in the adjoining area. Select the report type to be generated.

5. From the **Output** section, select the format (HTML or Excel) from the **Format** drop-down list. Modify (if required) the name of the generated file in the **File** box.

6. Click **OK**. The comparison report is generated.

The comparison report includes a generated Result ID (Result 1, Result 2, and so on, depending on the number of result files being compared). Additional information includes the scenario used, the simulation run start (and stop) date and time, the simulation duration and the total cost for each of the Result IDs.

Additionally, the comparison report includes all the main sections of the corresponding simulation report as described in Viewing simulation report details on page 174. Each of the main and sub-sections includes data for all the generated Result IDs in a tabular format.

**Note**: The “Violations and Recommendations” section is included only in the Violation and Recommendation comparison report.

Generating Real-time Comparison Report

You can also generate a real-time comparison report (HTML or Excel) by comparing the result of a simulation run to the real-time data from a server.
To generate the real-time comparison report:

1. After performing a simulation run, click the **Realtime Report** icon from the **Generate** section of the Simulation Control Editor to open the first page of the **Realtime Comparison** wizard, which is similar to second page of the **Import Scenario Data** wizard.
   
   Alternatively, you can right-click a result file (*.SRF), then click **Simulation Report > Generate Realtime Comparison Report**.

2. To establish connection to your server:
   
   a) Specify the server IP address and port number in the respective boxes.
   
   b) Enter the user name and password required to connect to the server.
   
   c) Modify (if required) the start date and end date in the **Start Date** and **End Date** boxes by clicking the respective **ellipsis** button. For details, see **Specifying a date** on page 166.
      
      Data of all the process instances that have been completed in this date range (between start and end date) are retrieved from the server.
   
   d) Click **Connect** to verify the connection to the server.

3. Click **Next** to open the second page of the **Realtime Comparison** wizard, which lists the report type that you can generate.

4. Review the available report type and its description.

5. From the **Output** section, select the format (HTML or Excel) from the **Format** drop-down list. Modify (if required) the name of the generated file in the **File** box.

6. Click **Finish** to generate the realtime comparison report, which is similar to the comparison report.
Business Process Modeler provides the User Management tool, which allows you to add and manage users, groups, and queues, as well as view and update the organization hierarchy.

All the members created using the User Management tool, are available to newly created process templates in Process Models and can be assigned to Activity worksteps.

The User Management tool includes a Organization Chart Viewer, that enables you to view the specified organization as a hierarchy of users and groups.

For details, see the following topics:

- Types of members
- Starting User Management tool
- Printing organization chart
- Managing nodes

Types of members

The User Management tool supports three types of members, as described in Table 56: Member types on page 180.
### Table 56: Member types

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Users</td>
<td>Represents the basic entity of the user management tool. Typical attributes of a user include user name, real name, and title.</td>
</tr>
<tr>
<td>Groups</td>
<td>Represents a set of users performing related tasks, for instance, the HR group. Attributes include leader name and group members. A group can include another group.</td>
</tr>
<tr>
<td>Queues</td>
<td>Represents a set of users and groups.</td>
</tr>
</tbody>
</table>

## Starting User Management tool

You can start the User Management tool by clicking **Tools > Users**.

The User Management tool consists of two panes. The left pane displays a tree consisting of the member node types namely **Users**, **Groups**, and **Queues**. You can define members, which then appear under the respective node type (see Managing nodes on page 181).

You can also search for members using the Search box in the left pane. Click the down-arrow provided and select either of the following options:

- **Flat search**: This search provides a flat list of all matching members, containing the search text.
- **Tree search**: This search displays the result in a tree structure, indicating the node type and if present, its position in the organization hierarchy.

The right pane, by default, displays the Organization Chart Viewer initially with blank tree node. After adding users and groups, the viewer is automatically updated to display the organization hierarchy. Additionally, you can expand (and collapse) parts of the organization hierarchy, thus providing views at different detail levels.

The Organization Chart Viewer has the following features:

- Each expandable (or collapsible) node displays the group and the group leader (optional). The topmost node displays the organization name and the leader (optional). The title of the added user, if defined, is also displayed.
- You can double-click any node to view the user details.
- You cannot add (or remove) nodes directly from the Chart Viewer.
- Queues are not displayed in the Chart Viewer. The Chart Viewer only displays users and groups (including groups within a group).

**To customize the Organization Chart Viewer:**

1. In the **Organization Name** box (in the right pane), type the name of your organization.
2. To specify the organization leader, click the **ellipsis** button beside the **Leader** box to open the Select User dialog box, which displays a list of defined users (as described in Managing users on page 181).
3. Click the user from the list, then click **OK**. You can also use the **Search** box to search for a user.
4. Click **Apply** to add the organization name and the leader name to the blank topmost node in the Organization Chart Viewer. The organization name is also displayed and represents the root node in the left pane of the User Management tool.
Note: Henceforth, you can click the root node at any point of time, to view the updated Organization Chart Viewer.

Printing organization chart

You can also print the organization chart displayed in the Organization Chart Viewer.

1. Click File > Print chart to open the Print dialog box, which displays a print preview of the organization chart.
2. Modify the print settings, if required, then click Print.

Managing nodes

You can use the User Management tool to add users, groups, and queues as members in the respective member nodes. You can then use the defined members as performers in newly created process templates.

You can click any member node or member in the left pane to view the details screen in the right pane. Alternatively, you can double-click any node in the Organization Chart Viewer to display the member details.

Managing users

You can add (and manage) individual users from the User list.

1. Click Users node in the left pane, displaying the user list in the right pane.
   The user name and the real name is displayed by default. To hide (or show) either of the columns, right-click any column header and mark (or unmark) the appropriate options.
2. To create a user, click New to open the user details screen, where you can enter the following user details.

   Table 57: User information on page 181 describes each user information field.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Username</td>
<td>(Required) Enter the system name of the user. The username appears as the performer in your process template. You can also search for a user by entering the username in Search box in the User List screen.</td>
</tr>
<tr>
<td>RealName</td>
<td>Enter the full name of the user (example, David Brown). This name appears in the Organization Chart Viewer for this user. To display the user in the Chart Viewer, you need to add the user to a group.</td>
</tr>
<tr>
<td>Title</td>
<td>Enter the designation (or title) of the user in the organization. If specified, then the title also appears along with the real name in the Organization Chart Viewer.</td>
</tr>
<tr>
<td>E-mail</td>
<td>Enter a valid email address of this user.</td>
</tr>
</tbody>
</table>

3. After entering the user information, click OK to add the user to the user list. The user is also added as a member to the Users node in the left pane.

To remove a user (or multiple users) from the user list, select the users and click Remove. The User Management tool prompts you for confirmation. Click Yes to remove the selected users. To modify user details, select the user and click Modify to open the user details screen, where you can modify the user information.

**Managing groups**

You can add (and manage) groups from the Groups list.

1. Click Groups node in the left pane, displaying the group list in the right pane.

   The group name and label is displayed by default. To hide (or show) either of the columns, right-click any column header and mark (or unmark) the appropriate options.

2. To create a group, click New to open the group details screen, where you can enter the following group details.

   Table 58: Group information on page 182 describes the group detail fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group Name</td>
<td>(Required) Enter the name of the group. The group name appears as the group performer in your process template. You can also search for a group by entering the group name in Search box in the Group List screen.</td>
</tr>
<tr>
<td>Group Label</td>
<td>Enter the group label (example, Human Resources). This label appears as the group label in the Organization Chart Viewer for all added users.</td>
</tr>
<tr>
<td>Leader</td>
<td>Click the ellipsis button beside the Leader box to select a group leader. From the Select User dialog box, click the user to be selected as the group leader, then click OK.</td>
</tr>
<tr>
<td>Calendar</td>
<td>Click the ellipsis button beside the Calendar box to specify a calendar (if defined). This action includes the business calendar restrictions for the group members.</td>
</tr>
<tr>
<td>Group Members</td>
<td>Use this section to add the group members, as discussed in Adding group members on page 183.</td>
</tr>
</tbody>
</table>

3. Click OK to add the group to the groups list. The group is also added as a member to the Groups node in the left pane.
To remove a group (or multiple groups) from the groups list, select the groups and click **Remove**. The User Management tool prompts you for confirmation. Click **Yes** to remove the selected groups. To modify group details, select the group and click **Modify** to open the group details screen, where you can modify the group information.

### Adding group members

You can use the **Group Members** section to add group members that can include individual users and other groups.

**To add and configure a group member:**

1. Click **Add** to open the **Select Members** dialog box, which lists all the defined users and groups.
2. Click the member to be added, then click **OK** to add the member to the list of members.
   
   You can also search for a member using the **Search** box. To remove a member from the member list, select the user and click **Remove**.
3. You can also specify a role (optional) for the group member.
   
   a) Select the added member, then click **Role** to open the **Select Role** dialog box.
   
   b) Select an existing role from the drop-down list provided or enter a new role.
   
   c) Click **OK** to define the role for the group member.

### Managing queues

You can add (and manage) queues from the queue list.

1. Click **Queues** node in the left pane, displaying the queue list in the right pane.
   
   The queue name and label is displayed by default. To hide (or show) either of the columns, right-click any column header and mark (or unmark) the appropriate options.
2. To create a queue, click **New** to open the queue details screen, where you can enter the queue details.

   **Table 59: Queue information** on page 183 describes the queue information fields.

**Table 59: Queue information**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Queue Name</td>
<td>(Required) Enter the name of the queue. The queue name appears as the queue performer in your process template. You can also search for a queue by entering the queue name in <strong>Search</strong> box in the Queue List screen.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Queue Label</td>
<td>Enter the queue label. Queue labels do not appear in the Organization Chart Viewer.</td>
</tr>
<tr>
<td>Queue Members</td>
<td>You can use this section to add queue members that can include individual users and other groups. Click Add to open the Select Members dialog box, which lists all the defined users and groups. Click the member to be added, then click OK to add the member to the list of members. You can also search for a member using the Search box. <strong>Note:</strong> You cannot add another queue as the queue member. To remove a member from the member list, select the member and click Remove.</td>
</tr>
</tbody>
</table>

3. Click OK to add the queue to the queue list. The queue is also added as a member to the Queues node in the left pane.

To remove a queue (or multiple queues) from the queue list, select the queues and click Remove. The User Management tool prompts you for confirmation. Click Yes to remove the selected queues. To modify queue details, select the queue and click Modify to open the queue details screens, where you can modify the queue information.

**Importing users**

You can also import user information from a selected server.

1. Click File > Import to open the Import dialog box.

2. In the Server URL box, modify the URL (if required) of the server from where you want to retrieve user information. You cannot import user information from an LDAP Realm.

3. Click OK.
Working with Business Calendar

Business Process Modeler provides the Business Calendar tool, using which you can define an organization-level calendar and assign them to workstep performers for simulation projects. For details regarding usage of business calendar in the Simulation perspective, see Configuring and running simulation on page 151.

You can start the Business Calendar by clicking **OpenEdge > Tools > Calendars**.

For details, see the following topics:

- Using the Business Calendar tool

Using the Business Calendar tool

You can use the Business Calendar tool to add (and manage) calendars and schedules.

Managing calendars

You can perform the following operations to manage calendars.

- To add a calendar, click the Add (.addButton) icon from the Calendar tool, to add a calendar (example, “Calendar1”) to the Calendar drop-down list.

**Note:** Each added calendar (Calendar1, Calendar2, and so on) is a copy of the configuration set in the working schedule of the default calendar.
• To rename the added calendar, click the Rename (_rename) icon to open the Calendar name dialog box.
  1. Type the modified name of the calendar.
  2. Click OK to rename the calendar.

• To delete a calendar, select the calendar in the Calendar drop-down list, then click the Remove (_remove) icon.
  The Business Calendar tool prompts you for confirmation. Click OK to remove the selected calendar.

Note: You cannot rename nor delete the default calendar.

Managing schedules

You can create customized working schedules, which are independent of calendars. You can then apply a schedule to a single day, or a sequence of days, or even to all the days of the year. You can also apply a schedule to multiple calendars.

To define a schedule:

1. Click a single day of your calendar, or drag across consecutive days to open the Select Schedule dialog box, using which you can define (or select) a schedule.

2. Click the Add (_add) icon to add a schedule (example, “Schedule1”) to the Schedule drop-down list.

Note: Each added schedule (Schedule1, Schedule2, and so on) contains the original settings of the default schedule. Any changes made to the default schedule are not reflected when you add a schedule.

3. Enter a description for the schedule (example, “Recruitment Schedule”) in the Description box.

Note: You can rename the schedule by clicking the Rename (_rename) icon, to open the Schedule name dialog box, where you can enter the modified name. To delete a schedule, click the Remove (_remove) icon. You cannot rename nor delete the default schedule.

4. From the Workdays section, select (or clear) the appropriate checkboxes for the work days in this schedule. For the default schedule, Monday to Friday are marked as working days, with Saturday and Sunday designated as non-working days.

Note: To create a schedule for company holidays, clear all the checkboxes in the Workdays section.

5. The Workhours section displays two time segments namely, AM and PM. For the default schedule, the work-hours are 8-12 (in the AM segment) and 1-5 (in the PM segment). To manage work-hours:
   • Use the slider along the starting and ending time of each segment to change the default work-hours.
   • You can remove a work-hour segment by right-clicking on it, then clicking Remove.
   • You can also insert additional work-hour segments, by right-clicking a blank portion of the Workhours section, then clicking Insert.

The work-hours that you set is applied to all the working days selected in the Workdays section.
6. You can set different work-hours for single (or multiple) working days in the **Exceptions** tab.
   a) Select the checkbox for the working day whose work-hours you want to modify.
   b) Modify the work-hours, as described in Step 5.

7. Click **OK** to create and apply the schedule to the selected days of your calendar.

The selected days are highlighted by a color, which is unique and randomly selected for each customized schedule. Move your pointer over any highlighted day to view the name of the customized schedule.

**Overwriting a schedule**

You can overwrite a schedule for selected day (or days) with another schedule.

1. Drag across the calendar days, whose schedule is to be overwritten.
2. From the **Select Schedule** dialog box, select any schedule from the **Schedule** drop-down list.
3. Click **OK** to apply the schedule to the selected days.
Managing business objects

Business Process Modeler provides the Business Object Manager tool, which enables you to define and manage business objects. For each business object, you can add and manage attributes, where data is stored and accessed.

Business objects are fully interoperable, plug-and-play, distributed components that encapsulate traditional lower-level objects that implement a business process. In Business Process Modeler, business objects act as a collection of dataslots that can behave as a single, reusable unit. Business Objects also supports complex nested structures, including collection of other business objects. Using business objects, you can incrementally adjust business applications to fit your changing organizational needs, use them to rapidly build new applications entirely from reusable components, and dramatically reduce your development and maintenance costs.

For details, see the following topics:

• Using the Business Object Manager
• Using business objects in a link
• Using business objects in applications

Using the Business Object Manager

You can use the Business Object Manager tool to create and maintain business objects in the Process Repository. The stored objects can be persisted internally and externally.

To create and manage a business object:
1. Open a Process Model or Web application in Process Modeler.

2. From the Tools menu, click Business Objects to open the Business Object Manager dialog box, which displays the list of default business objects with category, "demo."

   **Note:** To modify an existing business object, select it from the Business Object Manager dialog box, then click Edit to make the changes in the Edit Business Object dialog box.

3. To create a new business object, click New to open the Create New Business Object dialog box.

4. Type the name of the business object in the Name box and select a category from the Category drop-down list. To define a category, click the ellipsis button beside the Category list, to open the New Category dialog box, where you can define a new category.

5. In the Data Source Reference box, enter the description of the datasource (if any) being referenced. In the Description box, enter a description of the business object. This information is optional and help users identify business objects.

6. To define attributes for the business object, click Add to open the New Attribute dialog box.

   a) Define the attribute properties by entering appropriate information in the available field components. Table 60: Defining business object attributes on page 190 describes each of the business object attributes.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the attribute. Attribute name must not contain any special characters, and can have up to 64 characters. You need to precede any upper-case character with at least two lower-case characters.</td>
</tr>
<tr>
<td>Type</td>
<td>The type of attribute. Options include CHARACTER, INT64, INTEGER, DECIMAL, LOGICAL, DATETIME-TZ, Java datatypes, and any business object that you have previously defined. <strong>Note:</strong> Business Process Modeler does not support business objects with circular reference. For example, if a business object, &quot;bo1&quot; contains the business object, &quot;bo2&quot; as an attribute, then &quot;bo2&quot; cannot contain &quot;bo1&quot; as an attribute.</td>
</tr>
<tr>
<td>Size</td>
<td>The size of the attribute. You can modify the size only for String type.</td>
</tr>
<tr>
<td>Default value</td>
<td>Enter (or modify) the default value for the attribute, if required. The default values are 0 (for Long), 0.0 (for Double and BigDecimal), false (for Boolean), and current date (for TimeStamp). To change the current date for Timestamp, click the Open Time Chooser icon.</td>
</tr>
<tr>
<td>Primary Key</td>
<td>Select this checkbox to make this attribute the primary key. Only one attribute can be assigned as the primary key.</td>
</tr>
<tr>
<td>Read Only</td>
<td>Select this checkbox to make this attribute read-only.</td>
</tr>
<tr>
<td>Mandatory</td>
<td>Select this checkbox to make this attribute mandatory (or required).</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>-------------</td>
</tr>
<tr>
<td>Collection</td>
<td>If you select an existing business object as the attribute type and select the <strong>Collection</strong> check box, then you can retrieve multiple records from the selected business object, which is displayed as a line in a multi-line table. For example, if you create a attribute called Addresses and select a business object for &quot;Employee Records,&quot; you can display the &quot;Employee Records&quot; attribute data. This data is then displayed in Business Process Portal as a table.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the attribute. This is optional.</td>
</tr>
</tbody>
</table>

b) Click **OK** to add the attribute to the **Attributes** list in the **Create New Business Object** dialog box.

7. After you have added all the required attributes, click **OK**.

The new business object is added to the list in the **Business Object Manager** dialog box.

**Importing business objects**

You can define business objects by importing files of the following types:

- Business Object XML files, as discussed in Importing a business object from Business Object XML file on page 191.
- XSD files, as discussed in Importing a business object from an XSD file on page 191.
- Java Bean files, as discussed in Importing a business object from a Java Bean file on page 192.

**Importing a business object from Business Object XML file**

You can import one or more business object from an XML file, which is only available to you (or the ones that others have shared with you).

To import a business object from BO XML:

1. From the **Local** section of the **Business Object Manager** dialog box, click **Import**. The **Import** dialog box appears.
2. Select **BusinessObject XML** and then click **OK**. The **Open** dialog box appears.
3. Select single (or multiple) XML files and click **Open** to display the list of business objects. By default, all business objects are selected.
4. Click **Open**. The details of the business object file appears in business object details dialog box.
5. Click **OK**. The selected business objects are added to the list in the Business Object Manager.

**Importing a business object from an XSD file**

An XSD file can contain multiple tags each of which can be converted to a business object. You can select the tags to be imported as business objects.

**Prerequisite:**
Chapter 19: Managing business objects

1. You must have a JDK version 5.0 or higher installed on your machine for importing business object from an XSD.

2. In the System Environment Variables for PATH variable add the JDK bin directory. For example C:\Program Files\Java\jdk1.6.0_26\bin.

This must be updated because, the XSD functionality uses the xjc utility bundled with a JDK version 5.0 or higher found in the bin directory of the JDK installation.

**Note:** Only JRE is bundled with Process Modeler.

To import a business object from an XSD file:

1. From the Local section of the Business Object Manager dialog box, click **Import**. The Import dialog box appears.

2. Select **XSD** and then click **OK**. The XSD Import dialog box appears.

3. To add an XSD file as the source, click **Add**. The Add Source dialog box appears.

   a) You can enter the absolute path of the XSD file in the Location box.

   Alternatively, click the ellipsis button beside the Location box to browse and select the XSD file.

   b) Select the existing Category or create a new category.

   c) Click **OK**.

In the XSD Import dialog box, the XSD details appear in the Sources section and the business objects available in the XSD are displayed in the Types section. Click **Modify** in the Sources section to select another XSD file or category. Click **Delete** in the Sources section to delete the selected XSD file. To modify any of the listed business objects in the Types section, select the business object and click **Modify**. You can modify the details including name and category.

4. Click **Generate**.

   The list of business object that you can import appears in Business Objects To Import dialog box.

5. Select one (or more) business object and click **OK**. The selected business objects are added to the list in the Business Object Manager.

**Importing a business object from a Java Bean file**

Java Beans encapsulates multiple objects into a single object (or bean).

To import a business object from a Java Bean file:

1. From the Local section of the Business Object Manager dialog box, click **Import**. The Import dialog box appears.

2. Select **JavaBean** and then click **OK**. The Java Bean Import dialog box appears.

3. To add a Java Bean file as the source, click **Add**. The Add Source dialog box appears.

   a) Click the ellipsis button beside the Location box to browse and select the Java file or a folder containing multiple Java files.

   b) Select the existing Category or create a new category based on the requirement.

   c) Select Linked Source checkbox. If you select the Linked Source checkbox, then the information of linking the source is passed on to the BO type as well.
d) Click **OK**.

**Note:** The default (or initial) value of Java files with initialized variables is not imported.

In the **JavaBean Import** dialog box, the JavaBean details appear in the **Sources** section and the business objects available in the Java bean are displayed in the **Types** section. Click **Modify** in the **Sources** section to select another JavaBean file or category. Click **Delete** in the **Sources** section to delete the selected JavaBean file. To modify any of the listed business objects in the **Types** section, select the business object and click **Modify**. You can modify the details including name, category, and linked source attribute.

4. Click **Generate**.

The list of business object that you can import appears in **Business Objects To Import** dialog box.

5. Select one (or more) business object and click **OK**. The selected business objects are added to the list in the Business Object Manager.

### Exporting a business object

**To export a business object:**

1. From the **Business Object Manager** dialog box, select one or more listed business objects, then click **Export**.
2. The **Save** dialog box appears, in which you can export the business objects in XML format.
3. Select the folder where you want to export the selected business objects.
4. Click **Save**.

The selected business objects are saved to the selected folder. For each selected business object, a separate XML file is created, which contains the business object definitions encoded in it.

### Using business objects in a link

You can use business objects in links to filter for specific conditions. For information regarding links, see **Defining link properties** on page 124.

**To use a business object in a link:**

1. Open the **Properties** view for a conditional link, then click **Advanced** option to open the Advanced setting for that link.
2. Drag the business object dataslot (in this example “BOds”) from the **Dataslots** section to add it to the **Condition** section.
3. Build the condition for the business object. For business objects, you can use the AutoComplete feature, which lists all the attributes of the business object.

4. To see if the condition is valid, click **Validate**. A message stating “Validation successful” must appear.

Using business objects in applications

You can use Business Objects in your process templates, as described in the following sections.

**Note:** Business objects are not supported on worksteps with default HTML presentation format.

Using business objects in scripts

You can use scripts to set the value of business object attributes. You can add the required script in the **Before Activation** and **When Completed** tabs of the workstep Properties, as well as an overdue action.

Business Process Modeler provides the `getExprEval()` method, which returns a `ObjectGraphService` object. You can use this object to set the attribute values of the specified business object.

The following code provides an example of this functionality:

```javascript
var empObj_DS = jst.getDataSlotValue("Employee_DS");
var exprEval = jst.getExprEval();
exprEval.setValue(empObj_DS, "firstName", "Sam");
jst.putDataSlot("Employee_DS", empObj_DS);
```

where `Employee_DS` is the dataslot of type, "Business Object" mapped to the "empObj_DS" business object with "firstName" attribute.
Business Process Modeler tutorial

In this tutorial, you learn how to use Process Modeler to create a model of your process. This model can later be expanded and detailed in the Progress Developer Studio for OpenEdge.

This tutorial covers the entire procedure from designing a business process to generating instances of the installed application at runtime.

At the end of this tutorial, you will be able to:

• Design a Process Model. This tutorial shows you how to create a simple process called Approval.
• Import the process model into Progress Developer Studio for OpenEdge.
• Publish the process model from Progress Developer Studio for OpenEdge to Business Process Portal and install it as a Business Process Server application.
• Create an application instance at runtime.

For details, see the following topics:

• Designing a process template diagram
• Defining workstep properties
• Saving and installing the process
• Creating an instance and performing a task
Designing a process template diagram

This chapter describes how to design a process template diagram in Business Process Modeler.

**Note:** Alternatively, you can design a process template without the knowledge of BPMN shapes. For details, see *Working with the Overview page* on page 65.

Reviewing the process requirements

For *Approval*, the objective is to define a process in which an employee requests a purchase order, and the manager either approves the request, or rejects it. The employee is notified in both cases.

Defining the process flow

In Business Process Modeler, any business process can be represented by a process flow, with each workstep representing a unit of work to be executed.

In *Approval*, the process flow can be illustrated as shown in *Figure 11: Approval - Process Flow* on page 196.

*Figure 11: Approval - Process Flow*

- **Start**: The requester starts the process by filling out a request for approval form.
- **Request to Manager**: You need to decide how the request is made, and how the employee forwards it to the manager. A possible method is to access or design a Web form, that is sent to the manager as an attachment.
- **Approved?**: Choose a criterion for approving the request, which in this case is the amount of purchase order.
- **Notify Rejection/Notify Approval**: You can decide a suitable mode for notification, such as an e-mail.

Based on these steps, you can design the process template for *Approval*. 
Creating the process model

Open the Business Process Modeler and click File > New > Process Model to create a new process template. The New Process Model wizard opens, where you can provide the required information. Some important attributes are:

- **Name (Required):** Provide a unique model name to identify the new process.
- **Label:** This appears as the title of the process in Business Process Portal. If no Label is provided, then the Name appears as the title.
- **Group (Optional):** If a group is specified, then only the group members can initiate instances of the defined application.
- **Manager (Optional):** The default user who receives any task if an invalid user is given as a performer during an instance creation.

In the Business Process Modeler, defining the process flow includes deciding the types of worksteps, the order in which they occur, and through which types of connections they communicate. You can use the drag-and-drop features of the Business Process Modeler to add worksteps and connectors. For more information, see Designing a process template diagram on page 41.

Note that a workstep can have a user, an adapter, or a subprocess as the performer.

The flow of the process with worksteps identified is illustrated in Figure 12: Approval - Process Model on page 197.

**Figure 12: Approval - Process Model**

1. **Request:** The requester starts the process, providing necessary information.
2. **Approve:** The Manager reviews the request and evaluates it for approval.
3. **Decision:** The Decision gateway represents the choice made in the Approve workstep.
4. **NotifyApprove:** This workstep sends an e-mail to the employee that the request is approved. You can use a customized Email adapter for this step.
5. **NotifyReject:** This workstep sends an e-mail to the employee that the request is rejected. You can use a customized Email adapter for this step.
6. **Or-Join:** This workstep connects two flow paths from NotifyApprove and NotifyReject worksteps to the End workstep.
7. **End:** This is the final workstep. No attributes are attached to this workstep.
Defining the process information flow

Business Process Modeler supports defining the flow of information in the process with dataslots.

To define the process-specific dataslots, click the **Dataslots** tab in the Business Process Modeler interface. For more information on defining dataslots, see Creating user-defined dataslots on page 85. Define the required dataslots for **Approval** as described in Table 61: Dataslot Definition on page 198.

**Table 61: Dataslot Definition**

<table>
<thead>
<tr>
<th>Dataslot Name</th>
<th>Purpose</th>
<th>Data Type</th>
<th>Data Format</th>
</tr>
</thead>
<tbody>
<tr>
<td>Approved</td>
<td>Answers: “Is the request approved by the Manager?”&lt;br&gt;The Decision gateway uses this dataslot to determine the next step in the process flow.</td>
<td>LOGICAL</td>
<td>True</td>
</tr>
<tr>
<td>EmailContentApprove</td>
<td>Answers: “What is the content of the notification e-mail to be sent to the requester, when the manager approves the request?”&lt;br&gt;In the workstep NotifyApprove, the built-in Javascript feature is used to build this dataslot value at runtime.</td>
<td>CHARACTER</td>
<td>Editable</td>
</tr>
<tr>
<td>EmailContentReject</td>
<td>Answers: “What is the content of the notification e-mail to be sent to the requester when the manager rejects the request?”&lt;br&gt;In the workstep NotifyReject, the built-in Javascript feature is used to build this dataslot value at runtime.</td>
<td>CHARACTER</td>
<td>Editable</td>
</tr>
<tr>
<td>EmailHeader</td>
<td>Answers: “What is the common e-mail header for approval as well as rejection?”</td>
<td>CHARACTER</td>
<td>Editable</td>
</tr>
<tr>
<td>EmailSubject</td>
<td>Answers: “What is the subject of the notification e-mail?”</td>
<td>CHARACTER</td>
<td>Editable</td>
</tr>
<tr>
<td>MailTo</td>
<td>Answers: “To whom is the e-mail sent?”</td>
<td>CHARACTER</td>
<td>Editable</td>
</tr>
<tr>
<td>Manager</td>
<td>Answers: “To whom should the request go for approval?” Approval task goes to the Task List of the specified manager.</td>
<td>CHARACTER</td>
<td>Editable</td>
</tr>
<tr>
<td>Remark</td>
<td>Answers: “What remarks does the manager enter while making the decision?”</td>
<td>CHARACTER</td>
<td>Editable, Required</td>
</tr>
<tr>
<td>Request</td>
<td>Answers: “What is the text of the request?”</td>
<td>CHARACTER</td>
<td>Editable</td>
</tr>
<tr>
<td>Subject</td>
<td>Answers: “What is the subject of the request?”</td>
<td>CHARACTER</td>
<td>Editable</td>
</tr>
</tbody>
</table>
Defining process performers

To define performers, click the Performers tab in Business Process Modeler. Click New, then select a Performer type. Enter data in the Performer dialog box to define the required performers for Approval as described in Table 62: Performer Definition on page 199. For more information on defining performers, see Defining performers on page 97.

Table 62: Performer Definition

<table>
<thead>
<tr>
<th>Performer</th>
<th>Type</th>
<th>Role</th>
</tr>
</thead>
<tbody>
<tr>
<td>Emailler</td>
<td>Adapter</td>
<td>Not Applicable</td>
</tr>
<tr>
<td>Creator</td>
<td>User</td>
<td>Not Applicable</td>
</tr>
<tr>
<td>Manager</td>
<td>User</td>
<td>Manager</td>
</tr>
</tbody>
</table>

Tip: When a performer name is underlined and italicized (as in Manager), it indicates that the performer is a datalot with a dynamic value. In this case, the performer called Manager is derived from the value of the Manager datalot at runtime.

Defining workstep properties

You can define the properties of each workstep in the Properties view. An Activity workstep’s Properties view has six tabs: General, Description, Fields, Collaboration, Alerts and Advanced tab. For more information on setting workstep properties, see Setting workstep properties on page 109.

Table 63: Workstep Properties on page 199 describes the worksteps and lists their performers in the Approval sample process.

Table 63: Workstep Properties

<table>
<thead>
<tr>
<th>Workstep</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Request</td>
<td>This is the Start workstep for Approval.</td>
</tr>
<tr>
<td>Approve</td>
<td>This workstep is specific to the Manager approving the request. <strong>Performer:</strong> Manager</td>
</tr>
<tr>
<td>Decision</td>
<td>The Decision gateway represents the available paths.</td>
</tr>
<tr>
<td>NotifyApprove</td>
<td>This is an Email adapter workstep. The adapter sends an e-mail to the specified recipient, which in this case is the Requester. The e-mail notifies the requester regarding the manager’s decision to approve the request. Note that the performer is an external performer. <strong>Performer:</strong> common.externalperformers.Emailer: sendMail</td>
</tr>
</tbody>
</table>
**Workstep Description**

<table>
<thead>
<tr>
<th>Workstep</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>NotifyReject</td>
<td>This is an Email adapter workstep. The adapter sends an e-mail to the specified recipient, which in this case is the Requester. The e-mail notifies the requester regarding the manager’s decision to reject the request. Note that the performer is an external performer. <strong>Performer:</strong> common.externalperformers.<strong>Emailer:</strong> sendMail</td>
</tr>
<tr>
<td>Or-Join</td>
<td>This connects two different flow paths from NotifyApprove and NotifyReject worksteps to the End workstep.</td>
</tr>
<tr>
<td>End</td>
<td>This is the final workstep. No attributes are attached to this workstep in particular.</td>
</tr>
</tbody>
</table>

**Assigning dataslots to worksteps**

From the individual workstep's **Properties** view, open the **Fields** tab for Start and Activity worksteps (**Dataslots** tab for other worksteps) to associate dataslots to each workstep. For more information, see the relevant sections in **Setting workstep properties** on page 109.

**Table 64: Workstep Properties - Dataslots and Presentation Formats**

<table>
<thead>
<tr>
<th>Workstep</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Request</td>
<td><strong>Editable Dataslots:</strong> Manager, Request, Subject</td>
</tr>
</tbody>
</table>
| Approve         | **Non-editable Dataslots:** Request, Subject  
|                 | **Editable Dataslots:** Approved, Remark                                     |
| NotifyApprove   | **Input to Adapter:** EmailContentApprove, EmailSubject, MailTo             |
| NotifyReject    | **Input to Adapter:** EmailContentReject, EmailSubject, MailTo              |

After assigning dataslots, you can also define presentation forms for Start and Activity worksteps by right-clicking the workstep and selecting **Open**.

**Saving and installing the process**

You can verify and export the process to the Process Repository as an **.SPT** file. You can simulate the process in a simulation project before you export it, in order to quickly test a process model for design flaws, estimated costs, and bottlenecks, as described in **Configuring and running simulation** on page 151.

Note that the Business Process Modeler output cannot be directly installed in Business Process Server’s BPM Portal. You must first publish the project using Progress Developer Studio for OpenEdge (see **Publishing the process** on page 55). Your Business Process Server administrator can then install this process template in Business Process Portal environment, and make it available to you and other users as an installed application.

In this tutorial, you have learned to design the sample process Approval. You can compare it with the process provided with the Progress Developer Studio for OpenEdge installation, located in the `Studio_Home\workspace` folder.
Installing the published application

Once you have opened the process model in Progress Developer Studio for OpenEdge, you can directly publish the process template Approval.spt to Business Process Portal.

To install the published application in Business Process Portal:

1. Log into Business Process Portal with administrator privileges. If you do not have administrator privileges, then the Administration module is not visible.

2. In the Administration module, go to Applications > BP Server. From the list of published BP Server applications, select Approval and then click Install.

   When you install the Approval process template, it becomes available to other users as an installed application.

   If a group or permission is defined at the time of process creation, then the application is available only to the members of that group or members with appropriate permissions.

Creating an instance and performing a task

To create an instance of the Approval application and perform a task:


2. To create an instance of the Approval application, open the Applications tab in the Home module and, from the installed applications, click the Approval link.

   The Start workstep page for the Approval application opens. The dataslots previously defined in the Start workstep are displayed as editable text boxes or read-only fields in this page.

3. Provide the required information in the editable fields, and click Create to initiate the instance.

4. Once you create an instance, the task is assigned to the performer of the next workstep. Go to My Instances to see the Instance status.

5. To see the tasks assigned to you, open the My Tasks tab in the Home module.

6. Click on the ‘Approve’ task hyperlink to open the Task Details page. Enter data in the editable fields, as required.

7. Click Complete to finish the task.